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Introduction

1 Introduction

Sartorius offers scalable freeze-thaw solutions using patented technologies
for the handling, storage, and transport of biopharmaceuticals, including
tools for process development, pilot scale operation, and commercial scale
production. The benchtop system configurations are designed to reproduce
the controlled freeze-thaw processes that occur in the large-volume,
production-scale Celsius® and Cryovessel processes. Cryovessel is a
stainless steel product line, and Celsius® is a single-use product line. Both
systems use the Cryopilot A chiller and Cryomixer Jr. shaker.

1.1 Cryovessel

The bench-scale system for Cryovessel is called the Cryowedge. The
Cryowedge module duplicates a small section of the Cryovessel by
matching the heat exchange surface geometry, freeze path length, and
material of construction.

Product volume requirements for feasibility studies can be further reduced
by the use of the Cryocassette. These are 30 mL and 100 mL stainless steel
containers that can be fitted into the Cryowedge in polymeric sleeves.

1.2  Celsius®

The bench-scale system for Celsius® is called the S* Module; S® stands
for Scale-down, and Stability Studies. The S* Module models the FT16 and
FT100 Freeze-Thaw Modules by matching the freeze path length.

The Celsius® S* Benchtop System produces similar freeze-thaw times
allowing for scalable freeze-thaw tests and stability studies.

1.3 References

Refer to the following documents for more information about the
components of your benchtop freeze-thaw system:

— Huber Unistat 705 Operating Instructions

— Huber Unistat 705 Electrical Schematics

— Dow Syltherm HF Product Information

— Dow Syltherm HF Material Safety Data Sheet (MSDS)

— DuPont Suva 507 Material Safety Data Sheet (MSDS)

— DuPont Suva 23 Material Safety Data Sheet (MSDS)

Operating Instructions Celsius® S* Benchtop System 5
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2 Safety

Carefully follow all instructions to prevent serious injury or death to
personnel and damage to equipment. Any use of the system components
in applications for which they were not intended voids the units’ warranties
and releases Sartorius Stedim Biotech from any and all liability.

The following symbols indicate important information:

/A WARNING
Potentially hazardous situations that, if not avoided, could result in death
or serious injury.

A CAUTION
Potential for minor personnel safety hazards or of potential damage to
equipment or property.

NOTE

Information that is important but not safety-related.

2.1 General Precautions

Ensure that company safety policies are followed at all times.

Disconnect power and follow proper lock-out|tag-out procedures

when performing maintenance inside system components.

» Do not stretch the Cryohoses in order to attach them to the chiller or the
application. Instead, move the chiller or application in order to arrange
the hoses in a relaxed position. Allow adequate slack to prevent kinks.

P System components are heavy. Follow proper lifting and rigging

techniques.

vy

2.2 Heat Transfer Fluid

The system uses Dow Syltherm HF silicone heat transfer fluid (HTF). Do not
use any other heat transfer fluid.

There are several hazards associated with use of HTF:

— Temperatures as low as -75°C and as high as 250°C can cause severe
injury to skin, eyes, and other soft tissue. Use appropriate personal
protective equipment when working with HTF or near exposed hot or
cold equipment surfaces.

— Syltherm HF has a closed-cup flash point of 63°C (145°F) per ASTM D92.
According to NFPA and OSHA, it is classified as a Class I[lIA combustible
liquid. Follow proper handling and storage procedures.

— Syltherm HF has a low surface tension and it can be difficult to avoid
spills when filling or draining the system. Once spilled it is extremely
slippery. Use absorbent material such as polypropylene pads to keep
the bench and floor free of spilled HTF.

— Waste HTF and absorbent must be disposed of as hazardous waste.
Refer to the product information and MSDS for more information.
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2.3 Cryopilot A

Only qualified personnel may service the refrigeration equipment. The
Cryopilot A uses R-507 and R-23, which are hydrofluorocarbon (HFC)
refrigerants. These refrigerants are subject to environmental regulations
and must not be vented to the atmosphere.

» Referto the MSDS for more information.

2.4  CryomixerJr.

P During operation, keep hands clear of the top cover plate.
P Do not exceed the maximum recommended agitation speed listed in the
System Installation section.

Operating Instructions Celsius® S* Benchtop System 7
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3 System Components

31  Cryopilot A

The Cryopilot Ais a recirculating chiller that controls the temperature of a
heat transfer fluid (HTF) to a temperature setpoint.

A cascade refrigeration system cools the HTF when its actual temperature is
above the temperature setpoint. The main components of the refrigeration
system are a high temperature compressor, a low temperature compressor,
a condenser, an automated expansion valve and an evaporator. The
refrigerants used in the high and low stages are R23 and R507, respectively.
The refrigerant condenser is air-cooled.

A pair of electrical resistance heaters heats the HTF when its actual tempe-
rature is below the temperature setpoint. A1500 W large heater is used for
large temperature changes and a 100 W fine heater is used for small tempe-
rature changes. This dual heater arrangement provides for precise control of
HTF supply temperature.

Avariable speed pump circulates the HTF through the evaporator, the hea-
ters and the external application. For Cryowedge applications, the HTF
flows through the jacket and the core heat exchanger area. For S* Module
applications, the HTF flows through the walls adjacent to the Celsius® Pak
clamps. An expansion reservoir simplifies priming the system and allows for
HTF expansion and contraction.

The Cryopilot Ais microprocessor controlled. The controller user interface
has several pushbuttons, a rotary encoder, an LCD display with touch
screen, and a system diagram with status LEDs.

The following are key specifications for the Cryopilot A:

Electrical Power Supply

NOTE: The Cryopilot A is delivered without a plug. Due to the variation in
local electrical receptacles, the customer must supply the plug.

North America 208 VAC, 60 Hz,1~,20 A
Europe 230 VAC,50Hz 1~,15.6 A
Fluid Temperature Range -75°C to 250°C
Dimensions (WxDxH) 425x400x720 mm
(16.7"x15.7"x28.3")
Weight 90 kg (198 lbs)

Operating Instructions Celsius® S* Benchtop System
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3.2 Computer

The Cryopilot Ais controlled and monitored using Cryopilot software on
a computer. The Cryopilot software controls and monitors the benchtop
system components including chiller, mixer, and thermocouples. See
Chapter 5 Cryopilot Software”, page 20 for minimum system
requirements and additional information.

Computers purchased from Sartorius as part of a benchtop system have the
following specifications:

— Laptop form factor

— Operating System: Microsoft Windows 10 Professional, 64-bit

— Microsoft Excel

— Adobe Acrobat

— Cryopilot software pre-installed

3.3 Cryowedge Module

Cryowedge module names correspond to the volume of production scale
Cryovessels. For example, a Cryowedge 125 (20”) is meant to simulate a
125L Cryovessel.

Working volume 350 -4000 mL, depending on the size
of the Cryowedge.

Materials of construction

Body 316L stainless steel
Gaskets silicone
Cover transparent polycarbonate
Connections HTF in, HTF out with quick-disconnect
couplings

Weight, empty

Cryowedge 20 (127) 15 kg (32 Ibs)
Cryowedge 125 (207) 21 kg (46 Ibs)
Cryowedge 300 (30") 44 kg (97 Ibs)
Cryowedge 300 (34") 49 kg (108 Ibs)

Size equivalence
Cryowedge 20 (127) Cryovessel 20L-40 L
Cryowedge 125 (20") Cryovessel 60 L-150 L
Cryowedge 300 (307) Cryovessel 200 L -300 L
Cryowedge 300 (34") Cryovessel 300 L

Operating Instructions Celsius® S* Benchtop System 9
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3.4 Cryocassette

The Cryocassette minimizes the amount of product used within the
Cryowedge. The Cryowedge can then be filled with buffer while the
Cryocassette is filled with product. The design of the Cryocassette
maintains the freezing and thawing characteristics of the Cryowedge to
ensure scalability to the production Cryovessels. The Cryocassette also
serves as a scalable stability container.

Working volume — 10-100 mL, depending on the size of
the cassette
— Available in 30 mL and 100 mL sizes

Fig.1: Stainless Steel Cryocassettes Materials of construction
Body 316L stainless steel
Boat — polypropylene (30 mL) or
— polyethylene (100 mL)
Sterilization Customer autoclavable
Finish 10 p-in Ra, EP

3.5 Celsius®S®*Module

The Celsius® S* Module provides the capability to model Celsius® FT100 and
FT16 systems with as little as 20 mL of product. The configuration of the
heat transfer surfaces within the module provide the same bi-directional
heat flux as seen in the FT100 system utilizing frame and Celsius® Pak

designs.
Capacity 1-10 product samples
Working volume 20 mL to 1L, depending on size of

Celsius® Paks

Materials of construction

Shell 302-304 stainless steel Shell
Base 6061-T6 aluminum

Fig.2: Celsius* S*Module Shell frame cover 5052 aluminum
End plates Rigid PVC foam sheet
Internal shell insulation Silicone foam rubber

HTF connection end cover Delrin

Cover Transparent PVC
HTF piping maximum design 4.1 barg (60 psig)
pressure
Connections HTF in, HTF out with installed quick-
disconnect couplings; drain
Weight Approximately 18 kg (40 lbs)

10 Operating Instructions Celsius® S® Benchtop System



Frozen16.6 L
Celsius® Pak

Fig.3: Comparison Between 30 mLand 16.6 L
Celsius® Paks

Fig.4: Cryomixer Jr.

System Components

3.6 Celsius® Paks

All Celsius® Paks, regardless of size, have the same material of construction
and the same freeze and thaw path length as shown in Figure 3.

Since Celsius® Paks are single-use, the need for cleaning is eliminated.

— Available in 30 mL and 100 mL sizes

— Ready to use, single-use collapsible container

— Pre-sterilized (25-45 kGy gamma radiation)

— RF sealing compatible

— Designed to allow for sterile temperature measurement

— Celsius® Paks overwrap pouches are available. The use of an overwrap is
recommended when conducting studies at higher temperatures (room
temperature and above).

Materials of Construction (30 mL and 100 mL Celsius® Pak)

Product contact layer EVAM (ethylene vinyl acetate copolymer,
monomaterial)

Gas and moisture EVA|EVOH | EVA

barrier layer

External robust, EVA

handling layer

Fill and drain ports EVA

Extension tubing C-Flex®*

LuerLock® Polycarbonate or Polypropylene (C-Flex®
option)

Double barb elbow or union Polypropylene (C-Flex® option)

Thermowell Pt-cured silicone

3.7 CryomixerJr,

The Cryomixer Jr. is a reciprocating mixer that is positioned below the Cryo-
wedge or S* Module in order to ensure homogeneity of the thawed product.
The reciprocating motion starts automatically when activated by the
Cryopilot software. The Cryomixer Jr. is used for both Cryowedge and

S® Module agitation applications.

Specifications

Stroke 17 (25 mm), reciprocating

Electrical Power Supply

North America 115V, 60 Hz, 1~

Europe 230V, 50 Hz, 1~
Dimensions (WxDxH) 505x585x120 mm (20”x23"x5")
Weight 24 kg (52 Ibs)

* C-Flex®is a registered trademark of Saint-Gobain Performance
Plastics Corporation.
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3.8 Cryohose

All systems use two Cryohoses for the supply and return of HTF from the
Cryopilot A unit. These hoses are stainless steel with surrounding insulation.

3.9 Cryowrap

Cryowrap is a neoprene sleeve that, when wrapped around Cryohose
connections, prevents frost build up during Cryowedge or S* module
freezing.

310 Data Acquisition Device

The data acquisition device is compact module used to digitize thermocouple
signals for monitoring by the computer. The data acquisition device has
a breakout cable with receptacles for up to 16 T-type thermocouples.

12 Operating Instructions Celsius® S* Benchtop System
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4 System Installation

This chapter will guide you through the setup of the benchtop system.

41 Tools| Equipment Required for Installation

The following tools are needed to set up the Benchtop Freeze-Thaw

System:

— Assortment of cross head and flat head screw drivers

— Vise grip wrench with a minimum 6” (15 cm) handle

— Assortment of box or crescent wrenches

— Absorbent material such as polypropylene pads for cleaning up any
spilled HTF

— Multimeter suitable for measurement of supply voltage

4.2 Systemm Component Inventory

When all the equipment containers are unpacked, confirm that the
following parts are available for installation:

— Cryopilot A

— Cryowedge or S* Module

— Cryomixer Jr.

— (2) Cryohoses

— (4) Cryowraps

— T-Type thermocouples (up to 10 depending on system)
— USB to Cryomixer Jr. cable

— Computer with Cryopilot Software

— National Instruments USB-9213 data acquisition device
— USB to Unistat cable

— Dow Syltherm HF heat transfer fluid (~19 L or 5 gallons)
— Safety Siphon

— Cryowedge insulated cover (Cryowedge only)

— Three Cryocassettes (Cryowedge only)

— (10) Celsius® Paks (S* Module only)

— (10) Thermocouple holders (S°* Module only)

— Clamp release tool (S* Module only)

Operating Instructions Celsius® S* Benchtop System
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System Installation

4.3 Selecting a Location

Install the system on dry, level surface such as a lab bench or table that sup-
ports a total weight of ~400 Ibs (~180 kg). The space required for a typical
benchtop system is approximately 188 cm (74”) wide by 76 cm (30”) deep.
See Figure 5 for proper arrangement and required clearance. The Cryopilot
Ais air-cooled and requires adequate ventilation. Since the Cryomixer Jr.
oscillates back and forth, avoid use of wheeled carts.

188 cm (ref)
V/
S*Module or 1 8 cm mijin. clearance
Cryowedge -~
clo
| £ S
e o
Va o3
S £
T o
Cryopilot A —- N
Laptop / F46 cm min.-»|
computer B — Z

Data Cryomixer Jr.
acquisition
device

Required depth 76 cm (ref)

Fig.5: Space Requirements

4.4  Cryowedge and Cryohose Installation

/A CAUTION

Do not stretch or kink the Cryohoses in order to attach them to the Cryo-
wedge. This may cause leaking. Allow adequate slack.

/A CAUTION

Apply adequate counter torque when tightening the Cryopilot A union
fittings in order to avoid damage to the piping inside.

P Place the Cryowedge in the insulated cover provided, making sure that
the heat transfer fluid (HTF) inlet and outlet connections are exposed.
P Place theinsulated Cryowedge on top of the Cryomixer Jr. Position the
Cryowedge such that the motion of the Cryomixer Jr. will allow for mixing
along the length of a Cryocassette or from the point of the Cryowedge
(equivalent to the position of the core heat exchanger of a Cryovessel)
to the outer wall (equivalent to the position of the jacket of a Cryovessel).
P Slide two Cryowraps onto each hose.

Operating Instructions Celsius® S* Benchtop System
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NOTE

The quick disconnects are factory assembled onto the adapters and hoses.
If it becomes necessary to break and then remake connections having
tapered threaded fittings, use a thread sealant such as Loctite 567.

_"sanitary flange* M16x1 union M24x1.5 union

‘ Adapter Mx1union16

|

%“—J\/\/\—W—HF Cryopilot A

Cryowedge {

v \

Adapter* Adapter
Male %" Female %" Insulated hose
quick quick 1.5m

disconnect disconnect

Fig. 6: Cryohose Installation for Cryowedge

P Connect the port labeled “Thermofluid out” on the Cryopilot A to the
inlet port of the Cryowedge as shown in Figure 6. The inlet port on the
Cryowedge is on the outer wall, which is equivalent to the position of the
jacket on a Cryovessel.

P Connect the port labeled “Thermofluid in” on the Cryopilot A to the
outlet port of the Cryowedge as shown in Figure 6. The outlet port on
the Cryowedge is at the point, which is equivalent to the position of
the core heat exchanger on a Cryovessel.

P Verify that all hoses are connected properly.

4.5 S*®Module and Cryohose Installation

A CAUTION
Do not stretch or kink the Cryohoses in order to attach them to the S* Module.
This may cause leaking. Allow adequate slack.

A CAUTION
Apply adequate counter torque when tightening the Cryopilot A union
fittings in order to avoid damage to the piping inside.

Operating Instructions Celsius® S* Benchtop System 15
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P Place the S* Module on top of the Cryomixer Jr. as shown in Figure 7 so
that the motion of the Cryomixer Jr. will allow for mixing along the length
of a Celsius® Pak.

Pos.  Description

Fig.7: S* Module Positioning

1 Qutlet Port
2 Inlet Port
3 Mounting Knobs

» Secure the S* Module to the Cryomixer Jr. plate by tightening the four
mounting knobs at the bottom of the module.
p Slide two Cryowraps onto each hose.

NOTE

The quick disconnects are factory assembled onto the S® and hoses. If it
becomes necessary to break and then remake connections having tapered
threaded fittings, use a thread sealant such as Loctite 567.

M16x1 union M24x1.5 union
Adapter M16x1union
$* Module Ao cryopilot A
Adapter
Male %" Female %" Insulated hose
quick quick 1.5m

disconnect disconnect

Fig.8: Cryohose Installation for S* Module

P Connect the port labeled “Thermofluid out” on the Cryopilot A to the
inlet port of the S* Module. The inlet port is the lower of the two quick-
disconnect ports on the S°.

» Connect the port labeled “Thermofluid in” on the Cryopilot A to the
outlet port of the S* Module. The outlet port is the upper of the two
quick-disconnect ports on the S°.

P Verify that all hoses are connected properly.
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Fig.9: Cryopilot A Main Power Switch

System Installation

4.6 Cryopilot A Setup

/A WARNING

All wiring should be performed by a qualified electrician.

P Ensure that the main Cryopilot A power switch is in the “OFF” or “0”
position. The switch is red and yellow and is located on the back of the
Cryopilot A as shown in Figure 9.

» Have a qualified electrician install a plug (not provided) on the power

cord of the Cryopilot A. The plug must match the receptacle and must

be rated for the line voltage and current. Refer to Chapter ,3 System

Components”, page 8 for electrical supply specifications.

Plug the Cryopilot A unit into the electrical supply.

Turn the main Cryopilot A power switch to the “ON” position.

Verify that all LEDs light momentarily, and that the rectangular LCD

display is illuminated. If not, verify that power is available to the Cryopilot

A unit. If power is available to the Cryopilot A unit, but the controller

does not come on, please contact Customer Service (see page 45).

vVvyy

4.7 Heat Transfer Fluid Fill

It is recommended that about 19 L (5 gallons) of HTF are on hand for the
setup of the benchtop system. Dow Syltherm HF is used as a heat transfer
fluid because of its low freezing point and low viscosity over a wide
temperature range. For additional information, refer to the Dow Syltherm
HF Material Safety Data Sheet.

NOTE

Dow Syltherm HF is the only approved heat transfer fluid for use in this system.

» Ensure that the drain valve is closed by turning clockwise to the vertical
position and closing the lower sealing screw on the side of the
Cryopilot A as shown in Figure 10.

Operating Instructions Celsius® S* Benchtop System 17
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Fig.11: Rear of Cryomixer Jr.

1 2 3

Fig.10: Cryopilot A HTF Drain Valve and Sealing Screws

Pos.  Description

Main drain port sealing screw HTF Drain Valve

2 HTF Drain Valve
3 Sight glass Drain sealing screw HTF Drain Valve
P Remove the fill port cap located on top of the Cryopilot A, behind the

vvyy

sight glass.

Elevate the container of Syltherm HF above the Cryopilot A.

Insert the tube end of the Safety Siphon into the Cryopilot A and the
valve end into the container of Syltherm HF. Submerge the red valve end
in the Syltherm HF and wiggle it up and down to start the siphon. To stop
the flow of HTF, lift the red valve end out of the Syltherm HF. Fill the
Cryopilot A unit to the 2L mark on the sight glass.

Start a manual air purge (press Start, Start air purge, 30s interval, OK).
Add more HTF as needed so that the sight glass level stabilizes at 2L.
Verify that there are no leaks in the hose connections.

Stop the pump (press Stop, Air purge off).

Secure the Cryowraps over the exposed metal surfaces at each end of
the two hoses.

4.8 CryomixerJr. Setup

>
>

>

vvyy

Plug the Cryomixer Jr. into the electrical supply.

Set the manual operation knob on the front of the Cryomixer Jr. to the
“O” position.

Place the Manual | Automatic switch on the back of the Cryomixer Jr. to
the manual position (down) as shown in Figure 11.

Turn the speed knob to the fully counterclockwise (O RPM) position.
Turn the manual operation knob to the “I” position.

Slowly turn the speed knob in the clockwise direction until the proper
RPM is achieved and record displayed RPM as read on the LCD display
on the Cryomixer Jr. The standard settings are listed below:

— CW20 and CW125 Cryowedges: 45 RPM

— CW300 (30") and CW300 (34") Cryowedges: 35 RPM

— S$*Module: 120 RPM

18 Operating Instructions Celsius® S® Benchtop System



Fig.12: Cryopilot A Serial Port

System Installation

NOTE

Mixer speed settings may vary according to customer product
characterization. Contact Sartorius to discuss variations from the above
recommendations.

P Place the Manual | Automatic switch on the back of the Cryomixer Jr. to
the automatic position (up).

4.9 Computer Setup

P Plug the computer and display into the electrical supply. It is
recommended that you use a surge protector (not included).

P Turn on the computer and display. Answer the questions in the Windows
“first boot” setup dialogs. It may be necessary to obtain some information
from your Information Technology (IT) department.

A CAUTION

Computers supplied by Sartorius do not have antivirus software installed. It
is recommended that you install antivirus software according to your
company’s policy.

410 Data Acquisition Setup

P Connect the National Instruments USB-9213 to the computer with a
USB cable.

p Connect one end of the USB to Cryomixer Jr. cable to the receptacle at
the rear of the Cryomixer Jr. Plug the other end into a USB port on the
computer.

P ForS®Modules, plug the bundle of male thermocouple connectors
extending from the S*® Module into the thermocouple breakout cable.
Plug connector 1into receptacle 1, connector 2 into receptacle 2, and
so on. Plug the Celsius® Pak thermocouples into the receptacle strip
located within the S* hood enclosure area.

P Connect one end of the USB to Unistat cable to a USB port on the
computer and the other end to the serial port on the underside of the
ComBox as shown in Figure 12. The ComBox is located at the rear of
the Cryopilot A.

Operating Instructions Celsius® S® Benchtop System 19
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5 Cryopilot Software

51 Overview

The benchtop system is controlled and monitored by Cryopilot software,
which is a graphical application for computers with Microsoft Windows. The
Cryopilot software provides users with flexible execution of freeze and thaw
operations.

The following diagram illustrates the relationships between system
components. The Cryopilot software interfaces with the Cryopilot A chiller
and the Cryomixer Jr. shaker via USB, and with up to 16 thermocouples
through a National Instruments data acquisition device.

Computer
usB UsB usB
A 4
USB to Unistat Cable USB to Cryomixer Jr. Cable
USB Cable FTH-DAQ0000-0062 FTH-DA00000-0061
\ Y 4
National

Instruments Cryopilot A Cryomixer Jr.
USB-9213

A

16x Type T Thermocouple Cable
FTH-DAQQ000-0065

Cryowedge or §*

Fig.13: Cryopilot System

5.2 System Requirements

Cryopilot software is factory-installed on computers ordered from Sartorius

as part of a benchtop system. Alternately it is available on USB flash drive for

systems that meet the following requirements:

— Operating System: Microsoft Windows 7 Professional, 32 bit with Service
Pack 1 or Microsoft Windows 10 Professional, 64 bit.

— Data Acquisition Device: National Instruments USB-9213.

Cryopilot software is packaged with an installer that will automatically install

the Cryopilot software and all required third-party drivers on your computer.
You must have administrative privileges to install Cryopilot.

20 Operating Instructions Celsius® S® Benchtop System



Cryopilot Software

53 Components

By default, Cryopilot software is installed in C:\Program Files\Sartorius
Stedim Biotech\Cryopilot 5 for 32-bit operating systems and in C:\Program
Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 for 64-bit operating
systems. This will hereafter be called the installation directory. The following
is a description of the files and folders contained in the installation directory:

Component Description

Profiles/ Directory for standard profile files
supplied with Cryopilot .

BouncyCastle.Crypto.dll Support library
Cryopilot.chm Help file
Cryopilot.exe The executable for Cryopilot software.

Shortcuts to this file are placed on the
desktop and in the Start menu.

Cryopilot.exe.config Settings file
ICSharpCode.SharpZipLib.dll Support library
libftdi.dll Support library
log4net.dll Support library
Nationallnstruments.Common.dil  Support library
Add Nationallnstruments. Support library
NiLmClientDLL.dlI

Add Nationallnstruments. Support library
MStudioCLM.dII

Nationallnstruments.DAQmx.dll Support library
NPlot.dll Support library
uninsO00.dat Uninstaller support file
uninsO00.exe Uninstaller

In addition to the files in the installation directory, the Cryopilot installer
creates a folder named Cryopilot in each user's My Documents folder. This
will hereafter be called the user directory. The following is a description of
the files and folders contained in the user directory:

Component  Description

Data/ Default directory for data files saved by users.
Users may opt to store files elsewhere on the computer
oron a network drive.

Custom Default directory for custom profiles saved by users.
Profiles/ Users may opt to store files elsewhere on the computer
oron a network drive.

Files that are subject to change but common to all users are stored in
C:\ProgramData\Sartorius Stedim Biotech\Cryopilot 5.
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Component  Description

log.txt File used for troubleshooting software

settings.xml Settings file

The Cryopilot installer also installs several additional libraries: Microsoft
NET Framework 4.6.1, National Instruments NI-DAQmx, and USB drivers.

5.4 Installation

To install Cryopilot software, insert the USB flash drive and double-click on
mysetup.exe. Setup requires administrative privileges; contact your system
administrator if you do not have sufficient privileges.

The default settings are generally adequate.

Once the setup process is complete, you will be prompted to restart your
computer.

NOTE
It is critical that the computer be configured so that it does not suspend or
power down while a freeze|thaw process is running.

For Windows 7 or Windows 10, go to Control Panel > System and Security >
Power Options. Select High performance profile. Click Change plan settings,
then Change advanced power settings. Set Hard disk > Turn off hard disk
afterto O (never). Set USB settings > USB selective suspend setting to
Disabled. Click OK, then close the Control Panel window.
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5.5 UserInterface

551 Main Window

The main window is the primary screen used in the Cryopilot software. This
window contains menu items to interact with the program, a chart to graphically
display process data, and a legend to select the traces to display on the chart.

Cryopilot Software
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Fig.14: Main Window

Pos. Control

Description

1 Title bar Displays the name of the application and
the name of the current data file, if any
2 Menu bar Contains menus for performing common
tasks
3 Toolbar Contains buttons for performing common
tasks
4 Chart Displays a plot of temperature vs. elapsed
time
5 Status bar Shows the status of the equipment as
Online or Offline
6 Elapsed time indicator Shows how much time has elapsed since
the process started
7 HTF Setpoint legend Displays the heat transfer fluid (HTF)
item setpoint
HTF Supply legend item  Displays the actual HTF temperature
9 Product N legend item Displays the temperature of the Nth

type T thermocouple.
Up to 16 thermocouples may be
monitored, depending on hardware.
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5.5.2 Start Process Dialog

The Start Process dialog prompts the user for information that will be used

during the process.

Start Process

profile development

General
1 = Chart title: Temperature vs. Elapsed Time
2 ——— Data filename: N:\CryoPilot\Datal 2009-03-03-14-52-52.cpd E]—— 6
3 ——— Use profile: O None
(%) standard
Application: |53 30mL y— 717
Process: Freeze .V!—— 8
) Custom
4 —r-
5 -y Description: 10 Celsius-Paks 30ml containing buffer, used For

ok J[ concel |

Fig.15: Start Process Dialog

Pos. Control

Description

1 Chart title

The title shown at the top of the chart. The
default is “Temperature vs. Elapsed Time”.

2 Data filename

The complete file name where data for this
process will be saved. The default is [User
Directory]\Data\[date code].cpd, where [date
code] is a numeric string composed of year,
month, day, hour, minute, second.

3 Profile type
selector

Gives three options: None, for no profile;
Standard, for a Sartorius supplied standard
profile, or Custom, for a user-supplied profile.

4 Profile filename

The complete file name where the custom
profile can be found

5 Description

Afield for entry of additional information about
the process.

6 Data filename
selector

Opens a dialog to select a folder and filename
where the data for this process will be saved.
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Pos.

Control

Description

7

Application
selector

Gives six options when Standard profile type is

selected:

— $*30mL - for S® systems with ten 30mL
Celsius® Paks

— $*100mL - for S® systems with ten 100mL
Celsius® Paks

— Cryowedge 127

— Cryowedge 24"

— Cryowedge 30"

— Cryowedge 34"

Process selector

Gives three options when Standard profile type

is selected:

— Freeze - performs freeze only

— Thaw - performs thaw only

— Freeze and Thaw - performs freeze followed
by thaw

Profile filename
selector

Opens a dialog to select a folder and filename
where the custom profile can be found.

10

Cancel button

Ignores the information and closes the dialog
without starting the process.

1

OK button

Accepts the information, closes the dialog, and
starts the process.
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5.5.3 Options Dialog

Cryopilot software may be configured using the Cryopilot Configuration
dialog. From the main window, select the Tools > Options menu item.

7
M‘_
Certificates | Hardware I

Digital certificates are used ko ensure the authenticity and integrity of CryoPilot data
files. ¥ou may obtain a digital certificate by clicking the Create button below ar by
contacting your system administrator.

Select a digital certificate to use when saving data Files:

| Issued b I Issued to | Friendly name I Expiration date |

SARTORIU-784... SARTORIU-784... CryoPilot 3412011

Create Wiew Manage

oF I Cancel |
i

2 3 4

Fig.16: Options Dialog - Certificate Tab

Pos.

Control Description

1

Certificates list Displays a list of available digital certificates.
For each certificate the list shows who issued
the certificate, to whom the certificate was
issued, the friendly name, and the expiration
date.

Create button Creates a new self-signed certificate and installs
it in the Trusted Root Certification Authorities
folder.

View button Views additional details for the selected
certificate.

Manage button Opens the Microsoft Management Console for
additional certificate management tasks such as
certificate renewal and deletion.

OKbutton Accepts the changes and closes the dialog.
Cancel button Discards the changes and closes the dialog.
Hardware tab Switches to the hardware tab.
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7

Data Acquisition
A data acquisition device is used to read temperature sensors. Select an
available device from the list below or select None to disable data acquisition:

Device: |UsB-9213 (Dev1) v

Chiller

& chiller s used to control the temperature of the heat transfer fluid (HTF).
Select a device from the list below:

Type: h—hber Unistat R

Port:  |COMS (v

Shaker

& shaker is used to agitate product during thaw. Select a device from the
list below or select None to disable shaking.

Device: {USBCtyoMixef Ir. Interface ‘V_‘I

2

) [ goncel ]

Fig.17: Options Dialog - Hardware Tab

Pos. Control Description
1 Data acquisition The “None” option configures the application
device selector for no data acquisition. If a compatible National

Instruments data acquisition device is
detected, it will be automatically selected.

2 Chiller selector Selecting the “None” option configures the
application for no chiller. Selecting the “Huber
Unistat” option configures the application to
collect data from a Huber chiller equipped with
a Unistat controller, such as a Cryopilot A.

3 COM port selector Shows a list of available serial (COM) ports.

Shaker selector The “None” option configures the application
for no shaker. If a USB to Cryomixer Jr. cable is
detected, it will be automatically selected.

OKbutton Accepts the changes and closes the dialog.

Cancel button Discards the changes and closes the dialog.

Certificates tab Switches to the Certificates tab.
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5.6 Getting Started

Before a profile can be started the software must be configured. Make sure
that the data acquisition device (DAQ) and chiller are connected and
powered up. Then select the Tools > Options menu item to display the
Options dialog.

5.61 Selecting a Digital Certificate

First, a digital certificate must be selected. Cryopilot uses a digital certificate
to guarantee the authenticity and integrity of saved data files. The Certifica-
tes tab shows a list of available certificates. It is ideal to use a certificate
issued by a trusted certification authority (CA). If your information techno-
logy (IT) organization already has a digital certificate infrastructure establis-
hed then they may be able to provide a certificate for use with Cryopilot.

In the event that you do not have a certificate to use with Cryopilot, you can
create what is known as a self-signed certificate. “Self-signed” means that
the person who creates the certificate also vouches for its legitimacy. For
Click the Create button, and then click the Yes button on the dialog that
appears. The newly created certificate will be shown in the list of available
certificates.

5.6.2 Configuring Hardware

Next, the hardware must be selected. The Hardware tab contains settings
for common hardware configurations. The most common arrangement
consists of a data acquisition device (DAQ), a chiller, and a shaker. In most
cases the hardware will be detected automatically.

If you will not be running any processes and will only be using Cryopilot to
review data files, then select “None” for all Data Acquisition, Chiller, and
Shaker.

To save the options, click OK.

5.6.3 Program Flow

When Cryopilot software is launched, a splash screen appears briefly and
then the main window is displayed.

At this point the software is idle and will not do anything until the user starts
a process.

To start a process, select the Process > Start menu item or click the Start
Process button on the toolbar. The Start Process dialog will be displayed.
Once the user clicks OK, the software attempts to connect to the data
acquisition device, the shaker, and the chiller, if configured. If any of these
devices is configured but not connected then the user is prompted to check
connections and retry or cancel.

Once a process is started, the temperature chart and the legend are recon-
figured to display the appropriate plots, communications are established
with the chiller, and the data acquisition device (DAQ) is initialized. Once in-
itialization is complete, the initialization message disappears and first set of
data points is plotted. Subsequent data points are displayed at the sampling
interval, which is fixed at 15 seconds.
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When configured to use a chiller, the Cryopilot software uses a serial link to
send commands to and receive responses from the chiller.

During a process, the connection status is displayed in the lower left corner
of the main window. A green “Online” message indicates a good connection
with the data acquisition device and the chiller. A red “Offline” message in-
dicates that something is wrong with the connection.

The Stop Process button ends data acquisition and turns off the chiller and
mixer. The user may then review the data. The data file must be closed befo-
re the user can start another process.

5.6.4 Reviewing Data

Cryopilot can open and display files saved in Cryopilot 4 and Cryopilot 5.
Note that files created by Cryopilot 4 are supported for review purposes
only. All new data files are saved in Cryopilot 5 format so that data integrity
and authenticity can be verified via digital signature.

Only one data file can be open at a time.

To open a data file, do one of the following:
P Click the Open button on the toolbar
P» Open the File menu and click Open

P Use the keyboard shortcut Ctrl+O

Using the Open Data File dialog, select the file you wish to open. Be sure to
select the type of file in the “Files of type” dropdown.

Cryopilot 5 uses digital signatures to prove that the data has not been
modified since it was originally saved. If the integrity and authenticity of the
data file cannot be verified by means of a digital signature then you will be
notified and prompted to continue or cancel. There are two common cases
where this notification will appear:

— When opening a Cryopilot 4 data file. Cryopilot 4 files do not contain a
digital signature.
— If the certificate used to sign the data file is not trusted.

Once the data file is loaded, the chart will be populated with the data from
the data file, and the data on the chart can be explored just as if the data
was coming from a live process.

By right-clicking on the chart and clicking on the Review item, you can scroll
right and left on the chart and verify the values for each trace at a given
point in time. As the review line is scrolled right or left, the legend is updated
to show the timestamp and trace values for that point in time.
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"N.\-.-

Sk Scale

Review

Fig.18: Chart Pop-up Menu

5.6.5 Usingthe Chart

The chart is a graphical display of temperature vs. elapsed time for a run.
Elapsed time is displayed on the X axis in units of hours and temperature is
displayed on the Y axis in units of degrees C. A legend is provided to identify
and show the current value for each plot.

Panning and Zooming

By default, chart scales are automatically adjusted to fit the available data.
This auto-scaling feature may be turned on or off using the Auto Sscale item
Xand Autoscale Y options on the pop-up menu obtained by right-clicking
on the chart.

The scale extents can be changed directly by dragging the Xand Y axes. The
chart display can be panned by dragging the chart with the left mouse button
held down. When changing scale or panning the chart, Auto Scale will be
turned off. Double-click the chart to turn Auto Scale back on.

Legend

The legend identifies each of the plots on the chart. Each plot has a legend
item showing its name, color, units, and current value. To hide a plot,
double-clickits legend item; it will appear dimmed. To show the plot,
double-click the legend item again. This can be useful when trying to look
at data files with many plots lying on top of each other.

Review Mode

Review mode allows the user to review data at any point during the process.
Review mode is turned on and off using the pop-up menu shown in

Figure 18. When in review mode, a vertical line is displayed on the chart, and
the elapsed time and legend items display values that correspond to that
location on the chart.

5.6.6 Exporting Data

Cryopilot provides two different methods to export data. It can export an
image of the current chart view or it can export raw data for viewing in a
spreadsheet application.

Export Chart

To export the chart, select the Edit > Copy > Chart menu item. The chart is
copied to the Windows clipboard as a bitmap image. The chart may be
pasted to other applications by selecting Edit>Paste or pressing Ctrl+V. This
option is useful where a quick snapshot of the data is needed, for example in
a slide presentation. Use the Copy>Data option if the data must be further
analyzed.
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Export Data

To export the data, select the Edit > Copy > Data menu item. The raw data is
copied to the Windows clipboard in tab-delimited format. The data may be
pasted to spreadsheet applications such as Microsoft Excel or OpenOffice
Calc by selecting the destination cell and selecting Edit>Paste or pressing
Ctrl+V.

5.6.7 Printing

Cryopilot can create a report for the open data file. The report is a snapshot
of the current chart view including the title and legend. The report may be
previewed on-screen or sent to a printer. If you have a PDF print driver such
as Adobe Acrobat installed on your computer, you can save the report to a
PDF file on disk.

To print a report, do one of the following:
p Click the Print button on the toolbar
» Open the File menu and click Print

P Use the keyboard shortcut Ctrl+P.

The Print dialog will appear, prompting you to select the destination printer
and the number of copies. Other settings such as margins and paper size
may be set in Page Setup. Click OK to send the report to the selected
printer.

5.6.8 Profiles

Cryopilot software controls the chiller and the mixer by following a profile.

A profile is a recipe with instructions to change the chiller temperature
setpoint and the mixer mode setpoint (on|off) as a function of time.
Cryopilot software is supplied with a set of standard profiles that are suitable
for many S* Module and Cryowedge applications.

It may be necessary to create a new profile to suit a specific application.

When designing a new profile, there are several factors to consider:

— Which operations are to be performed - freeze, thaw, or both?

— Are multiple freeze and thaw cycles required?

— Whatis the initial temperature of the material to be frozen or thawed?
If this is variable, an equilibration step at the beginning of the profile can
improve reproducibility.

— Should the equipment remain running or turn off after the freeze or thaw
is complete?

Adjustment of the freeze and thaw rates is performed empirically. If a lower
endpoint is desired for a freeze, it may be necessary to increase the duration
of the final setpoint or reduce the the temperature adjusted. When trying to
thaw quickly without overshoot, use a high temperature setpoint for a short
duration and then lower the temperature setpoint before the target
temperature is exceeded.
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[® $3 100mL Paks with CP-A - freeze hold.txt - Notepad

File Edit Format View Help

=loix]|

[The first column is the time (in minutes)
and the third column is the mixer state

[START

0. 00 -50 OFF
140.00 -25 OFF
150.00 -25 OFF
160.00 -35 OFF
180.00 -45 OFF
200.00 -535 OFF

[STOP

<

ntegrated Biosystems Scale Down Temperature profile x|

P
the second column is the temperature (in degrees C),

| o

Fig.19: A profile in Microsoft Notepad.

Profile Editing

Profiles may be created and edited manually with text editors (e.g. Microsoft
Notepad) or spreadsheet programs (e.g. Microsoft Excel). When using a text
editor, always use the tab key to separate columns; do not use the space
key. For a new line, use the Return or Enter key after entering the status for
the Mixer.

If you use a standard profile as a starting point, be sure to save it with a new
file name and then make changes.

Last Step Behavior

By default, once the Cryopilot software executes the last step of a profile it
will leave the chiller and mixer as-is until the user stops the profile by pressing
the STOP button. In some cases it is useful to turn the chiller and mixer off
at a certain elapsed time. This is down by placinga TURN CHILLER OFF
instruction after the STOP instruction. Note that this cannot be done using
the Cryopilot profile editor; it must be done manually with a text editor or
spreadsheet application. For example, the following profile will turn the
chiller and mixer off at 311 minutes:

0 -40  OFF
31000 -60  OFF
STOP

311.00 TURN CHILLER OFF

The TURN CHILLER OFF instruction will be visible in the Cryopilot profile
editor, but will have no temperature associated with it.

File Format

Profiles are stored on disk as tab-delimited data files. The character enco-
ding is ASCIl and the file format is case-insensitive. All lines found before
the START token are a description of the file. This means that the descripti-
on cannot contain the word “start”. Between the START token and the opti-
onal STOP token, each line represents a step in the profile. The start time
identifies when the step should start; it has units of elapsed minutes and is
expressed in decimal notation. The start time of the first step must be O, and
start times for successive steps must increase monotonically. Note that the
start time for each step references the profile start time, so three 30-minute
steps would have start times of O, 30, and 60. The chiller setpoint has units
of °C and is expressed in decimal notation. If a STOP token is present, the
next line may be a TURN CHILLER OFF token.
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The following syntax is used to describe the file format:

\n Newline character, here defined as CRLF
\s Zero or more whitespace characters

\t Tab character

<variable> Variable element

[FOO] Optional element

OFF|ON Enumerated value, element must be one or the other
Indicates repeating structure

Format:

[<description>\n]

START\s\n

<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n

[STOP\n
[<start time>\tTURN CHILLER OFF]]

Example (implied \n):
This is a test profile with three steps.

START
0 -20 OFF
30 -60 ON

200 10 OFF

5.6.9 Data Files

During a run, the Cryopilot software monitors the benchtop system
components and records key process values in a data file on the computer.

Cryopilot 5 software can open data files created by Cryopilot 4 as well as

data files created by Cryopilot 5. However, all new data files saved by

Cryopilot 5 will be saved in Cryopilot 5 format. This data file contains the

following process values:

— Chiller heat transfer fluid temperature setpoint and actual heat transfer
fluid temperature

— Chiller mode setpoint (On|Off)

— Mixer mode setpoint (On|Off)

— Temperature measured by up to 14 Type T thermocouples

By default, Cryopilot 5 data files have a .cpd file extension. A Cryopilot data
file is a ZIP file containing two files:

— data.txt, which is a tab-delimited data file

— data.txt.p7s, which is a digital signature in PCKS#7 format.

Spreadsheet programs such as Microsoft Excel can import the tab-delimi-
ted data file, but it is easier to transfer the data using the File > Copy > Data
menu item. Do not attempt to open the data file fora run in progress as the
spreadsheet application may lock the file, thus preventing the Cryopilot
software from writing additional data.
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File Format

The data.txt file and the results of the File > Copy > Data command both
contain tab-delimited text. The character encoding is ASCIl and the file
format is case-insensitive. The first line must contain the creator and version
as specified below. All temperature values have units of °C.

The following syntax is used to describe the file format:

\n Newline character, here defined as CRLF
\s Zero or more whitespace characters
\t Tab character

<variable> Variable element

[FOQ] Optional element

OFF|ON  Enumerated value, element must be one or the other
Indicates repeating structure

Note that times are specified as Universal Coordinated Time (UCT), which
may differ from local time depending on your time zone.

Where no data is available, the file will contain the symbol “NaN” (Not a
Number).

Format:

Cryopilot 5.0\n

METADATA\n

Title\t<title>\n

Process Start\t<timestamp format=yyyy-MM-dd HH:mm:ssZ>\n
Computer\t<computer name>\n

User\t<user name>\n

Description\t<description>\n

START\n

Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply
Temperature Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\
tProduct Temperature 1(C)\tProduct Temperature 2(C)\t...Product
Temperature n(C)\n

<timestamp format=yyyy-MM-dd HH:mm:ssZ>\t<elapsedhours
format=0.000000>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
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Example with four thermocouples (implied \n):
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HTF Supply Temperature

Mixer Status Product 1

Cryopilot 5.0

METADATA

Title Temperature vs. Elapsed Time
Process Start 2009-03-03 21:49:227
Computer DEMO_LAPTOP

User DEMO_LAPTOP\Administrator
Description

START

Date/Time(UTC) Elapsed Time(h)  Chiller Status
Setpoint(C) HTF Supply Temperature(C)
Temperature(C) Product 2 Temperature(C)

Product 4 Temperature(C)

2009-03-03 21:49:31Z 0.002500
2009-03-03 21:49:46Z 0.006667
2009-03-03 21:50:01Z 0.010833
2009-03-03 21:50:16Z 0.015000

On
On
On
On

0.0
0.0
0.0
0.0

21.0

20.7
20.3
20.0

Product 3 Temperature(C)

On
On
On
On

22.8 254 NaN NaN
22.8 253 NaN NaN
22.8 253 NaN NaN
22.8 252 NaN NaN
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5.6.10 Diagnostics|Troubleshooting

Error and status messages are displayed in the message area at the lower
right hand corner of the main window. This section describes common errors
and what may be done in response.

Chiller

In the event of problems with the chiller, the following steps may be helpful:

» Check both ends of the cable between the computer and the chiller.

» Checkthe chiller’s error log. For more information, refer to the Huber
Unistat 705 Operating Instructions.

» Checkthat the chiller communication settings are configured properly.
The Cryopilot A should be set to use baud rate 9600 and protocol RS-232.
For more information, refer to the Huber Unistat 705 Operation
Instructions.

P As a last resort, exit the Cryopilot software, cycle power to the chiller,
and restart the Cryopilot software. Try to ascertain the cause of the
problem before starting another run. Make sure that the settings in the
Options dialog are correct.

If a power failure occurs during a run the chiller may get disconnected or the
data from the chiller may be corrupted. The presence of NaN (not a number)
in the temperature fields of the data file is another indication of a chiller
error.

Shaker

If the shaker does not move when it should, the following may be helpful:
» Checkthe cable between the computer and the shaker.

» Verify that the mode switch at the rear of the mixeris in the Auto position.
P Verify that the speed setting is correct.

Data Acquisition - Device | Thermocouples

The following are common errors related to the data acquisition hardware or
the thermocouples:
— Asensordoes not respond to changes in temperature as the other

sensors do.

Should one of the above occur, the following hints may be helpful:

» Verify that the sensorin question is plugged in to the proper receptacle
in the thermocouple breakout cable attached to the data acquisition
device.

P Be sure that each sensor is properly located and secured. A small errorin
location can cause large deviations compared to other sensors.

» Check connections between the computer and the data acquisition
device.

P Asensor may be damaged. Check the sensorwith a calibrated reader
(e.g. Fluke 725) capable of measuring Type T thermocouples.
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5611 21CFR Part 11

Cryopilot 5 software has been designed to facilitate compliance with the
requirements of 21 CFR Part 11.

Digital signatures are used to prove that the authenticity and integrity of
Cryopilot 5 data files, even on open (i.e. untrusted) systems. The terms
“digital signature” and “electronic signature” should not be confused. A
digital signature is a cryptographic method, whereas an electronic signature
is an electronic equivalent of a handwritten signature with legal implications.
References to electronic signatures in 21 CFR Part 11 do not apply to the
digital signatures used in Cryopilot 5 data files.

Some general notes about implementation:

— Cryopilot 5 relies on the operating system for account management,
authentication, and authorization functions.

— The digital signature algorithm used by Cryopilot 5 is SHA-1 with RSA,
itis written in PKCS#7 format.

— The file system is treated as an untrusted system.

— When a process is stopped, the data file is closed and cannot be opened
again for modification. Any alteration of the data by other means,
whether accidental or malicious, will be detected by the digital signature
mechanism.

— Once data is exported from Cryopilot (e.g. to a spreadsheet), its
authenticity and integrity can no longer be ensured.
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6 System Operation

6.1  Preparing fora Run

611  Cryowedge

To prepare the Cryowedge for use:

» Remove the upper half of the Cryowedge insulated cover.

P Remove the wing nuts holding the transparent cover and set aside.

» Remove the transparent cover. Fill the Cryowedge with the test solution
using a graduated cylinder. Standard volumes for each size Cryowedge
are as follows:

Cryowedge Size Volume (mL)
CW20 (12 inch) 350

CW125 (20 inch) 650
CW300 (30inch) 3000
CW300 (34 inch) 4000

P Replace the transparent cover.

P Replace the wing nuts and tighten them hand tight. Do not over-torque
or strip the threads.

P Replace the upper half of the Cryowedge insulated cover.

P Ensure that the Cryomixer Jr. cable is plugged into the Cryomixer Jr. and
the computer.

» Ensure that at least six thermo-couples are plugged into the data
acquisition device, starting with position 1.

P Place five of the thermocouples through the pre-drilled holes in the
transparent cover. Secure the thermocouples ?” below the surface of the
test solution using plastic spacers or cut pieces of silicon tubing.

P Place the remaining thermocouple on the top of the transparent cover
as a reference temperature at the outer surface of the Cryowedge.

P Record the number and position of each thermocouple for later reference.

612 S*Module

Celsius® Paks are delivered presterilized by gamma irradiation. They are sup-
plied with female Luer fittings and caps on 2 fill|drain ports. A variant with C-
Flex® tubing extensions is also available for sterile filling. All Celsius® Paks
have a closed silicone/EVA thermowell for insertion of a thermocouple
probe.

In order to obtain consistent results, always load the S® Module with the
same number of Celsius® Paks. Ensure that each Celsius® Pak is filled to the
same volume. The thermocouple should be placed at the same depth every
time.
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Fig.20: Thermocouple Holder Attached to
Celsius® Pak

System Operation

The standard freeze profiles provided with the Cryopilot software are desig-
ned for 10 Celsius® Paks, either 30 or 100 mL, filled to nominal volume.
Place thermocouples at a minimum depth of 1cm below the liquid surface
of Celsius® Paks. Blank Celsius® Paks should be filled with sample buffer. Do
not use deionized water in blanks as it typically supercools. If you use fewer
than 10 Celsius® Paks, the freeze completes more rapidly and the profile
does not transfer directly to a larger scale.

Step by step procedure for Celsius® Pak prep, filling and loading:

P Prepare sample and|or buffer for filling Celsius® Paks.

P Insert labelin label holder at the bottom of Celsius® Pak. A label with
dimensions of ~2 x 5 cm fits entirely within the label holder. It is
recommended to use waterproof material and ink for the label. Do not
write on the Celsius® Paks as the solvents used in the ink may penetrate
the Celsius® Pak and contaminate the product.

» Use a syringe or peristaltic pump to fill Celsius® Paks with sample or
buffer through one of the fill|lempty ports. Connect the syringe or pump
via a male Luer® fitting or welded with the optional C-Flex® line.

P Fill Celsius® Paks with a maximum volume of 30 mL for the 30 mL
Celsius® Pak or 100 mL for the 100 mL Celsius® Pak.

/A CAUTION

Do not overfill Celsius® Paks or purge all air from the top of the Celsius®
Paks as this will cause sample and ice expansion into port tubing.

P Close the fill tube with the supplied Luer® cap or pinch clamp.
P> Wipe any excess moisture from all surfaces inside the S* Module, prior to
starting a freeze.

Celsius® Paks are held in the S* Module by a spring clamp mechanism that
holds the Celsius® Pak and acts as an active heat transfer surface. Perform
the following steps for loading the S* Module:

P Attach thermocouple holder to Celsius® Pak by aligning the female Luer
lock on thermocouple holder with the male Luer lock on the top of the
thermowell. After fastening the Luer lock to the thermowell, note that
the front of the thermocouple holder should face the same direction as
the front label of the Celsius® Pak.

P Measure 1cm from the end of the thermocouple and place a mark at this
point for placement of thermocouple within the Celsius® Pak.

» Slowly unscrew the thermocouple locking collar, taking care to collect
the two small o-rings within the locking collar. Place the locking collar
and two o-rings over the end of the thermocouple and screw down the
locking nut just far enough to ensure that it will not fall off the thermo-
couple holder.
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Fig.21: Thermocouple 1cm below Liquid Level
Surface

Fig.23: Thermocouple Holder and Celsius® Pak
Installation

» Lower the thermocouple into thermowell. Never push hard enough to

pierce through the end of the thermowell. For accurate thermal monito-
ring, always place the thermocouples 1 cm below the surface of the liquid
in the Celsius® Pak by ensuring that the mark on the thermocouple
meets the liquid surface.

Tighten the locking collar to secure the thermocouple in place within the
thermowell.

Stand facing the left side of the S* Module; insert a Celsius® Pak between
the clamp mechanisms, starting at slot 10; the slot furthest from the HTF
supply and return. Open the mechanism by placing the clamp release
tool over the 2 guide pegs on the 2 stainless steel pinch blocks for the
slot and pressing down.

While pressing the clamp release tool down, Slide each of the sides of
the Celsius® Pak down between a black block and a stainless steel pinch
block of the clamping mechanism. Position the top of the Celsius® Pak so
it is even with the top of the stationary black metal bar of the clamp me-
chanism. Note that the Celsius® Pak must face left in order to fit properly
into the S* Module.

Withdraw the clamp release tool. The Celsius® Pak will be held tightly on
each side between two metal blocks, one black and one stainless steel.
Connect the male thermocouple plugs to the corresponding thermo-
couple receptacle strip.
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Fig.24: Celsius® Pak Placement and Thermocouple Connection

P Repeat this procedure from slot 9 to 1. Figure contains a diagram of the
final placement of all Celsius® Paks and thermocouples.

NOTE

For reproducibility, load the S* Module with the same number of Celsius® Paks,
fill each Celsius® Pak with the same amount of sample or buffer and place
the thermocouples in the thermowells 1cm below the surface of the liquid.
All freeze profiles developed at Sartorius Stedim Biotech perform correctly
only with a fully loaded system (10 Celsius® Paks). For that reason, results
achieved with the freeze profiles provided with the installation software are
directly scalable to 16.6 Liters. Changing the number of Celsius® Paks affects
the scalability of these profiles.

P Diagram the position and number of each thermocouplein a lab
notebook or in accordance with company policy.
P Close and lock the cover of the S* Module.

Thermocouple Receptacle Strip
) @ @ |
Filled Celsius® Pak Slot Position
' ' ™ I I ) ~ ~ OTF
Inlet
HTF
10 9 8 7 6 5 4 3 2 1 Outlet
\_/ \_/ \_/ \_/ \_/ u \_/ \_/ \_/ \_/

Fig.25: Thermocouple and Celsius® Pak placement in S* Module.
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6.2 Running a Profile

NOTE
When thawing with the S* Module, ensure that the 4 S* Module mounting
knobs are tight and that the module is held securely on the Cryomixer Jr. plate.

/A CAUTION

Never exceed a value of 120 RPM for the Cryomixer Jr.

>

Double click the Cryopilot software icon to initialize the Cryopilot
Software.

Select the Process > Start menu item to display the Start Process dialog.
Provide a file name for the data file where time and temperature data will
be stored for the new process.

Select the Standard profile type and select your application and desired
operation (freeze, thaw, or freeze and thaw). Alternately, select a custom
profile.

Click the OK button to start the process.

Verify that the chiller responds to the commands from the software. The
status indicator in the lower left hand corner should read “Online”. There
will be a 2-5 minute delay before the compressor starts and temperature
regulation commences.

Allow the profile to run to the end of the programmed time.

Select the Process > Stop menu item to stop the process.
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6.3 Removing Frozen Celsius® Paks from the
S° Module

In some cases it is desirable to remove Celsius® Paks from the S* Module
while they are still frozen.

P Remove the transparent top cover of the S* Module.

NOTE

If the unit is left open for an extended period of time while maintained at
low temperature, frost builds up on the clamps, Celsius® Paks and thermo-
couple holders making Celsius® Pak removal difficult. Once the unit is open,
quickly remove the frozen Celsius® Paks and then replace the hood.

» Remove the thermocouples from the Celsius® Paks. If a thermocouple
does not readily pull out, gently twist until it pulls free. Remove the
thermocouple holder from each slot. If condensation builds up on the
surfaces of the clamps, it forms an ‘ice bond’ between the thermocouple
holders and the black metal cooling blocks. This makes removal of the
thermocouple holders nearly impossible. Wipe excess moisture from all
surfaces prior to starting a freeze.

> Remove the frozen Celsius® Paks from the S* Module using the clamp
release tool to slide the Celsius® Paks up and out. Place in an insulated
transport container.

P Inthe freezer, store frozen Celsius® Paks in a protective container at the
desired temperature. If performing stability tests or formulation studies,
it is best to use a controlled freezer with thermal monitoring.

6.4 Dispensing Thawed Samples from the S°
Module

Remove thermocouples and thermocouples holders.

Remove the thawed Celsius® Paks from the S* Module.

Invert each Celsius® Pak three times to ensure uniform product mixture.
Remove desired amount of sample from Celsius® Pak via the unused
filllempty port. This can be done by syringe, pump, or gravity drain.
Discard used Celsius® Paks. Since Celsius®s Paks are sometimes
deformed during freezing and thawing, upon reuse they do not fit as well
between the clamping mechanisms. This can cause prolonged freezing
and thawing due to poor heat transfer.

\AAA 4

v
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/  System Maintenance

Maintenance may be performed by the end-user or by Sartorius Stedim
Biotech. Contact the Sartorius Stedim Biotech Service Department to
establish a Preventive Maintenance Contract.

In the event of a problem, first check the error code section of the
Huber Unistat 705 Operating Instructions. If you are unable to remedy
the situation, call Customer Service (see page 45).

/.1 Cleaning

Exposed equipment surfaces are generally compatible with spray and wipe
with isopropyl alcohol. Stainless steel surfaces may optionally be cleaned
with stainless steel polish.

The internal cabinet of the S contains many parts made of anodized
aluminum which is incompatible with basic solutions such as sodium
hydroxide (NaOH) or oxidizers. These materials should not be used for
cleaning the internal cabinet. Rather, isopropyl alcohol or other non
oxidizing cleaning solutions are recommended if cleaning is necessary.

/72  Changing the Heat Transfer Fluid

Change the heat transfer fluid if it becomes visibly contaminated with water
or particulate, or if you notice a decline in heat transfer efficiency (i.e. when
the unit does not reach or maintain set point temperature). Always change
out the entire amount of HTF. If there is no improvement in heat transfer
efficiency after changing the HTF, call Customer Service (see page 45).

To change the HTF, use the following procedure:

» Verify that the system HTF drain valve located on the front of the unit is
closed. The slot in the screw cap is vertically aligned when closed. See
,Fig.10: Cryopilot AHTF Drain Valve and Sealing Screws”, page 18.

P Remove the sealing screw in the protruding stainless tube on the left
side of the unit and connect a piece of flexible tubing over the end of
tube. Attach securely with a hose clamp.

P Put the far end of the tubing in a container that will hold at least 12 L
(3 gallons) of HTF.

» Open the HTF drain valve by turning counter-clockwise until the slot is
horizontally aligned.

» If possible, attempt to lift Cryowedge or S module to drain residual HTF
from the application module back down into the Cryopilot A.

» When HTF stops flowing, close the HTF drain valve, remove the tubing
from the sealing screw tube, and replace the sealing screw.

» Fill the Cryopilot A system with new HTF according to the procedure in
Chapter ,4.7 Heat Transfer Fluid Fill“, page 17.
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8 Information and Instructions
on Disposal and Repairs

Packaging that is no longer required must be disposed of at the local waste
disposal facility. The packaging is made of environmentally friendly materials
that can be used as secondary raw materials.

The equipment, including accessories and batteries, does not belongin
your regular household waste. EU legislation requires its Member States to
collect electrical and electronic equipment and dispose of it separately
from other unsorted municipal waste with the aim of recycling it.

In Germany and many other countries, Sartorius takes care of the return and
legally compliant disposal of its electrical and electronic equipment on its
own. These products may not be placed with the household waste or
brought to collection centers run by local public disposal operations - not
even by small commercial operators.

For disposal in Germany and in the other Member States of the European
Economic Area (EEA), please contact our service technicians on location or
our Service Centerin Goettingen, Germany:

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Goettingen, Germany

In countries that are not members of the European Economic Area (EEA) or
where no Sartorius affiliates, subsidiaries, dealer, or distributors are located,
please contact your local authorities or a commercial disposal operator.

Prior to disposal and|or scrapping of the equipment, any batteries should be
removed and disposed of in local collection boxes.

Sartorius, its affiliates, subsidiaries, dealers, and distributors will not take
back equipment contaminated with hazardous materials (ABC contaminati-
on) - either for repair or disposal. Please refer to the accompanying manual
orvisit our Internet website (www.sartorius.com) for comprehensive infor-
mation that includes our service addresses to contact if you plan to send
your equipment in for repairs or proper disposal.

Contact Information

24 Hour Customer Service
+1866 424 5600

(toll free North America only)
+1707 747 5614

(outside North America)
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sartorius
EC Declaration of Conformity

biotech

Company Sartorius Stedim Systems GmbH

Address Schwarzenberger Weg 73-79
34212 Melsungen; Germany
Phone +49.551.308.0, Fax +49.551.308.3289
www.sartorius-stedim.com

We hereby declare that based on the design, construction
and version placed on the market, the device designated be-
low fulfills the relevant fundamental safety requirements

o g and health requlations specified by the pertinent EC Direc-
Is the certificate e

?
u p to date * This declaration shall become legally invalid if any modifica-
tions are made to the device, which have not been certified
by Sartorius Stedim Systems.

Authorised person for documentation Sartorius Stedim Biotech GmbH
attn. Marc Hogreve
August-Spindler-Strasse 11
37079 Goettingen, Deutschland
Phone +49.551.308.3752, Fax +49.551.308.2062

Designation of the device Benchtop Freeze-Thaw System
Model, version S3 System, CryoWedge System
Cat.-No. FTH-CS00000-0002, FTH-CS00000-0004, FTH-CS00000-0006,

FTH-CS00000-0008, FTH-CS00000-0010, FTH-CS00000-0012,
FTH-CS00000-0014, FTH-CS00000-0016

Relevant directives of the EC 2004/42/EC  Machinery
2004/108/EC  Electromagnetic Compatibility

2006/95/EC  Electrical equipment designed for use within
certain voltage limits

Applied harmonized standards EN IS0 12100-1:2003, EN ISO 12100-2:2003
EN 61326-1:2006
EN 61010-1:2001

Applied national standards and not applied
Technical specifications

Date and Signature 24.01.2011

7 :
Function of Signatory Lars Bottcher Dr. Susaryfé Gerighausen
Director of R&D for Director of Quality
Automation, Sensors Engineered Systems and
and Instruments Instruments
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Einleitung

1 Einleitung

Sartorius bietet skalierbare Gefrier-Auftauldsungen unter Verwendung
patentierter Technologien zur Handhabung, Lagerung und Beférderung
von Biopharmazeutika, einschlieBlich der Instrumente flr die Prozess-
entwicklung, der Durchfihrung im Pilotumfang und der kommerziellen
Produktion. Die Konfigurationen des Benchtop-Systems sind fur die
Reproduktion der kontrollierten Gefrier-Auftauprozesse, die bei
groBvolumigen Celsius®- und Cryovessel-Prozessen in einer Produktions-
umgebung auftreten, konzipiert. Cryovessel ist eine Produktreihe aus
Edelstahl; Celsius® ist eine Produktreihe fir den Einmalgebrauch. Beide
Systeme nutzen den Kuhler Cryopilot A und den Schttler Cryomixer Jr.

1.1 Cryovessel

Das Benchtop-System fur Cryovessel heif3t Cryowedge. Das Cryowedge-
Modul bildet durch den Abgleich der WarmeuUbertragungsflache des
Gefrierweges und des Konstruktionsmaterials einen kleinen Cryovessel-
Bereich ab.

Die Produktionsvolumenanforderungen fir Machbarkeitsstudien lassen
sich durch die Verwendung der Cryocassette weiter reduzieren. Dabei
handelt es sich um Edelstahlbehélter mit einem Fassungsvermdgen von
30 mL und 100 mL, die sich in Polymermanschetten in den Cryowedge
einsetzen lassen.

1.2  Celsius®

Das Benchtop-System fur Celsius® ist das S>-Modul; S* steht fur ,Scale-
down” (Abwartsskalieren) und Stabilitatsstudien. Das S>-Modul modelliert
die Gefrier-Auftau-Module FT16 und FT100 durch den Abgleich des
Gefrierweges. Das Gefrier-Auftau-System Celsius® S® generiert dhnliche
Gefrier-Auftau-Zeiten und ermoglicht somit skalierbare Gefrier-Auftau-
Tests und Stabilitatsstudien.

1.3 Referenzen

Weitere Informationen zu den Komponenten |hres Benchtop-Gefrier-
Auftausystems finden Sie in den folgenden Dokumenten:

— Gebrauchsanweisung fur den Huber Unistat 705

— Elektrische Schaltpléne fir den Huber Unistat 705

— Produktinformationen zu Dow Syltherm HF

— Materialsicherheitsdatenblatt (MSDS) zum Dow Syltherm HF

— Materialsicherheitsdatenblatt (MSDS) zum DuPont Suva 507

— Materialsicherheitsdatenblatt (MSDS) zum DuPont Suva 23

Betriebsanleitung Celsius® S® Benchtop System
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2 Sicherheit

Beachten Sie sorgfaltig alle Anweisungen, um schwere Verletzungen der
Mitarbeiter, ggf. sogar mit Todesfolge und Schaden an den Geraten zu ver-
meiden. Durch jegliche Nutzung der Systemkomponenten in nicht
bestimmungsgemaBen Anwendungen erloschen die Garantien der Gerate.
In einem solchen Fall GUbernimmt Sartorius keine Haftung.

Die folgenden Symbole zeigen wichtige Informationen an:

A ACHTUNG
Potenziell gefahrliche Situationen, die, wenn sie nicht vermieden werden,
zum Tod fUhren oder schwere Verletzungen nach sich ziehen kdnnen.

/A VORSICHT

Potenzielle geringere Sicherheitsrisiken fir die Mitarbeiter oder potenzielle
Schéden an Geraten oder Eigentum.

HINWEIS

Wichtige, jedoch nicht sicherheitsbezogene Informationen.

2.1  Allgemeine VorsichtsmafBBnahmen

P Stellen Sie sicher, dass die unternehmenseigenen Sicherheitsrichtlinien
jederzeit befolgt werden.

p Beider Durchfihrung von Wartungsarbeiten schalten Sie das Gerat aus
und beachten Sie in den Systemkomponenten die korrekten
Einschaltsicherungs- | Abschaltverfahren.

» Dehnen Sie die Cryohoses nicht, um sie am Kihler oder an der Anlage
anschlieBen zu konnen. Bewegen Sie statt dessen den Kiuhler oder die
Anlage, um die Schlauche im ungestrafften Zustand anbringen zu
konnen. Sorgen Sie fur ein ausreichendes Spiel, um Abknickungen zu
vermeiden.

» Die Systemkomponenten sind schwer. Beachten Sie die korrekten Hebe-
und Montageverfahren.
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2.2 DasWarmetragermedium

Das System nutzt das Dow Syltherm HF-Silikon-Warmetragermedium
(HTF - heat transfer fluid). Verwenden Sie kein anderes
Warmetragermedium.

Mit der Anwendung von HTF sind eine Reihe von Risiken verbunden:

— Temperaturen von bis zu -75 °C und 250 °C kdnnen schwere
Verletzungen der Haut, der Augen und an anderem Weichgewebe
verursachen. Tragen Sie bei der Arbeit mit HTF oder in der Néahe von
heien oder kalten Gerateoberflachen geeignete personliche
Schutzkleidung.

— Syltherm HF hat einen ,Closed-Cup“-Flammpunkt (bei geschlossenem
Tiegel) von 63 °C gemaB ASTM D92. Es ist gemal NFPA und OSHA als
brennbare Flissigkeit der Klasse IIIA definiert. Befolgen Sie die
korrekten Verfahren zur Handhabung und Lagerung.

— Syltherm HF hat eine geringe Oberflachenspannung und es kann sich
als schwierig erweisen, Spritzer beim Beflllen oder Ablassen des
Systems zu vermeiden. Verspritzte | verschittete Fllssigkeit ist duBerst
rutschig. Verwenden Sie ein absorbierendes Material, wie Polypropylen-
Pads, um Tisch und Boden frei von verspritztem | verschittetem HTF zu
halten.

— HTF-Abfallstoffe und Absorptionsmittel missen als Sondermull entsorgt
werden. Weitere Informationen finden Sie in den Produktinformationen
und MSDS.

2.3 Cryopilot A

Die Kuhlgerate durfen nur von qualifizierten Fachkraften gewartet werden.
Der Cryopilot A nutzt den teilhalogenierten Fluorkohlenwasserstoff
(Hydrofluorocarbonat) (H-FKW) R-507 und R-23 als Kéltemittel. Diese
Kaltemittel unterliegen Umweltschutzvorschriften und dirfen nicht in die
Atmosphaére abgelassen werden.

» Weitere Informationen finden Sie in den MSDS.

2.4  CryomixerJr.

P Halten Sie Ihre Hande wahrend des Betriebs fern von der oberen
Abdeckplatte.

» Uberschreiten Sie nicht die im Abschnitt Systeminstallation empfohlene
Hochstgeschwindigkeit des Mixers.
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3 Systemkomponenten

31  Cryopilot A

Der Cryopilot Aiist ein Umwalzkihler, der die Temperatur eines
Warmetragermediums (HTF) auf einen Temperatursollwert regelt.

Das Kaskadenkihl-System kihlt das HTF, wenn die Isttemperatur Gber dem
Temperatursollwert liegt. Die Hauptkomponenten des Kihlsystems sind ein
Hochtemperaturkompressor, ein Niedertemperaturkompressor, ein
Kondensator, ein automatisches Ausdehnungsventil und ein Verdampfer.
Die in den hohen und niedrigen Stufen verwendeten Kaltemittel sind
jeweils R23 und R507. Der Kaltemittelkondensator ist luftgekuhlt.

Ein Paar elektrische Widerstandsheizelemente heizen das HTF auf, wenn
die Ist-Temperatur unter dem Temperatursollwert liegt. Ein groBes
1500-W-Heizelement wird flr gro3e Temperaturanderungen eingesetzt,
ein kleines 100-W-Heizelement fur kleine Temperaturanderungen. Diese
Doppelinstallation der Heizelemente liefert eine prazise Regelung der
HTF-Versorgungstemperatur.

Eine drehzahlveranderliche Pumpe zirkuliert das HTF durch Verdampfer,
Heizelemente und durch die externe Anlage. Bei Cryowedge-Anlagen flief3t
das HTF durch den Mantel- und den inneren Warmeaustauschbereich. Bei
S*-Modul-Anlagen flieBt das HTF durch die Wande neben den Celsius® Pak-
Klemmen. Ein Ausdehnungsbehalter vereinfacht das Beflllen des Systems
und ermdglicht die Expansion und die Kontraktion des HTF.

Der Cryopilot A ist mikroprozessorgesteuert. Die Controller-Benutzerober-
flache verflgt Gber eine Reihe von Druckknopfen, einen Sollwertgeber fur
die Drehzahl, eine LCD-Anzeige mit Touchscreen sowie ein Netzschema
mit Status-LEDs.

Nachfolgend finden Sie die Hauptspezifikationen des Cryopilot A:

Stromversorgung

HINWEIS: Der Cryopilot A wird ohne Stecker geliefert. Auf Grund der
Variationen bei den lokalen Steckdosen muss der Kunde den Stecker
konfektionieren.

Nordamerika 208 VAC, 60 Hz,1~,20 A
Europa 230VAC, 50 Hz,1~,15,6 A
Fluid-Temperaturbereich -75°C bis 250 °C
MaBe (BxTxH) 425x400x720 mm
Gewicht 90 kg
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3.2 Computer

Der Cryopilot A wird mithilfe der Cryopilot-Software auf einem Computer
gesteuert und kontrolliert. Die Cryopilot-Software steuert und kontrolliert
die Benchtop-Systemkomponenten, einschlieBlich Kihler, Mischer und
Thermoelementen. Angaben zu den Mindestsystemvoraussetzungen und
zusatzliche Informationen erhalten Sie im Kapitel ,5 Cryopilot-Software”,
Seite 65.

Computer, die von Sartorius als Teil eines Benchtop-Systems gekauft
wurden, haben folgende technische Daten:

— Laptop-Formfaktor

— Betriebssystem: Microsoft Windows 10 Professional, 64-Bit

— Microsoft Excel

— Adobe Acrobat

— Vorinstallierte Cryopilot-Software

3.3 Cryowedge-Modul

Die Cryowedge-Modulnamen entsprechen dem Volumen von Produktions-
Cryovessel-Einheiten. Ein Cryowedge 125 simuliert beispielsweise ein
125-1-Cryovessel.

Betriebsvolumen 350 -4000 mL, je nach Cryowedge-GroBe
Konstruktionsmaterialien

Gehéause 316 L Edelstahl

Dichtungen Silikon

Abdeckung transparentes Polycarbonat
AnschlUsse HTF-Eingang, HTF-Ausgang mit

Schnellkupplungen

Gewicht, leer

Cryowedge 20 (127) 15 kg
Cryowedge 125 (207) 21kg
Cryowedge 300 (30") 44 kg
Cryowedge 300 (34") 49 kg

GroBenaquivalent
Cryowedge 20 (127) Cryovessel 20L-40 L
Cryowedge 125 (20") Cryovessel 60 L-150 L
Cryowedge 300 (307) Cryovessel 200 L -300 L
Cryowedge 300 (34") Cryovessel 300 L
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Abb.1: Cryocassette-Einheiten aus Edelstahl

3.4 Cryocassette

Die Cryocassette minimiert die Menge an verwendetem Produkt im
Cryowedge. Der Cryowedge kann dann mit Pufferlésung gefillt werden,
wéahrend die Cryocassette mit Produkt gefillt wird. Durch die Konstruktion
der Cryocassette werden die Gefrier- und Auftaueigenschaften der
Cryowedge-Einheit bewahrt, um eine Skalierbarkeit gegenltber den
Produktions-Cryovessel-Einheiten zu gewahrleisten. Die Cryocassette
dient zudem als Behalter mit einer skalierbaren Stabilitat.

Betriebsvolumen — 10 -100 mL, je nach KassettengrofBe.
— Erhaltlich in den GréBen 30 mL und 100 mL

Konstruktionsmaterialien

Gehause 316 L Edelstahl
Schiffchen — Polypropylen (30 mL) oder
— Polyethylen (100 mL)
Sterilisierung Vom Kunden autoklavierbar
Oberflache 10 p-in Ra, EP

3.5 Celsius® S*-Modul

Das Gefrier-Auftau-Modul S*>-Modul liefert die Moglichkeit der
Modellierung von Celsius® FT100- und FT16-Systemen mit nur 20 mL
Produkt. Die Konfiguration der Warmeaustauschflachen innerhalb des
Moduls bietet denselben bidirektionalen Warmefluss wie beim
FT100- System, wenn Rahmen- und Celsius® Paks verwendet werden.

Kapazitat 1-10 Produktproben

Betriebsvolumen 20 mL bis 1L, je nach GroBe der
Celsius® Paks

Konstruktionsmaterialien

Mantel 302-304 Edelstahlmantel

Abb.2: Celsius® S*>-Gefrier-Auftau-Modul

Sockel 6061-T6 Aluminium

Mantelrahmenabdeckung 5052 Aluminium

Abschlussplatten Starre PVC-Schaumplatte

Mantelinnenisolierung Silikonschaumstoff

Abschlussabdeckung fur Delrin
den HTF-Anschluss

Abdeckung Transparentes PVC

Max. Betriebsdruck der 41 barg
HTF-Leitungen

Anschlusse HTF-Eingang, HTF-Ausgang mit
Schnellkupplungen; Ablass

Gewicht Etwa 18 kg
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Frozen16.6 L
Celsius® Pak

Abb. 3: Vergleich zwischen den Celsius® Paks
mit einem Fassungsvermdégen von 30 mL und
16,6 L

3.6 Celsius® Paks

Systemkomponenten

Alle Celsius® Paks haben ungeachtet inrer GroBe dasselbe Konstruktions-
material und dieselbe Gefrier- und Abtauwegstecke, wie in Abbildung 3

dargestellt.

Da Celsius® Paks Artikel fir den Einmalgebrauch sind, entfallt die

Notwendigkeit einer Reinigung.

— Erhaéltlich in den GréBen 30 mL und 100 mL

— Gebrauchsfertiger faltbarer Behalter fir den Einmalgebrauch

— Vorsterilisiert (Gammastrahlung von 25 - 45 kGy)

— Kompatibel mit der RF-Dichtung

— Sterile Temperaturmessung moglich

— Essind Celsius® Paks-Uberziehbeutel erhaltlich. Die Verwendung eines
Uberziehbeutels wird fiir Studien bei héheren Temperaturen (Raumtem-

peratur und hoher) empfohlen.

30 mL und 100 mL Celsius® Pak-Konstruktionsmaterialien

Produkt-Kontaktschicht

EVAM (Ethylenvinylacetatcopolymer,
Monomaterial)

Gas- und Feuchtigkeits-
barriereschicht

EVA|EVOH |EVA

Externe robuste EVA
Handhabungsschicht

Fall- und Ablassanschlisse EVA
Verlangerungsleitungen C-Flex®*

LuerLock®

Polycarbonat oder Polypropylen
(optional C-Flex®)

Doppeltillen-Winkel- oder
Anschlussstiick

Polypropylen (optional C-Flex®)

Schutzrohr

Pt-gehartetes Silikon

* C-Flex® is a registered trademark of Saint-Gobain Performance

Plastics Corporation
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3.7  CryomixerJr.

Der Cryomixer Jr. ist ein Hubkolbenmischer, der unter dem Cryowedge oder
dem S*-Modul aufgestellt wird, um so die Homogenitét des aufgetauten
Produkts zu gewahrleisten. Die Hubkolbenbewegung beginnt automatisch
bei Aktivierung der Cryopilot-Software. Der Cryomixer Jr. wird sowohl fur
Agitationsanlagen des Cryowedges als auch des S>-Moduls verwendet.

Technische Daten

Hub 25 mm, reziprok
Abb. 4: Cryomixer Jr. Stromversorgung
Nordamerika 15V, 60 Hz, 1~
Europa 230V, 50 Hz, 1~
MafBe (BxTxH) 505 x 585 %120 mm
Gewicht 24 kg

3.8 Cryohose

Alle Systeme nutzen zwei Cryohoses fur die Zufuhr und Rickleitung des
HTF von der Cryopilot A-Einheit. Diese Leitungen bestehen aus Edelstahl
mit einem Isolationsmantel.

3.9 Cryowrap

Cryowrap ist eine Neoprenmanschette, die um die Cryohose-Anschlisse
gewickelt wird. Sie verhindert, dass sich beim Einfriervorgang des
Cryowedges oder S*-Moduls eine Eisschicht an den AnschlUssen bildet.

310 Datenerfassungsgerat

Das Datenerfassungsgerat ist ein kompaktes Modul zur Digitalisierung von
Thermoelementsignalen fiir die Uberwachung durch den Computer. Das
Datenerfassungsgerat verfugt Gber eine Kabelpeitsche mit Anschltssen fur
bis zu 16 Thermoelementen vom T-Typ.
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4  Systeminstallation

Dieses Kapitel fuhrt Sie durch die Konfiguration des Benchtop-Systems.

41  Furdie Installation bendtigte

Folgende Werkzeuge werden fur die Einrichtung des Benchtop-Gefrier-

Werkzeuge | Gerate

Auftau-Systems bendtigt:

Verschiedene Schraubendreher fir Kreuzschlitz- und
Senkkopfschrauben

Eine Klemmzange mit einem Griff von wenigstens 15 cm
Verschiedene Ring- oder RollgabelschlUssel

Absorptionsmaterial, wie Polypropylen-Pads zum Aufwischen von

verschittetem |verspritztem HTF

Ein zum Messen der Versorgungsspannung geeignetes Multimeter

4.2 Lieferumfang

Stellen Sie nach dem Auspacken aller Komponenten aus den Verpackungen
sicher, dass die folgenden Komponenten fir die Installation vorhanden sind:

Cryopilot A

Cryowedge oder S*-Modul

Cryomixer Jr.

(2) Cryohoses

(4) Cryowraps

Thermoelemente vom Typ T (je nach System bis zu 10 Stlick)
Kabel, USB an Cryomixer Jr.

Computer mit Cryopilot-Software
Datenerfassungsgerat, National Instruments USB-9213
Kabel, USB an Unistat

Warmetragermedium Dow Syltherm HF (~19 L)
Sicherheitssiphon

Isolierte Cryowedge-Abdeckung (nur Cryowedge)
Drei Cryocassette-Einheiten (nur Cryowedge)

(10) Celsius® Paks (S*-Modul)

(10) Thermoelement-Halter (nur S>-Modul)
Klemmenwerkzeugschlissel (nur S*-Modul)

Betriebsanleitung Celsius® S® Benchtop System
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4.3 Auswahl eines Standorts

Stellen Sie das System auf einer trockenen, ebenen Oberflache, wie einem
Labortisch oder einem Tisch, der ein Gesamtgewicht von ~180 kg tragt, auf.
Ein typisches Benchtop-System bendtigt etwa eine Standflache von 188 cm
Breite und 76 cm Tiefe. Die ordnungsgemafBe Aufstellung und die bendtig-
ten Freiraume sind in Abbildung 5 dargestellt. Der Cryopilot A ist luftge-
kihlt und bendtigt eine ausreichende Bellftung. Stellen Sie das Gerat nicht
auf Wagen mit Radern auf, da der Cryomixer Jr. vor und zurlck schwingt.

188 cm (Ref.)
S3-Modul od g 7 7
-Modutoaer oo Freiraum von|mindestens 8 cm
Cryowedge o m |
B
\ 20
=0
7 g <
w £ c
— (&)
Cryopilot A —ji— h
Laptop ——— / ‘¢Mind446cm+
Computer Z
Anschluss-  Cryomixer Jr.

kasten

Erforderliche Tiefe von 76 cm (Ref.)

Abb. 5: Platzbedarf

4.4 Montage von Cryowedge und Cryohose
(Schlauchverbindung fur
Warmetragermedium HTF)

A VORSICHT

Dehnen Sie die Cryohoses nicht und knicken Sie sie nicht ab, um sie am
Cryowedge anzuschlieBen. Dies kann zu Leckagen flhren. Lassen Sie
ausreichend Spiel.

AVORSICHT

Halten Sie beim Anziehen der Cryopilot A-Verbindungselemente mit einem
geeigneten Gegendrehmoment gegen, um Schaden an der Leitungsinnen-
seite zu vermeiden.

» Ummanteln Sie den Cryowedge mit der im Lieferumfang enthaltenen
Isolierabdeckung. Stellen Sie sicher, dass die Ein- und Auslassanschlisse
fUr das Warmetransferfluid (HTF) freiliegen.
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> Platzieren Sie denisolierten Cryowedge auf den Cryomixer Jr. Richten
Sie den Cryowedge so aus, dass die Bewegung des Cryomixer Jr. das
Mischen entlang der gesamten Cryocassette-Lange oder ab dem Punkt
des Cryowedges (entspricht der Position des inneren Cryovessel-
Waérmeaustauschers) bis zur AuBenwand (entspricht der Position des
Cryovessel-Mantels) gestattet.

p Schieben Sie Uber jede Leitung zwei Cryowraps.

HINWEIS

Die Schnellkupplungen sind werkseitig an den Adaptern und Leitungen
vormontiert. Wenn es erforderlich ist, Verbindungen zu 16sen und neu anzu-
schlieBen mit konischen Gewinden, verwenden Sie ein Gewindedichtmittel,
wie beispielsweise Loctite 567.

Anschlussstlck Anschlussstlck
M16x1 M24x1,5
_"Sanitarflansch* M16x1
Adapter Anschlussstlck 16

%“—\/\/\/\—W—HF Cryopilot A

N
Cryowedge {

Adapter* Adapter
%"-Schnell-  %"-Schnell- Isolierter Schlauch,
kupplung kupplung 1,5m
(Stecker) (Buchse)

Abb. 6: Montage der Schlauchverbindung Cryohose fir den Cryowedge

p Verbinden Sie den Anschluss ,Thermofluid out” (HTF-Auslass) am
Cryopilot A mit dem Einlassanschluss am Cryowedge, wie in der
Abbildung 6 dargestellt. Der Einlassanschluss am Cryowedge befindet
sich an der AuBenwand, diesentspricht der Position des Cryovessel-
Mantels.

» Verbinden Sie den Anschluss ,Thermofluid in“ (HTF-Einlass) am
Cryopilot A mit dem Auslassanschluss am Cryowedge, wie in der
Abbildung 6 dargestellt. Der Auslassanschluss am Cryowedge befindet
sich an einem Punkt, der der Position des inneren Cryovessel-
Warmeaustauschers entspricht.

P Stellen Sie sicher, dass alle Leitungen korrekt angeschlossen sind.
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45 Montage des S*>-Moduls

AVORSICHT

Dehnen Sie die Cryohoses nicht und knicken Sie sie nicht ab, um sie am
S*- Modul anzuschlieBen. Dies kann zu Leckagen fuhren. Lassen Sie
ausreichend Spiel.

A VORSICHT

Halten Sie beim Anziehen der Cryopilot A-Verbindungselemente mit einem
geeigneten Gegendrehmoment gegen, um Schaden an der Leitungsinnen-
seite zu vermeiden.

P Stellen Sie das S*-Modul auf den Cryomixer Jr., wie in der Abbildung 7
dargestellt, sodass die Bewegung des Cryomixer Jr. ein Mischen entlang
der gesamten Celsius® Pak-Lange erméglicht.

| . Pos.  Beschreibung

l, 5 : 1 Outlet Port
‘ 2 Inlet Port
3 Mounting Knobs

2 » Fixieren Sie das S>-Modul an der Cryomixer Jr.-Platte. Ziehen Sie dazu
die vier Montageknopfe unten am Modul an.
P Schieben Sie Uber jede Leitung zwei Cryowraps.

! HINWEIS

Die Schnellkupplungen sind werkseitig am S* und an den Leitungen
Abb.7: Positionierung des $*-Moduls vormontiert. Wenn es erforderlich ist, Verbindungen mit konischen

Gewindeverbindungsstlicken zu [6sen und neu anzuschlieBen, verwenden
Sie ein Gewindedichtmittel, wie beispielsweise Loctite 567.

Anschlussstiick Anschlussstlck
M16x1 M24x1,5

M16x1
Adapter Anschlussstick 16

|

S$* Module #“—\/\/\/\—W—HF Cryopilot A

Adapter
%"-Schnell- %"-Schnell- Isolierter Schlauch,
kupplung kupplung 1,5m
(Stecker) (Buchse)

Abb.8: Cryohose-Montage am S*-Modul
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Abb. 9: Cryopilot A-Hauptnetzschalter
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» Verbinden Sie den Anschluss ,Thermofluid out” (Thermofluid-Auslass)
am Cryopilot A mit dem Einlassanschluss des S>-Moduls. Bei dem
Einlassanschluss handelt es sich um den unteren der beiden
Schnellkupplungsanschlisse am S°.

» Verbinden Sie den Anschluss ,Thermofluid in“ (Thermofluid-Einlass)
am Cryopilot A mit dem Auslassanschluss des S*>-Moduls. Bei dem
Auslassanschluss handelt es sich um den oberen der beiden
Schnellkupplungsanschlisse am S°.

P Stellen Sie sicher, dass alle Leitungen korrekt angeschlossen sind.

4.6 Konfiguration des Cryopilot A

/A ACHTUNG

Alle Verdrahtungen und Verkabelungen sollten von einem fachkundigen
Elektriker vorgenommen werden.

P Stellen Sie sicher, dass der Cryopilot A-Hauptnetzschalterin der Stellung
.OFF“ (Aus) oder,0" steht. Der Schalter ist rot-gelb und befindet sich
auf der Rickseite des Cryopilot A, wie in Abbildung 9 dargestellt.

P Lassen Sie sich von einem fachkundigen Elektriker einen Stecker (nicht
im Lieferumfang enthalten) am Netzkabel des Cryopilot A konfektionie-
ren. Der Stecker muss zur Steckdose passen und auf die Netzspannung
und den Netzstrom ausgelegt sein. Die technischen Angaben zur Strom-
versorgung finden Sie im Kapitel ,3 Systemkomponenten”, Seite 52.

» SchlieBen Sie die Cryopilot A-Einheit an der Stromversorgung an.

» Drehen Sie den Cryopilot A-Hauptnetzschalter in die Stellung ,ON”
(Ein).

p Stellen Sie sicher, dass alle LEDs kurz aufleuchten und dass die recht-
eckige LCD-Display aufleuchtet. Ist dies nicht der Fall, stellen Sie sicher,
dass die Cryopilot A-Einheit mit Strom versorgt wird. Wird die Cryopilot
A-Einheit mit Strom versorgt, der Controller wird jedoch nicht aktiviert,
wenden Sie sich an den Kundendienst (siehe Seite 93).

4.7  Befullung mit Warmetragermedium HTF

Es wird empfohlen, fir die Konfiguration des Benchtop-Systems etwa 19 L
HTF bereit zu halten. Als Warmetragermedium wird auf Grund seines
niedrigen Gefrierpunktes und der geringen Viskositat Gber einen groBen
Temperaturbereich Dow Syltherm HF verwendet. Weitere Informationen
finden Sie auf dem Materialsicherheitsdatenblatt (MSDS) zu Dow
Syltherm HF.

HINWEIS

Dow Syltherm HF ist das einzige zulassige Warmetragermedium, das
in diesem System verwendet werden darf.
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P Stellen Sie sicher, dass das Ablassventil geschlossen ist (drehen Sie esim

Uhrzeigersinn in die senkrechte Stellung und verschlieBen Sie die untere
Dichtschraube seitlich am Cryopilot A, wie in Abbildung 10 dargestellt).

1 2 3

Abb.10: HTF-Ablassventil und Dichtschrauben des Cryopilot A

Pos. Beschreibung

Hauptablass-HTF Ablass-Dichtschraube

HTF-Ablassventil

Sichtscheibe Ablauf, Dichtschraube

Entfernen Sie die Einflllkappe oben auf dem Cryopilot A, hinter der
Sichtscheibe.

Heben Sie den Behalter mit Syltherm HF Uber die Hohe des Cryopilot A
an.

FUhren Sie das Schlauchende der Handpumpe in den Cryopilot A und
das Ventilende in den Syltherm HF-Behalter ein. Tauchen Sie das rote
Ventilende ins Syltherm HF ein und bewegen Sie es auf und ab, um die
Handpumpe zu aktivieren. Um das HTF-Beflllen zu stoppen, heben Sie
das rote Ventilende aus dem Syltherm HF. Befullen Sie die Cryopilot A-
Einheit bis zur 2-I-Markierung des Schauglases.

Starten Sie eine manuelle LuftspUlung (dricken Sie ,Start”, ,Start Air
Purge” (Luftspllung starten), ,30s interval” (30-s-Intervall), ,OK").
Geben Sie je nach Bedarf mehr HTF zu, bis sich das Schauglasniveau bei
2 L stabilisiert.

Stellen Sie sicher, dass in den Leitungsanschlissen keine Leckagen
vorhanden sind.

Stoppen Sie die Pumpe (dricken Sie ,Stop” (Stopp), , Air Purge Off”
(Luftspulung aus)).

Fixieren Sie die Cryowraps Uber den freiliegenden Metallflachen am
Ende der beiden Leitungen.
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4.8 Konfiguration des Cryomixer Jr.

P SchlieBen Sie den Cryomixer Jr. an die Stromversorgung an.

P Stellen Sie den Handbetriebsschalter an der Vorderseite des Cryomixer
Jr.in die Stellung ,O".

P Stellen Sie den Schalter ,Manual | Automatic” (Manuell | Automatisch)
auf der Ruckseite des Cryomixer Jr., wie in Abbildung 11 dargestellt, in die
manuelle Stellung (nach unten).

» Drehen Sie den Drehzahlknopf bis zum Anschlag entgegen dem
Uhrzeigersinn (O U/Min.).

» Drehen Sie den Handbetriebschalter in die Stellung ,,1”.

» Drehen Sie den Geschwindigkeitsknopf langsam im Uhrzeigersinn, bis
die korrekte Drehzahl erreicht ist. Protokollieren Sie die angezeigte
Drehzahl gemafB der LCD-Anzeige am Cryomixer Jr. Nachfolgend ist die
Standardkonfiguration aufgefuhrt:

— Die Cryowedges CW20 und CW125: 45 U/Min.
— Die Cryowedges CW300 (30“) und CW300 (34): 35 U/Min.
— S$’-Modul: 120 U/Min.

HINWEIS

Die Einstellungen der Mischerdrehzahl konnen je nach kundenspezifischer
Produktcharakterisierung variieren. Wenden Sie sich zur Besprechung von
Abweichungen von den oben aufgefuhrten Empfehlungen an Sartorius.

P Stellen Sie den Schalter ,Manual|Automatic” (Manuell|Automatisch) auf
der Rickseite des Cryomixer Jr., wie in Abbildung 11 dargestellt, in die
automatische Stellung (nach oben).

4.9 Computerkonfiguration

P SchlieBen Sie den Computer und das Display an der Stromversorgung
an. Es wird empfohlen, einen Uberspannungsschutz (nicht im
Lieferumfang enthalten) zu verwenden.

P Schalten Sie Computer und Display ein. Beantworten Sie die Fragen in
den Windows-Konfigurationsdialogfeldern zur ,ersten Inbetriebnahme”.
Moglicherweise missen Sie dazu einige Daten bei lhrer IT-Abteilung
erfragen.

AVORSICHT

Auf Computern von Sartorius ist keine Virenschutzsoftware installiert. Es
wird empfohlen, eine Virenschutzsoftware gemaf den Richtlinien Ihres
Unternehmens zu installieren.
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Abb.12: Serielle Schnittstelle des Cryopilot A

410 Konfiguration der Datenerfassung

| 2

>

SchlieBen Sie den National Instruments USB-9213 lGber ein USB-Kabel
am Computer an.

SchlieBen Sie das USB-Kabel des Cryomixer Jr. mit dem einen Ende

an der Buchse auf der Rickseite des Cryomixer Jr. an. SchlieBen Sie das
andere Ende an einem USB-Anschluss am Computer an.

Bei S*>-Modulen schlieBen Sie das Bundel aus Thermoelementsteckern,
die vom S*-Modul kommen, an der Kabelpeitsche des Thermoelements
an. SchlieBBen Sie den Stecker 1an die Buchse 1, den Stecker 2 an die
Buchse 2 usw. an. SchlieBen Sie die Celsius® Pak-Thermoelemente an
der Sammelleiste im Haubenabdeckungsbereich des S*-Moduls an.
SchlieBen Sie, wie in Abbildung 12 dargestellt, ein Ende des Kabels, USB
an Unistat, an einem USB-Anschluss des Computers und das andere
Ende an der seriellen Schnittstelle unterhalb der Combox an. Die
Combox befindet sich auf der Rickseite des Cryopilot A.
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5 Cryopilot-Software

51  Uberblick

Das Benchtop-System wird von der Cryopilot-Software, einer grafischen
Anwendung fir Computer mit dem Betriebssystem Microsoft Windows,

gesteuert und kontrolliert. Die Cryopilot-Software bietet den Benutzern die

flexible Ausfiihrung von Gefrier- und Auftauvorgangen.

Im folgenden Diagramm wird die Beziehung zwischen den System-
komponenten dargestellt. Die Cryopilot-Software wird Gber USB mit dem

Cryopilot A-Kihler und dem Schuttler Cryomixer Jr. sowie Uber ein National

Instruments-Datenerfassungsgerat mit bis zu 16 Thermoelementen
verbunden.

Computer
usB usB usBe
Iy A
USB to Unistat Cable USB to Cryomixer Jr. Cable
USB Cable FTH-DA0D000-0062 FTH-DA00000-0061
A4 Y Y
National
Instruments Cryopilot A Cryomixer Jr.
USB-9213

A

16x Type T Thermocouple Cable
FTH-DAQ0000-0065

Cryowedge or §*

Abb.13: Cryopilot-System

5.2 Mindestsystemvoraussetzungen

Die Cryopilot-Software ist werkseitig als Teil eines Benchtop-Systems auf

denbei Sartorius bestellten Computern installiert. Alternativ ist sie fur

Systeme, die folgende Voraussetzungen erflllen, auf USB Flash Drive

erhaltlich:

— Betriebssystem: Microsoft Windows 7 Professional, 32-Bit mit Service
Pack 1 oder Microsoft Windows 10 Professional, 64-Bit.

— Datenerfassungsgerat: National Instruments USB-9213.

Die Cryopilot-Software ist mit einem Installationsprogramm ausgestattet,
das die Cryopilot-Software und alle erforderlichen Treiber von Drittanbie-
tern auf Inrem Computer installiert. Zur Installation von Cryopilot missen
Sie Uber Administratorrechte verfligen.
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5.3 Komponenten

Die Cryopilot-Software wird standardmaBig in C:\Programme\Sartorius
Stedim Biotech\Cryopilot 5 fir ein 32-Bit Betriebssystem und in C:\
Program Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 fur ein 64-Bit
Bestriebssystem installiert - nachfolgend als Installationsverzeichnis
bezeichnet. Nachfolgend finden Sie eine Beschreibung der Dateien und

Ordnerim Installationsverzeichnis:

Komponente

Beschreibung

Profiles /(Profile)

Verzeichnis fur die Standardprofil-
dateien von Cryopilot.

BouncyCastle.Crypto.dll

Support-Bibliothek

Cryopilot.chm

Hilfedatei

Cryopilot.exe

Die ausfuhrbare Datei fur die
Cryopilot-Software. Die
Verknupfungen zu dieser Datei
werden auf dem Desktop platziert
und im Startmend verankert.

Cryopilot.exe.config

Konfigurationsdatei

ICSharpCode.SharpZipLib.dll Support-Bibliothek
libftdi.dll Support-Bibliothek
log4net.dll Support-Bibliothek

Nationallnstruments.Common.dll

Support-Bibliothek

Add Nationallnstruments.
NiLmClientDLL.dII

Support-Bibliothek

Add Nationallnstruments.
MStudioCLM.dII

Support-Bibliothek

Nationallnstruments.DAQmx.dll

Support-Bibliothek

NPlot.dll

Support-Bibliothek

uninsO00.dat

Deinstallations-Hilfedatei

uninsO00.exe

Deinstallationsprogramm

Zusatzlich zu den Dateien im Installationsverzeichnis erstellt das Cryopilot-
Installationsprogramm einen Ordner ,Cryopilot” im Ordner ,Meine
Dokumente” eines jeden Benutzers. Dieser wird nachfolgend als Benutzer-
verzeichnis bezeichnet. Nachfolgend finden Sie eine Beschreibung der
Dateien und Ordner im Benutzerverzeichnis:
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Komponente Beschreibung

Data/ (Daten) Standardverzeichnis fur die von den Benutzern
gespeicherten Dateien. Die Benutzer konnen Dateien
auch an einem anderen Speicherort auf dem Computer
oder auf einem Netzwerklaufwerk speichern.

CustomProfiles/  Standardverzeichnis flr die von den Benutzern

(Benutzer- gespeicherten benutzerdefinierten Profile. Die

definierte Profile) Benutzer kdnnen Dateien auch an einem anderen
Speicherort auf dem Computer oder auf einem
Netzwerklaufwerk speichern.

Dateien, die geandert werden konnen, die jedoch fir alle Benutzer verflig-
bar sind, sind in C:\Programme\Sartorius Stedim Biotech\Cryopilot 5
gespeichert.

Komponente Beschreibung
log.txt Datei, die zur Fehlerbehebung der Software
settings.xml Konfigurationsdatei

Das Cryopilot-Installationsprogramm installiert ferner mehrere zuséatzliche
Bibliotheken: Microsoft NET Framework 4.6.1, National Instruments NI-
DAQmx und USB-Treiber.

5.4 Installation

Legen Sie zum Installieren der Cryopilot-Software die USB Flash Drive ein,
und doppelklicken Sie auf ,mysetup.exe”. Fur die Installation sind
Administratorrechte erforderlich. Wenden Sie sich an den System-
administrator, wenn Sie nicht Gber die erforderlichen Rechte verfigen.

Die Standardeinstellungen kdnnen normalerweise Ubernommen werden.

Wenn der Installationsvorgang abgeschlossen ist, werden Sie zum Neustart
des Computers aufgefordert.

HINWEIS

Es ist wichtig, dass der Computer konfiguriert wird, damit er nicht ange-
halten oder heruntergefahren wird, wahrend ein Gefrier-| Auftauprozess
ausgefuhrt wird.

Windows 7 oder Windows 10: Rufen Sie ,Systemsteuerung > System und
Sicherheit > Energieoptionen” auf. Wahlen Sie ,Hochstleistung” aus. Klicken
Sie auf ,Energiesparplaneinstellungen andern”, und klicken Sie dann auf
.Erweiterte Energieeinstellungen andern”. Legen Sie unter ,Festplatte” die
Option ,Festplatte ausschalten nach” auf ,Nie” fest. Legen Sie unter ,USB-
Einstellungen” die Option ,Einstellung fur selektives USB-Energiesparen”
auf ,Deaktiviert” fest. Klicken Sie auf ,OK", und schlieen Sie dann die
Systemsteuerung.
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5.5 Benutzeroberflache

551 Hauptfenster

Das Hauptfensterist der von der Cryopilot-Software hauptsachlich verwendete
Bildschirm. Dieses Fenster umfasst MenUoptionen zur Interaktion mit dem
Programm, ein Diagramm zur grafischen Anzeige von Prozessdaten sowie eine
Legende zur Auswahl der Kurven, die im Diagramm angezeigt werden sollen.

1 —=HCryoPilot - N:\CryoPilot\Data\2009-03-03-13-48-43.cpd 9w X
2 ——File  Edt Process Tooks Help
3 wadlg Rl e el
Temperature vs. Elapsed Time 0:23:59—‘— 6
=L i HTF Setpoint |
24 — 7
o 0.0 «
HTF Supply
20 - 8
1 -1.3 «
4 - 1 || product 1 9
o 14 22.8 °C
%12 Product 2
Sof 24.8 «
]
8 Product 3
sl == aC
ar Product 4
A == o
0 Product 5
2k
-— o
4 o.’os o‘.1 o.|15 0z [ Izs o‘.: 0 ‘35 Product &
Elapsed fime, h =
5 Tjon\lne
Abb.14: Hauptfenster
Pos. Steuerung Beschreibung
1 Titelleiste Zeigt den Namen der Anwendung

und den Namen der aktuellen Datei
an, sofern zutreffend.

2 Mendleiste Enthalt MenUs zur Durchfihrung
allgemeiner Aufgaben.

3 Symbolleiste Enthalt Schaltflachen zur
Durchfihrung allgemeiner Aufgaben.

4 Statusleiste Zeigt den Status der Gerate an,
entweder Online oder Offline.

5 Diagramm Zeigt eine Grafik der Temperaturin
Relation zur abgelaufenen Zeit an.

6 Anzeige der abgelaufenen Zeigt an, wie viel Zeit seit

Zeit Prozessbeginn vergangen ist.

7 Legendenpunkt HTF-Sollwert Zeigt den Sollwert des
Waérmetragermediums (HTF) an.

Legendenpunkt HTF-Zufuhr  Zeigt die HTF-Isttemperatur an.

Legendenpunkt Produkt N Zeigt die Temperaturdes N. Typ T-
Temperatursensors an. Je nach Hard-
ware konnen bis zu 16 Temperatur-
sensoren Uberwacht werden.
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5.5.2 Das Dialogfeld ,Start Process” (Prozess starten)

Das Dialogfeld ,Start Process” (Prozess starten) fordert den Benutzer zur
Eingabe von Informationen auf, die wahrend des Prozesses verwendet

werden.

Start Process
General
1 ——— Chart Litle: Temperature vs, Elapsed Time
2 ——— Datafilename: | N:\CryoPilotiDatal2009-03-03-14-52-52.cpd led —or ¢
3 ——— Use profile: ) None
() Standard
Application: |53 20mL w— 7
Process: Freeze .v!—— 8
() Custom
4 v 9
5 = Description: 10 Celsius-Paks 30ml containing buffer, used for
profile development
[ ok || cancet |

1 10

Abb.15: Das Dialogfeld ,Start Process” (Prozess starten)

Pos. Steuerung

Beschreibung

1 Chart Title
(Diagrammtitel)

Titel, der oben im Diagramm angezeigt wird.
Der Standard ist , Temperature vs. Elapsed
Time" (Temp-Zeit-Diagramm).

2 Data Filename
(Dateiname)

Der vollstandige Dateiname, unter dem die
Daten fUr diesen Prozess gespeichert werden.
Der Standard ist [User Directory]\Data\[date
code].cpd, wobei [date code] (Datencode)
eine numerische Zeichenfolge bestehend aus
Jahr, Monat, Tag, Stunde, Minute und
Sekunde ist.

3 Wahlschalter Profile
Type (Profiltyp)

Bietet drei Optionen: None (Kein) - fur kein
Profil; Standard - fir ein von Sartorius
bereitgestelltes Standardprofil; oder Custom
(Benutzerdefiniert) - fur ein vom Benutzer
erstelltes Profil.

4 Profile Filename
(Profildateiname)

Dervollstandige Dateiname, unter dem das
benutzerdefinierte Profil zu finden ist.
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Pos. Steuerung

Beschreibung

5 Description
(Beschreibung)

Ein Feld zur Eingabe zusatzlicher
Informationen zum Prozess.

6 Wahlschalter
,Data Filename”
(Dateiname)

Z

Offnet ein Dialogfeld zur Auswahl eines
Ordners und eines Dateinamens, in dem bzw.
unter dem die Daten fur diesen Prozess
gespeichert werden.

7 Wahlschalter
LJApplication”
(Anwendung)

Bietet sechs Optionen, wenn der Profiltyp

.Standard” ausgewahlt ist:

— $°30 mL - fur S*-Modulsysteme mit zehn
30-mL-Celsius® Paks - S*100 mL - fir
S*-Modulsysteme mit zehn 100-mL-
Celsius® Paks

— Cryowedge 12"

— Cryowedge 24"

— Cryowedge 30"

— Cryowedge 34"

8 Wahlschalter
.Process” (Prozess)

Bietet drei Optionen, wenn der Profiltyp

.Standard” ausgewahlt ist:

— Freeze (Einfrieren) - fihrt die Aktion ,Nur
einfrieren” aus- Thaw (Auftauen) - fihrt
die Aktion , Nur auftauen” aus

— Freeze and Thaw (Einfrieren und Auftauen)
- fuhrt die Aktion ,Einfrieren” gefolgt von
der Aktion , Auftauen” aus

9 Wahlschalterselector
,Profile Filenname”
(Profildateinamen)

Offnet ein Dialogfeld zur Auswahl eines
Ordners und eines Dateinamens, in dem bzw.
unter dem das benutzerdefinierte Profil zu
finden ist.

10 Die Schaltflache

,Cancel”

(Abbrechen)

Verwirft die Daten und schlie3t das
Dialogfeld, ohne den Prozess zu starten.

" Die Schaltflache

,OK"

Ubernimmt die Daten, schlieBt das Dialogfeld
und startet den Prozess.
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5.5.3 Das Dialogfeld ,Options” (Optionen)

Die Cryopilot-Software kann mithilfe des Dialogfelds ,Cryopilot
Configuration” (Cryopilot-Konfiguration) konfiguriert werden. Wéhlen Sie
im Hauptfenster die Menuoption ,Tools” (Extras) > ,Options” (Optionen).

7
M‘

Certificates IHardWarB |

Digital certificates are used to ensure the authenticity and inkegrity of CryoPilot data
files, Yaou may obtain a digital certificate by clicking the Create button below or by
contacking waur swstem administratar,

Select a digital certificate to use when saving data files:

| Issued b

| Issued to

| Friendly name | Expiration date |

SARTORIU-754...

Create Wienw

SARTORIU-7E4...

CryoPilok

3442011

Manage

Cancel |

2 3

[ o ]

|
I
4 5 6

Abb.16: Dialogfeld ,Options” (Optionen) - Registerkarte , Zertifikat”

Pos. Steuerung Beschreibung

1 Zertifikatsliste Zeigt eine Liste mit verfligbaren digitalen
Zertifikaten an. FUr jedes Zertifikat zeigt die
Liste an, wer das Zertifikat ausgestellt hat, an
wen das Zertifikat ausgestellt wurde, den
Anzeigenamen sowie das Gultigkeitsdatum.

2 Schaltflache Erstellt ein selbst unterzeichnetes Zertifikat und
,Create” installiert esim Ordner ,Trusted Root
(Erstellen) Certification Authorities” (Vertrauenswurdige

Stammzertifizierungsstellen®).

3 Schaltflache Zeigt weitere Einzelheiten fUr das ausgewahlte
LView” (Ansicht) Zertifikat an.

4 Schaltflache Offnet die Microsoft Management Console fiir
.Manage” weitere Zertifikatsverwaltungsaufgaben, wie
(Verwalten) das Erneuern und Loschen von Zertifikaten.

5 Schaltflache ,OK” Ubernimmt die Anderungen und schlieBt das

Dialogfeld.

6 Schaltflache Verwirft die Anderungen und schlieBt das
,Cancel” Dialogfeld.

(Abbrechen)

7 Registerkarte Wechselt zur Registerkarte ,Hardware”.
,Hardware”
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7

Certificates | Hardware |

Data Acquisition
A data acquisition device is used to read temperature sensors. Select an
available device from the st below or select None to disable data acquisition:

Device: |UsB-9213 (Dev1) ]

Chiller

A chiller is used to control the temperature of the heat transfer fluid (HTF).
Select a device from the list below:

Type:  |Huber Unistat v

Port: [coms |v

Shaker

A shaker is used to agitate product during thaw. Select a device from the
list below or select None to disable shaking.

Device: ‘USBCryoMixsf . Interface .V.]

][ Cancel ]

2

Abb.17: Options Dialog - Hardware Tab

Pos. Steuerung Beschreibung
1 Wahlschalter ,Data Die Option ,None” (Kein) konfiguriert die
Acquisition Device” Anwendung auf ,No Data Acquisition” (Keine
(Daten- Datenerfassung). Wenn ein kompatibles
erfassungsgerat) National Instruments-Datenerfassungsgerat
erkannt wird, wird es automatisch ausgewahlt.
2 Wahlschalter Durch Auswahl der Option ,None” (Kein) wird
,Chiller” (Kahler) die Anwendung auf ,Kein Kihler” konfiguriert.
Durch die Auswahl der Option ,Huber
Unistat” wird die Anwendung auf die
Datenerfassung von einem Huber-Kihler mit
einem Unistat-Controller, wie einem
Cryopilot A, konfiguriert.
3 Wahlschalter Zeigt eine Liste der verfUgbaren seriellen
,COM Port” (COM-)AnschlUsse.
(COM-Anschluss)
4 Wahlschalter Die Option ,None” (Kein) konfiguriert die
.Shaker” (Schittler) Anwendung auf,No Shaker” (Kein Schuttler).
Wenn ein Kabel, USB an Cryomixer, erkannt
wird, wird es automatisch ausgewahlt.
5 Schaltflache ,OK”  Ubernimmt die Anderungen und schlie3t das

Dialogfeld.
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Pos. Steuerung Beschreibung

o) Schaltflache Verwirft die Anderungen und schlieBt das
,Cancel” Dialogfeld.
(Abbrechen)

7 Registerkarte Wechselt zur Registerkarte ,Certificates”
,Certificates” (Zertifikate).

(Zertifikate)

5.6 Erste Schritte

Bevor ein Profil gestartet werden kann, muss die Software konfiguriert
werden. Stellen Sie sicher, dass das Datenerfassungsgerat (DAQ) und der
Kihler angeschlossen und hochgefahren sind. Wahlen Sie dann die
MenUoption ,Tools” (Extras) > ,Options” (Optionen), um das Dialogfeld
,Options” (Optionen) aufzurufen.

5.61 Auswahl eines digitalen Zertifikats

Zunachst muss ein digitales Zertifikat ausgewahlt werden. Cryopilot
verwendet ein digitales Zertifikat zur Gewahrleistung der Authentizitat und
Integritat der gespeicherten Dateien. Die Registerkarte ,Certificates” zeigt
eine Liste der verfugbaren Zertifikate. Optimal ist die Verwendung eines von
einer vertrauenswurdigen Zertifizierungsbehorde (Certification Authority,
CA) ausgestellten Zertifikats. Wenn lhre IT-Organisation bereits eine
digitale Zertifikatinfrastruktur etabliert hat, kann sie moglicherweise ein
Zertifikat fur die Nutzung mit Cryopilot bereitstellen.

Wenn Sie kein Zertifikat fir die Nutzung mit Cryopilot haben, kdnnen Sie
sich ein so genanntes ,Self-Signed“-Zertifikat ausstellen. ,Self-Signed”
bedeutet, dass die Person, die das Zertifikat ausstellt, auch fir dessen
Legitimitat burgt. Klicken Sie auf die Schaltflache ,Create” (Erstellen) und
dann im daraufhin eingeblendeten Dialogfeld auf die Schaltflache ,Yes”
(Ja). Das neu ausgestellte Zertifikat wird in der Liste der verfligbaren
Zertifikate angezeigt.

5.6.2 Konfiguration der Hardware

Als Nachstes muss die Hardware ausgewahlt werden. Die Registerkarte
.Hardware” enthélt Einstellungen fur die allgemeinen
Hardwarekonfigurationen. Die gangigste Kombination umfasst sowohl ein
Datenerfassungsgerat (DAQ), einen Kihler als auch einen Schttler. In den
meisten Fallen wird die Hardware automatisch erkannt.

Wenn Sie keine Prozesse ausfihren und Cryopilot nur zur Darstellung von
Dateien verwenden, wahlen Sie in allen Feldern, ,Data Acquisition”
(Datenerfassung), ,Chiller” (Kthler) und ,Shaker” (Schittler) die Option
.None” (Kein).

Zum Speichern der Optionen klicken Sie auf ,OK".
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5.6.3 Programmfluss

Nach dem Starten der Cryopilot-Software wird kurzzeitig ein Ladebild-
schirm (Splash Screen) eingeblendet, dann wird das Hauptfenster
angezeigt.

An diesem Punkt ist die Software untatig und bleibt auch in diesem Status,
bis der Benutzer einen Prozess startet.

Zum Starten eines Prozesses wéahlen Sie die MenUoption ,Process”
(Prozess) > ,Start” (Starten) oder klicken Sie in der Symbolleiste auf die
Schaltflache ,Start Process” (Prozess starten). Das Dialogfeld ,Start
Process” (Prozess starten) wird angezeigt. Nachdem der Benutzer auf ,OK”
geklickt hat, versucht die Software, eine Verbindung zum Datenerfassungs-
gerat, zum Schuttler und zum Kahler herzustellen, sofern konfiguriert.
Wenn eines dieser Gerate konfiguriert, jedoch nicht angeschlossen ist, wird
der Benutzer aufgefordert, die Anschlisse zu Uberprifen und den Vorgang
erneut auszufUhren oder abzubrechen.

Wenn ein Prozess gestartet wurde, werden das Temperaturdiagramm und
die Legende neu auf die Darstellung der entsprechenden Kurven
konfiguriert, mit dem Kihler werden Kommunikationen eingeleitet und das
Datenerfassungsgerat (DAQ) wird initialisiert. Wenn die Initialisierung
abgeschlossen ist, verschwindet die Initialisierungsmeldung und der erste
Satz Datenpunkte wird angezeigt. Die nachfolgenden Datenpunkte werden
in demselben Sampling-Intervall - einem festen Intervall von 15 Sekunden

- angezeigt.

Bei einer Konfiguration zur Verwendung eines Kihlers nutzt die Cryopilot-
Software die serielle Schnittstelle zum Versenden und Empfangen von
Befehlen an den bzw. vom Kihler.

Wahrend eines Prozesses wird der Verbindungsstatus in der unteren linken
Ecke des Hauptfensters angezeigt. Eine griine ,Online”-Meldung zeigt an,
dass eine gute Verbindung zwischen dem Datenerfassungsgerat und dem
Kihler besteht. Eine rote ,Offline“-Meldung zeigt eine fehlerhafte Verbin-
dung zwischen Datenerfassungsgerat und Kihler an.

Mit der Schaltflache ,Stop Process” (Prozess stoppen) wird die Daten-
erfassung beendet und der Kihler und der Mischer werden deaktiviert.

Der Benutzer kann sich die Daten dann anzeigen lassen. Bevor der Benutzer
einen anderen Prozess starten kann, muss die Datenanzeige geschlossen
sein.
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5.6.4 Darstellung von Daten

Cryopilot kann in Cryopilot 4 und Cryopilot 5 gespeicherte Dateien 6ffnen
und darstellen. Beachten Sie, dass mit Cryopilot 4 erstellte Dateien nur zu
Darstellungszwecken unterstutzt werden. Alle neuen Dateien werden im
Cryopilot 5-Format gespeichert, sodass sich die Datenintegritat und
-authentizitat Gber die digitale Signatur verifizieren lasst.

Es kann jeweils nur eine Datei gedffnet sein.

Zum Offnen einer Datei gehen Sie folgendermaBen vor:

» Klicken Sie in der Symbolleiste auf die Schaltfliche ,Open” (Offnen)

» Offnen Sie das Meni , File” (Datei) und klicken Sie auf ,Open” (Offnen)
» Verwenden Sie das Tastenkurzel Ctrl+O (Strg+O)

Wahlen Sie im Dialogfeld ,Open Data File” (Datei 6ffnen) die Datei, die
geoffnet werden soll. Wahlen Sie den Dateityp aus der Dropdown-Liste
.Files of type” (Dateien vom Typ) aus.

Cryopilot 5 nutzt digitale Signaturen als Nachweis, dass die Daten seit der
urspringlichen Speicherung nicht mehr modifiziert wurden. Lassen sich die
Integritat und Authentizitat der Datei nicht anhand einer digitalen Signatur
verifizieren, werden Sie darUber informiert. Sie mUssen dann wéhlen, ob Sie
fortfahren oder den Vorgang abbrechen wollen. Es gibt zwei géngige Falle,
wann diese Meldung angezeigt wird:

— Beim Offnen einer Cryopilot 4-Datei. Cryopilot 4-Dateien umfassen
keine digitale Signatur.

— Wenn das zur Signierung der Datei verwendete Zertifikat nicht
vertrauenswdurdig ist.

Nachdem die Datei geladen ist, wird das Diagramm mit den Daten der Datei
gefullt. Die Daten im Diagramm kdnnen so ausgewertet werden, als kdmen
sie aus einem Live-Prozess.

Wenn Sie mit der rechten Maustaste auf das Diagramm klicken und dann
auf die Option ,Review” (Darstellen) klicken, konnen Sie im Diagramm nach
links und rechts scrollen und die Werte flr jede Kurve zu einem beliebigen
Zeitpunkt verifizieren. Wenn die Darstellungslinie nach rechts oder links
gescrollt wird, wird die Legende aktualisiert und zeigt somit den Zeitstempel
und die Kurvenwerte fir den jeweiligen Zeitpunkt an.
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Abb.18: Kontextmeni ,Chart” (Diagramm)

5.6.5 Verwendung des Diagramms

Das Diagramm ist eine grafische Darstellung der Temperatur-Zeit-Kurve zur
verstrichenen Zeit fur einen Zyklus (Durchgang). Die verstrichene Zeit wird
auf der X-Achse in der Einheit Stunden angezeigt; die Temperatur wird auf
derY-Achse in der Einheit Grad Celsius angezeigt. Es ist eine Legende zur
Identifizierung und Darstellung des aktuellen Wertes fur jede Kurve
vorhanden.

Verschieben und Zoomen

StandardmaBig werden die Diagrammskalen automatisch an die
verfugbaren Daten angepasst. Diese automatische Skalierfunktion Iasst sich
mithilfe der Optionen ,Autoscale X“ (X automatisch skalieren) und
LJAutoscale Y (Y automatisch skalieren) aus dem Pop-up MenU aktivieren
bzw. deaktivieren. Das Pop-up Menl wird durch klicken der rechten
Maustaste auf das Diagramm aufgerufen.

Die Skalenbreite lasst sich direkt durch das Ziehen der X- und Y-Achsen
andern. Die Diagrammanzeige lasst sich durch Ziehen des Diagramms mit
der gedriickten linken Maustaste verschieben. Beim Andern oder
Verschieben der Skala wird die Funktion ,Auto Scale” (Automatisch
skalieren) deaktiviert. Doppelklicken Sie auf das Diagramm, um die
Funktion ,Auto Scale” (Automatisch skalieren) zu reaktivieren.

Legende

Die Legende identifiziert jede der Kurven im Diagramm. Jede Kurve verfigt
Uber eine Legendenoption mit Name, Farbe, Einheiten und dem aktuellen
Wert. Zum Ausblenden einer Kurve doppelklicken Sie auf ihre Legen-
denoption; diese wird dann gedimmt dargestellt. Zum Anzeigen der Kurve
doppelklicken Sie erneut auf die Legendenoption. Dies kann hilfreich sein,
wenn Dateien mit vielen Plots, die einander Uberlagern, betrachtet werden
sollen.

~Review Mode” - Darstellungsmodus

Im Darstellungsmodus kann der Benutzer die Daten an einem beliebigen
Punkt wéhrend des Prozesses darstellen und prifen. Der Darstellungs-
modus wird Uber das in Abbildung 19 dargestellte Popup-Menu aktiviert
bzw. deaktiviert. Im Darstellungsmodus wird eine vertikale Linie im
Diagramm dargestellt und die abgelaufene Zeit und die Legenden zeigen
die Werte an, die dieser Diagrammposition entsprechen.

5.6.6 Datenexport

Cryopilot bietet zwei verschiedene Methoden zum Exportieren von Daten.
Es kann ein Bild der aktuellen Diagrammansicht exportiert werden oder es
konnen die Rohdaten zur Darstellung in einer Tabellenkalkulationsanwen-
dung exportiert werden.
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Diagrammexport

Zum Exportieren des Diagramms wéhlen Sie die Mentoption ,Edit” (Bear-
beiten) > ,Copy” (Kopieren) > ,Chart” (Diagramm). Das Diagramm wird als
Bitmap-Bild in die Zwischenablage von Windows kopiert. Das Diagramm
kann durch die Auswahl von Edit (Bearbeiten) > Paste (Einfligen) oder
durch Dricken des Tastenkdurzels ,Ctrl+V“ (Strg+V) in andere Anwendungen
eingeflgt werden. Diese Option ist hilfreich, wenn eine Momentaufnahme
der Daten bendtigt wird, beispielsweise in einer Folienprasentation. Ver-
wenden Sie die Option Copy (Kopieren) > Data (Daten), wenn die Daten
weiter analysiert werden sollen.

Datenexport

Zum Exportieren von Daten wéhlen Sie die MenUoption ,Edit” (Bearbeiten)
> ,Copy” (Kopieren) > ,Data” (Daten). Die Rohdaten werden in einem
tabulatorgetrennten Format in die Zwischenablage von Windows kopiert.
Die Daten lassen sich durch Auswahl der Zielzelle und Wahl der Option Edit
(Bearbeiten) > Paste (Einfligen) oder Driicken des Tastenkurzels ,Ctrl+V*
(Strg+V) in Tabellenkalkulationsanwendungen wie Microsoft Excel oder
OpenOffice Calc einfugen.

5.6.7 Drucken

Cryopilot kann fur die gedffnete Datei einen Bericht erstellen. Der Bericht
ist eine Momentaufnahme der aktuellen Diagrammansicht, einschlieBlich
Titel und Legende. Der Bericht kann in einer Vorschau am Bildschirm
angezeigt oder an einen Drucker gesendet werden. Wenn Sie einen PDF-
Druckertreiber wie Adobe Acrobat auf Inrem Computer installiert haben,
konnen Sie den Bericht als PDF-Datei auf der Festplatte speichern.

Zum Drucken eines Berichts nutzen Sie eine der folgenden Maoglichkeiten:
p Klicken Sie in der Symbolleiste auf die Schaltflache ,Print” (Drucken)

» Offnen Sie das Men( ,File” (Datei) und klicken Sie auf ,Print” (Drucken)
» Verwenden Sie das Tastenkurzel Ctrl+P (Strg+P)

Das Dialogfeld ,Print” (Drucken) wird aufgerufen. Darin werden Sie aufge-
fordert, den Zieldrucker und die Anzahl der Druckexemplare auszuwahlen.
Andere Einstellungen, wie Rander (,Margins”) und Papierformat (,Paper
Size") kdnnen unter ,Page Setup” (Seite einrichten) konfiguriert werden.
Klicken Sie auf OK, um den Bericht an den ausgewahlten Drucker zu
senden.
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[® 53 100mL Paks with CP-A - freeze hold.txt - Notepad

File Edit Format View Help

=1olx]|

ntegrated Biosystems Scale Down Temperature Profile
[The first column is the time (in minutes),

the second column is the temperature (in degrees CJ,
and the third column is the mixer state

[START

0. 00 -50 OFF
140.00 -25 OFF
150.00 -25 OFF
160.00 -35 OFF
180.00 -45 OFF
200.00 -55 OFF

[STOP

4 |

=l

Abb.19: Ein Profil in Microsoft Notepad

5.6.8 Profile

Die Cryopilot-Software steuert den Kihler und den Mischer nach der
Vorgabe durch das Profil. Ein Profil ist ein Rezept mit Anweisungen zur
Anderung des Kiihler-Temperatursollwerts und des Mischermodus-
Sollwerts (ein | aus) als Funktion der Zeit. Die Cryopilot-Software verfigt
Uber einen Satz Standardprofile, die fur viele S>-Modul- und Cryowedge-
Anwendungen geeignet sind.

Mdoglicherweise muss flr eine bestimmte Anwendung ein neues Profil
erstellt werden. Bei der Erstellung eines neuen Profils miUssen einige
Faktoren berucksichtigt werden:

— Welche Aktionen sollen ausgefihrt werden - Einfrieren, Auftauen oder
beides?

— Sind mehrere Einfrier- und Auftauzyklen erforderlich?

— Wieist die Anfangstemperatur des einzufrierenden oder aufzutauenden
Materials? Wenn diese variabel ist, kann ein Aquilibrierungsschritt zum
Start des Profils die Reproduzierbarkeit verbessern.

— Sollen die Gerate nach Abschluss des Einfrier-| Auftauvorgangs
weiterhin laufen?

Die Einstellung der Gefrier- und Auftauraten erfolgt empirisch. Wenn ein
tieferer Endpunkt fir einen Gefriervorgang gewiinscht wird, ist es ggf.
erforderlich, die Dauer des endgultigen Sollwertes zu erhéhen oder die
eingestellte Temperatur zu verringern. Verwenden Sie zum schnellen
Auftauen ohne Uberschreiten der Zieltemperatur (,Overshoot”) einen
hohen Temperatursollwert fir eine kurze Dauer und senken Sie den
Temperatursollwert dann ab, bevor die Zieltemperatur Gberschritten wird.

Profilbearbeitung

Profile lassen sich manuell mit Texteditoren (z. B. Microsoft Notepad) oder
Tabellenkalkulationsprogrammen (z. B. Microsoft Excel) erstellen und
bearbeiten. Verwenden Sie bei Verwendung eines Texteditors stets die
Tabulatortaste zum Trennen der Spalten, nicht die Leertaste. Verwenden Sie
nach der Eingabe des Mischerstatus flr eine neue Zeile die Return- oder
Eingabetaste (Enter).

Wenn Sie ein Standardprofil als Ausgangsprofil verwenden wollen,
speichern Sie es unter einem neuen Dateinamen und nehmen erst dann
Anderungen vor.
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Anlagenstatus nach dem letzten Schritt

Nachdem die Cryopilot-Software den letzten Schritt eines Profils
ausgefuhrt hat, lasst sie Kihler und Mischer standardmafig im Istzustand,
bis der Benutzer das Profil durch Drlcken der Taste ,STOP” (Stopp) stoppt.
In einigen Fallen ist es hilfreich, Kihler und Mischer nach einiger Zeit zu
deaktivieren. Dazu wird nach der Anweisung ,STOP” (Stopp) eine
Anweisung ,TURN CHILLER OFF” (Kihler deaktivieren) gesetzt. Beachten
Sie, dass dies nicht mit dem Cryopilot-Profileditor erfolgen kann; es muss
manuell mit einem Texteditor oder einer Tabellenkalkulationsanwendung
vorgenommen werden. Das folgende Profil schaltet den Kihler und den
Mischer beispielsweise nach 311 Minuten aus:

0 -40  OFF
31000 -60  OFF
STOP

311.00 TURN CHILLER OFF

Die Anweisung ,TURN CHILLER OFF” (Kuhler ausschalten) ist im
Cryopilot-Profileditor sichtbar, es ist inr jedoch keine Temperatur
zugewiesen.

Dateiformat

Profile werden als tabulatorgetrennte Dateien auf der Festplatte gespei-
chert. Die ZeichenverschlUsselung ist ASCIl und beim Dateiformat wird
nicht zwischen GroB- und Kleinschreibung unterschieden. Alle Zeilen, die
vordem Eintrag ,START" stehen, sind eine Beschreibung der Datei. Das
bedeutet, dass die Beschreibung den Begriff ,Start” nicht enthalten darf.
Zwischen dem Eintrag ,START” und dem optionalen Eintrag ,STOP“ (Stopp)
stellt jede Zeile einen Schritt im Profil dar. ntifiziert, wann der Schritt
beginnen soll; sie wird in der Einheit Minuten (abgelaufende Minuten)
angegeben und wird als Dezimalwert ausgedrlckt. Die Startzeit des ersten
Schrittes muss O sein; die Startzeiten nachfolgender Schritte muss sich
monotonisch erhohen. Zu beachten ist, dass sich die Startzeit fur jeden
Schritt auf die Profilstartzeit bezieht. Drei 30-Minuten-Schritte hatten als
Startzeiten O, 30 und 60. Der Kihlersollwert wird in der Einheit °C und als
Dezimalwert ausgedrlckt. Wenn ein Eintrag ,STOP” (Stopp) vorhanden ist,
kann die nachste Zeile ein Eintrag ,TURN CHILLER OFF“ (KUhler aus-
schalten) sein.
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Die folgende Syntax wird zur Beschreibung des Dateiformats verwendet:

\n Zeichen fur eine neue Zeile, hier als CRLF definiert
\s Null oder mehr Whitespace-Zeichen
\t Tabulatorzeichen

<variable> Variables Element

[FOO] Optionales Element

OFF|ON  Aufzahlungswert, das Element muss eins von beiden sein
Zeigt eine Wiederholungsstruktur an

Format:

[<description>\n]

START\s\n

<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n

[STOP\n
[<start time>\tTURN CHILLER OFF]]

Beispiel (implizierte \n):
Dies ist ein Testprofil bestehend aus drei Schritten:

START

0 -20 OFF
30 -60 ON
200 10 OFF
5.6.9 Dateien

Waéhrend eines Zyklus | Vorgangs Uberwacht die Cryopilot-Software die
Komponenten des Benchtop-Systems und erfasst die Hauptprozesswerte
in einer Datei auf dem Computer.

Die Cryopilot 5-Software kann Dateien 6ffnen, die mit Cryopilot 4 erstellt
wurden, sowie Dateien, die mit Cryopilot 5 erstellt wurden. Alle neuen
Dateien, die mit Cryopilot 5 gespeichert werden, werden jedoch im
Cryopilot 5-Format gespeichert. Die Datei enthalt folgende Prozesswerte:

— Den Temperatursollwert und die Isttemperatur des WarmeUlbertragungs-
mediums fur das Kihler-WarmeuUbertragungsmedium

— Den Kihlermodus (On | Off (Ein | Aus))

— Den Mischermodus (On | Off (Ein | Aus))

— Die Temperaturvon bis zu 14 Typ T Temperatursensoren

StandardmaBig haben Cryopilot 5-Dateien die Dateierweiterung .cpd. Eine
Cryopilot-Datei ist eine ZIP-Datei, die zwei Dateien enthalt:

— data.txt, eine tabulatorgetrennte Datei

— data.txt.p7s, eine digitale Signatur im PKCS7-Format

Tabellenkalkulationsprogramme wie Microsoft Excel konnen die tabulator-
getrennte Datei importieren, es ist jedoch einfacher, die Daten mit der
MenUoption ,File” (Datei) > ,Copy” (Kopieren) > ,Data” (Daten) zu Ubertra-
gen. Versuchen Sie nicht, die Datei fur einen laufenden Zyklus | Vorgang zu
offnen, da die Tabellenkalkulationsanwendung die Datei schlieBen und
somit verhindern kann, dass die Cryopilot-Software weitere Daten in die
Datei schreibt.
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Dateiformat

Die Datei data.txt und die Ergebnisse des Befehls File (Datei) > Copy
(Kopieren) > Data (Daten) enthalten beide tabulatorgetrennten Text. Die
Zeichenverschlisselung ist ASCII und beim Dateiformat wird nicht zwischen
GroB3- und Kleinschreibung unterschieden. Die erste Zeile muss, wie nach-
folgend dargestellt, den Ersteller und die Version enthalten. Alle Tempera-
turwerte sind in der Einheit °C angegeben.

Die folgende Syntax wird zur Beschreibung des Dateiformats verwendet:

\n Zeichen fur eine neue Zeile, hier als CRLF definiert
\s Null oder mehr Whitespace-Zeichen
\t Tabulatorzeichen

<variable> Variables Element

[FOQO] Optionales Element

OFF|ON  Aufzahlungswert, das Element muss eins von beiden sein
Zeigt eine Wiederholungsstruktur an

Beachten Sie, dass die Zeiten als UCT (Universal Coordinated Time)
angegeben sind; diese kann sich je nach |hrer Zeitzone von der Lokalzeit
unterscheiden.

Wenn keine Daten verfligbar sind, enthélt die Datei das Symbol ,NaN”
(Not a Number; Keine Zahl).

Format:

Cryopilot 5.0\n

METADATA\n

Title\t<title>\n

Process Start\t<timestamp format=yyyy-MM-dd HH:mm:ssZ>\n
Computer\t<computer name>\n

User\t<user name>\n

Description\t<description>\n

START\n

Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply Tempera-
ture Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\tProduct Tem-
perature 1(C)\tProduct Temperature 2(C)\t...Product Temperature n(C)\n

<timestamp format=yyyy-MM-dd HH:mm:ssZ>\t<elapsedhours
format=0.000000>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
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Beispiel mit vier Temperatursensoren (implizierte \n):

HTF Supply Temperature

Mixer Status Product 1

Cryopilot 5.0

METADATA

Title Temperature vs. Elapsed Time
Process Start 2009-03-03 21:49:227
Computer DEMO_LAPTOP

User DEMO_LAPTOP\Administrator
Description

START

Date/Time(UTC) Elapsed Time(h)  Chiller Status
Setpoint(C) HTF Supply Temperature(C)
Temperature(C) Product 2 Temperature(C)

Product 4 Temperature(C)

2009-03-03 21:49:31Z 0.002500 On
2009-03-03 21:49:46Z 0.006667  On
2009-03-03 21:50:01Z 0.010833 On
2009-03-03 21:50:16Z 0.015000  On

0.0
0.0
0.0
0.0

21.0

20.7
20.3
20.0
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5.6.10 Diagnostik|Fehlersuche

Fehler- und Statusmeldungen werden im Meldungsbereich in der unteren
rechten Ecke des Hauptfensters angezeigt. Dieser Abschnitt beschreibt
gangige Fehler und mogliche GegenmaBnahmen.

Kihler
Bei Problemen mit dem Kiuhler kdnnen folgende Schritte hilfreich sein:

» Uberprifen Sie beide Enden des seriellen Kabels zwischen Computer
und Kuhler.

» Uberpriifen Sie das Fehlerprotokoll des Kiihlers. Weitere Informationen
finden Sie in der Gebrauchsanweisung zum Huber Unistat 705.

P Stellen Sie sicher, dass die Kommunikationseinstellungen des Kihlers
korrekt konfiguriert sind. Der Cryopilot A sollte fur die Nutzung der
Baud-Rate (Ubertragungsgeschwindigkeit) 9600 und des Protokolls
RS-232 konfiguriert sein. Weitere Informationen finden Sie in der
Gebrauchsanweisung zum Huber Unistat 705.

P Als letzte MalBnahme beenden Sie die Cryopilot-Software, schalten den
Kihler aus und wieder ein und starten die Cryopilot-Software neu.
Versuchen Sie, die Ursache fUr das Problem herauszufinden, bevor Sie
einen weiteren Zyklus | Vorgang starten. Stellen Sie sicher, dass die
Einstellungen im Dialogfeld ,Options” (Optionen) korrekt sind.

Wenn es wahrend eines Zyklus | Vorgangs zu einem Stromausfall kommt,
kann der Kihler von der Netzversorgung getrennt werden oder die Daten
des Kiuhlers kdnnen beschadigt werden. Das Vorhandensein von NaN (Not
a Number; Keine Zahl) in den Temperaturfeldern der Datei ist ein weiteres
Anzeichen fur einen Kihlerfehler.

Schittler

Wenn sich der Schuttler nicht bewegt, wenn er es sollte, konnen folgende
MaBnahmen Abhilfe schaffen:

» Uberprifen Sie das Kabel zwischen Computer und Schiittler.

P Stellen Sie sicher, dass der Modusschalter auf der Mischerriickseite in
der Stellung ,Auto” steht.

P Stellen Sie sicher, dass die Hubzahleinstellung korrekt ist.
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Datenerfassungsgerat | Temperatursensoren

Nachfolgend finden Sie géangige Fehler der Datenerfassungshardware oder

der Temperatursensoren:

— Ein Sensor reagiert nicht auf Temperaturanderungen, wie es die anderen
Sensoren tun.

Wenn das oben genannte Problem auftritt, kdnnen folgende Maf3nahmen

moglicherweise Abhilfe schaffen:

P Stellen Sie sicher, dass der fragliche Sensor an der korrekten Buchse an
der Kabelpeitsche des Thermoelements, die mit dem
Datenerfassungsgerat verbunden ist, angeschlossen ist.

P Stellen Sie sicher, dass jeder Sensor korrekt positioniert und fixiert ist. Ein
kleiner Positionsfehler kann im Vergleich mit anderen Sensoren zu
groBBen Abweichungen fuhren.

» Uberprifen Sie die Verbindungen und Anschliisse zwischen dem
Computer und dem Datenerfassungsgerat.

» Moglicherweise ist ein Sensor beschadigt. Uberpriifen Sie den Sensor
mit einem kalibrierten Messgerat (z. B. Fluke 725), mit dem sich
Thermoelemente vom Typ T messen lassen.

5611 21CFR, Teil N

Die Cryopilot 5-Software wurde in Anlehnung an die Anforderungen des
Kodex 21 CFR, Teil 11 entwickelt.

FUr den Nachweis der Authentizitat und der Integritat von Cryopilot
5-Dateien, selbst bei offenen (d. h. nicht vertrauenswirdigen) Systemen,
werden digitale Signaturen verwendet. Die Begriffe ,digitale Signatur” und
Lelektronische Signatur” sollten nicht verwechselt werden. Eine digitale
Signaturist ein VerschlUsselungsverfahren, wohingegen eine elektronische
Signatur das elektronische Aquivalent einer handgeschriebenen Signatur
mit rechtlichen Implikationen ist. Die Verweise auf elektronische Signaturen
im Kodex 21 CFR, Teil 11 gelten nicht flr die digitalen Signaturen, die in
Cryopilot 5-Dateien verwendet werden.

Einige allgemeine Hinweise zur Implementierung:

— Cryopilot 5 nutzt die Kontoverwaltungs-, Authentifizierungs- und
Autorisierungsfunktionen des jeweiligen Betriebssystems.

— Dervon Cryopilot 5 verwendete digitale Signaturalgorithmus ist SHA-1
mit RSA; geschrieben im PKCS#7-Format.

— Das Dateisystem wird als nicht vertrauenswirdiges System behandelt.

— Wenn ein Prozess gestoppt wird, wird die Datei geschlossen und sie lasst
sich nicht mehr 6ffnen und @ndern. Jede Veranderung der Daten durch
andere Mittel, ungeachtet dessen, ob diese versehentlich oder
vorsatzlich erfolgt, wird vom digitalen Signaturmechanismus erkannt.

— Wenn die Daten aus Cryopilot (beispielsweise in eine Tabelle) exportiert
werden, kann ihre Authentizitat und Integritat nicht mehrlanger
gewahrleistet werden.
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6 Systembetrieb

6.1  Vorbereitung fur einen Zyklus

611  Cryowedge

So bereiten Sie den Cryowedge vor:

>
>

>

Entfernen Sie die obere Halfte der isolierten Cryowedge-Abdeckung.
Entfernen Sie die Fligelmuttern, mit denen die transparente Abdeckung
fixiert ist, und legen Sie sie zur Seite.

Entfernen Sie die transparente Abdeckung. Beflllen Sie den Cryowedge
mithilfe eines Messzylinders mit der Testlosung. Die Standardvolumen
fur die jeweiligen Cryowedge-GroBen sind wie folgt:

Cryowedge-GrofBle Volumen (mL)
CW20 (127) 350

CW125 (207) 650

CW300 (30 3000
CW300 (34) 4000

Setzen Sie die transparente Abdeckung wieder auf.

Bringen Sie die Flugelmuttern wieder an und ziehen Sie sie von Hand an.
Ziehen Sie sie nicht zu stark an und Uberdrehen Sie die Gewinde nicht.
Setzen Sie die obere Halfte derisolierten Cryowedge-Abdeckung
wieder auf.

Stellen Sie sicher, dass das Kabel des Cryomixer Jr. am Cryomixer Jr. und
am Computer angeschlossen ist.

Stellen Sie sicher, dass wenigstens sechs Thermoelemente auf der
Rackseite des Datenerfassungsgerats angeschlossen sind, beginnend
mit der Position 1.

Setzen Sie fUnf der Temperatursensoren durch die vorgebohrten Locher
in die transparente Abdeckung ein. Fixieren Sie die Temperatursensoren
mit Kunststoffabstandshaltern oder mit abgetrennten Silikonrohr-
materialstiicken unterhalb der Testlésungsoberflache.

Platzieren Sie den sechsten Temperatursensor als Referenztemperatur
an den AuBenflachen des Cryowedges oben auf die transparente
Abdeckung.

Dokumentieren Sie die Nummer und die Position eines jeden
Temperatursensoren zur spateren Bezugnahme.
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612 S-Modul

Celsius® Paks werden durch Gammastrahlung vorsterilisiert geliefert. Sie
verfligen Uber Luer-Anschlussbuchsen und Kappen an 2 Befill-|
Ablassanschlissen. Auch eine Ausfihrung mit C-Flex®-Rohrverlangerungs-
elementen ist fur ein steriles Beflullen erhaltlich. Alle Celsius® Paks verflgen
Uber ein geschlossenes Silikon- | EVA-Schutzrohr zur Einfihrung einer
Temperatursonde.

Um einheitliche Ergebnisse zu erhalten, bestiicken Sie das S>-Modul stets
mit derselben Anzahl an Celsius® Paks. Stellen Sie sicher, dass jedes
Celsius® Pak auf dasselbe Volumen befullt ist. Der Temperatursensor sollte
jedes Mal in derselben Tiefe platziert werden.

Die Standard-Gefrierprofile, die die Cryopilot-Software bietet, sind auf

10 Celsius® Paks mit einem Fassungsvermogen von entweder 30 oder

100 mL ausgelegt, die auf das Nennvolumen beflllt sind. Platzieren Sie die
Temperatursensoren in einer Mindesttiefe von 1 cm unter der Fllssigkeits-
oberflache der Celsius® Paks. Leere Celsius® Paks sollten mit Musterpuffer
beflllt werden. Verwenden Sie in den ansonsten leeren Fullkdrpern kein
entionisiertes Wasser, da dieses Ublicherweise unterkihlt wird. Wenn Sie
weniger als 10 Celsius® Paks verwenden, erfolgt das Gefrieren schneller und
das Profil Iasst sich nicht direkt auf groBere Einheiten | Mengen ubertragen.

Schritt-fUr-Schritt-Verfahren zur Vorbereitung, Beftillung und Bestlickung
der Celsius® Paks:

P Bereiten Sie die Probe und | oder den Puffer fir das Beflllen der
Celsius® Paks vor.

P Schieben Sie das Etikett in den Etikettenhalter unten am Celsius® Pak.
Ein Etikett mit den MaBen ~2 x 5 cm passt vollstandig in den Etiketten-
halter. Es wird empfohlen, wasserfestes Material und wasserfeste Tinte
fur die Etikettbeschriftung zu verwenden. Schreiben Sie nicht auf die
Celsius® Paks, da die in der Tinte verwendeten Lésungsmittel das
Celsius® Pak penetrieren und das Produkt kontaminieren kénnen.

p» Verwenden Sie zum Befullen der Celsius® Paks mit der Probe oder dem
Puffer durch einen der Beflllungs-| Ablassanschlisse eine Spritze oder
eine Peristaltikpumpe. SchlieBen Sie die Spritze oder Pumpe Uber einen
Luer®-Anschlussnippel oder per SchweiBverbindung an der optionalen
C-Flex®-Leitung an.

p Beflllen Sie die Celsius® Paks mit einem maximalen Volumen von 30 mL
(30-mL-Celsius® Pak) oder 100 mL (100-mL-Celsius® Pak).

AVORSICHT

Befillen Sie die Celsius® Paks nicht zu sehr und entfernen Sie nicht jegliche
Luft im oberen Teil des Celsius® Paks, da dies eine Ausdehnung von Probe
und Eis in die Anschlussleitungen bewirkt.

» VerschlieBen Sie die Fullleitung mit derim Lieferumfang enthaltenen
Luer®- Kappe oder einer Klemme.

P Wischen Sie vor einem Gefriervorgang Uberschuissige Feuchtigkeit von
allen Oberflachen im S*-Modul ab.
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Celsius® Paks werden Uber einen Federklemmenmechanismus im S*-Modul
gehalten. Dieser fungiert als aktive Warmeleitungsoberflache. Fihren Sie
die folgenden Schritte zur Bestlickung des S*-Moduls durch:

P Befestigen Sie den Temperatursensorhalter am Celsius® Pak. Dazu
richten Sie die Luer-Lock-Anschlussbuchse am Temperatursensorhalter
mit dem Luer-Lock-Anschlussnippel oben an der Thermometerhulse
aus. Nach der Befestigung des Luer-Locks an die Thermometerhlse
muss die Vorderseite des Temperatursensorhalters in dieselbe Richtung
zeigen wie das vordere Etikett des Celsius® Paks.

» Messen Sie 1 cm vom Ende des Temperatursensors ab und setzen Sie an
dieser Stelle eine Markierung fur die Platzierung des Temperatursensors
im Celsius® Pak.

P Schrauben Sie die Sicherungsmanschette des Temperatursensors
langsam ab. Achten Sie dabei darauf, die beiden kleinen O-Ringe aus der

Abb. 20: Am Celsius® Pak befestigterThermoele- Sicherungsmanschette einzusammeln. Schieben Sie die Sicherungs-

menthalter manschette und die beiden O-Ringe Uber das Ende des Temperatursen-

sors und drehen Sie die Sicherungsmutter gerade so weit herunter, dass
sie nicht vom Temperatursensorhalter abfallt.

P Flhren Sie den Temperatursensor in die Thermometerhlse ein.
Dricken Sie nie so stark, dass der Sensor durch das Ende der Hulse hin-
durchdrlckt. Fur eine prazise Warmelberwachung platzieren Sie die
Temperatursensoren stets 1cm unter der Oberflache der Flissigkeit im
Celsius® Pak. Dies erreichen Sie, wenn die Markierung am Temperatur-
sensor mit der FlUssigkeitsoberflache Gbereinstimmt.

Abb.21: Thermoelement 1 cm unter der
Flussigkeitsoberflache

P Ziehen Sie die Sicherungsmanschette an, um den Temperatursensorin
der Hulse zu fixieren.

P Stellen Sie sich mit Blick auf die linke Seite des S>-Moduls. Setzen Sie ein
Celsius® Pak in den Klemmmechanismus ein, beginnen Sie hierbei am
Steckplatz 10; dem Steckplatz, der sich am weitesten von der HTF-Zu-
und Ruckleitung entfernt befindet. Offnen Sie die Klemmen, indem Sie
den KlemmenwerkzeugschlUssel Uber die 2 Fihrungsstifte an den
2 Edelstahl-Klemmbldcken des Steckplatzes fihren und es dann nach
unten drlcken.
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P Schieben Sie beim Herunterdriicken des Klemmenwerkzeugschlissels
jede Seite des Celsius® Pak zwischen einem schwarzen Block und einem
Edelstahl-Klemmblock des Klemmmechanismus hinunter. Richten Sie
die Oberseite des Celsius® Paks so aus, dass es biindig mit der Oberseite
der schwarzen Metallstange des Klemmmechanismus abschlief3t. Be-
achten Sie, dass das Celsius® Pak nach links weisen muss, um korrekt in
das S*-Modul eingesetzt werden zu kénnen.

» Ziehen Sie den KlemmenwerkzeugschlUssel zuriick. Das Celsius® Pak
wird auf jeder Seite fest zwischen zwei Metallbldcken gehalten - einem
schwarzen und einem aus Edelstahl. Schlie3en Sie die Temperatur-
sensorenstecker an der entsprechenden Temperatursensoren-
Anschlussleiste an.

Abb.23: Montage des Thermoelementhalters
und des Celsius® Paks
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Abb.24: Platzierung der Celsius® Paks und Anschluss der Thermoelemente

» Wiederholen Sie diesen Vorgang von Steckplatz 9 bis Steckplatz 1.
Die Abbildung zeigt ein Diagramm mit der endgultigen Platzierung aller
Celsius® Paks und Temperatursensoren.

HINWEIS

Bestlicken Sie das S*>-Modul aus Grinden der Reproduzierbarkeit stets

mit derselben Anzahl an Celsius® Paks, beflllen Sie jedes Celsius® Pak stets
mit derselben Menge an Probe oder Puffer und platzieren Sie die
Temperatursensoren in den Temperaturfihlerhllsen jeweils 1 cm unter der
FlUssigkeitsoberflache. Alle bei Sartorius entwickelten Gefrierprofile lassen
sich nur mit einem vollstandig bestickten System (10 Celsius® Paks) korrekt
ausfihren. Daher sind Ergebnisse, die mit den Gefrierprofilen der
Installationssoftware gewonnen werden, direkt auf 16,6 Liter skalierbar.

Eine Anderung der Anzahl an Celsius® Paks beeintrachtigt die Skalierbarkeit
dieser Profile.

P Vermerken Sie die Position und die Nummer eines jeden
Temperatursensors in einem Labornotizbuch bzw. gemaf der
Unternehmensrichtlinie.

P SchlieBen und verriegeln Sie die Abdeckung des S*>-Moduls.

Temperatursensor-Anschlussleiste
) [« ol
Steckplatzposition des befullten Celsius® Paks

~ ) ™ ' () M) M) M HTF-
Einlass
HTF-

10 9 8 7 6 5 4 3 2 1 Auslass

\_/ \_/ \_/ \_/ \_/ \_z \_/ \_/ \_/ \_/

Abb.25: Platzierung der Heizelemente und Celsius® Paks im S*>-Modul
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6.2 Ausfuhrung eines Profils

HINWEIS

Stellen Sie beim Abtauen mit dem S*>-Modul sicher, dass die 4 Montage-
knopfe des S*-Moduls fest angezogen sind und dass das Modul fest auf der
Cryomixer Jr.-Platte fixiert ist.

A VORSICHT

Uberschreiten Sie beim Cryomixer Jr. nie den Wert von 120 U/Min.

>

Doppelklicken Sie zur Initialisierung der Cryopilot-Software auf das
Cryopilot-Softwaresymbol.

Waéhlen Sie zum Aufrufen des Dialogfeldes ,Start Process” (Prozess
starten) die MenUoption ,Process” (Prozess) > ,Start”.

Geben Sie der Datei, in der die Zeit und die Temperaturdaten fur den
neuen Prozess gespeichert werden, einen Namen.

Wahlen Sie den Standard-Profiltyp sowie Ihre Anwendung und |hre
gewlnschte Aktion aus (Gefrieren, Abtauen oder Gefrieren und
Abtauen). Wéahlen Sie alternativ ein benutzerdefiniertes Profil aus.
Klicken Sie auf die Schaltflache ,OK” um den Prozess zu starten.
Stellen Sie sicher, dass das Kihlaggregat auf die Software-Befehle
reagiert. Die Statusanzeige in der unteren linken Ecke sollte ,Online”
zeigen. Bevor der Kompressor startet und die Temperaturregelung
aktiviert wird, kommt es zu einer 2- bis 5-minutigen Verzégerung.
Lassen Sie das Profil bis zum Ende der programmierten Dauer
durchlaufen.

Wahlen Sie die MenUoption ,Process” (Prozess) > ,Stop” (Stopp), um
den Prozess zu stoppen.
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6.3 Entnahme der gefrorenen Celsius® Paks aus
dem S*-Modul

In einigen Fallen ist es wiinschenswert, Celsius® Paks im gefrorenen Zustand
aus dem S*-Modul zu entnehmen.

P Entfernen Sie die transparente Abdeckung des S>-Moduls.

HINWEIS

Wenn das Gerat Uber einen langeren Zeitraum bei kalten Temperaturen
offen gelassen wird, bildet sich Reif auf den Klemmen, den Celsius® Paks
und den Temperatursensorhaltern, wodurch eine Entnahme der

Celsius® Paks erschwert wird. Entnehmen Sie die gefrorenen Celsius® Paks
schnell, sobald das Gerat gedffnet ist, und setzen Sie die Abdeckung dann
wieder auf.

» Entnehmen Sie die Temperatursensoren aus den Celsius® Paks. Wenn
sich ein Temperatursensor nicht leicht herausziehen lasst, drehen Sie ihn
vorsichtig, bis er sich |0st. Entfernen Sie den Temperatursensorhalter aus
jedem Steckplatz. Wenn sich Kondensation auf den Klemmenoberfla-
chen niederschlagt, bildet sich eine ,Eisbricke” zwischen den
Temperatursensorhaltern und den Kihlblocken aus schwarzem Metall.
Dadurch wird eine Entnahme der Temperatursensorhalter fast unmog-
lich. Wischen Sie vor Beginn eines Gefriervorgangs die Uberschissige
Feuchtigkeit von allen Oberflachen ab.

P Entnehmen Sie die gefrorenen Celsius® Paks mithilfe des Klemmen-
werkzeugschlUssels aus dem S*-Modul, indem Sie die Celsius® Paks nach
oben herausschieben. Legen Sie sie in einen isolierten Transportbehalter.

P Lagern Sie die gefrorenen Celsius® Paks im Gefrierschrank in einem
Schutzbehalter bei Solltemperatur. Wenn Sie Stabilitatsprifungen oder
Rezepturstudien durchfihren, ist die Verwendung eines geregelten
Gefrierschranks mit Warmeuberwachung die optimale Losung.

6.4 Losenvon aufgetauten Proben aus dem
S°>-Modul

» Entnehmen Sie die Temperatursensoren und die Temperatursensorhal-
ter.

» Entnehmen Sie die aufgetauten Celsius® Paks aus dem S*-Modul.

» Drehen Sie jedes Celsius® Pak drei Mal um, um ein homogenes
Produktgemisch zu gewahrleisten.

» Entnehmen Sie die gewiinschte Probenmenge aus dem Celsius® Pak.
Verwenden Sie dazu den bisher nicht verwendeten
Beflllungs-|Ablassanschluss. Die Entnahme kann mithilfe einer Spritze,
einer Pumpe oder durch Ablassen per Schwerkraft erfolgen.

P Entsorgen Sie gebrauchte Celsius® Paks. Die Celsius®s-Paks verformen
sich wahrend des Gefrier- und Auftauvorgangs gelegentlich und lassen
sich dann beim Wiederverwenden nicht gut in den Klemmmechanismus
einspannen. Dies kann eine schlechte Warmeleitung bedingen und zu
einer langeren Gefrier- und Auftaudauer fihren.
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/  Systemwartung

Die Wartung kann vom Endbenutzer oder von Sartorius vorgenommen
werden. Wenden Sie sich zur Einrichtung eines Praventiven
Wartungsvertrages an die Service-Abteilung von Sartorius.

Wenn ein Problem auftritt, lesen Sie bitte zunachst den Abschnitt zu den
Fehlercodes in der Gebrauchsanweisung zum Huber Unistat 705. Wenn Sie
das Problem nicht beheben kbnnen, wenden Sie sich an den Kundendienst
(siehe Seite 93).

/.1 Reinigung

Freiliegende Gerateoberflachen kdnnen generell mit Isopropylalkohol ein-
gespriht und abgewischt werden. Edelstahloberflachen konnen optional
mit einer Edelstahlpolitur gereinigt werden.

Der Schrankinnenraum des S*>-Moduls enthalt viele Komponenten aus
eloxiertem Aluminium, die nicht mit basischen Lésungen wie Natronlauge
(NaOH) oder Oxidationsmitteln kompatibel sind. Diese Stoffe sollten nicht
far eine Reinigung des Schrankinnenraums verwendet werden. Statt dessen
werden |sopropylalkohol oder andere nicht oxidierende Reinigungs-
|I6sungen empfohlen, wenn eine Reinigung erforderlich ist.

/72  Wechsel des Warmetragermediums HTF

Wechseln Sie das Warmetragermedium HTF, wenn es sichtbar durch
Wasser oder Partikel kontaminiert ist oder wenn Sie einen Abfall der
Warmeulbertragungsleistung feststellen (d. h. wenn das Geréat die
Sollwerttemperatur nicht mehr erreicht oder halten kann). Wechseln Sie
stets die gesamte HTF-Menge. Wenn nach dem HTF-Wechsel keine
Verbesserung der Warmeubertragungsleistung festgestellt wird, wenden
Sie sich an den Kundendienst (siehe Seite 93).

Gehen Sie zum Wechsel des HTF folgendermafen vor:

P Stellen Sie sicher, dass das HTF-Ablassventil des Systems an der
Geratevorderseite geschlossen ist. Der Schlitz im Schraubdeckel ist im
geschlossenen Zustand vertikal ausgerichtet. Siehe ,Abb.10 HTF-
Ablassventil und Dichtschrauben des Cryopilot A”, Seite 62.

» Entfernen Sie die Dichtschraube der vorstehenden Edelstahlleitung links
am Gerat und schlieBen Sie einen Flexischlauch am Leitungsende an.
Fixieren Sie ihn fest mit einer Schlauchschelle.

p Hangen Sie das entfernte Leitungsende in einen Behalter, der
wenigstens 12 L HTF fasst.

» Offnen Sie das HTF-Ablassventil, indem Sie es entgegen dem Uhr-
zeigersinn drehen, bis der Schlitz horizontal ausgerichtet ist.

P Versuchen Sie nach Méglichkeit, den Cryowedge oder das S*-Modul
anzuheben, um restliches HTF aus dem Anlagenmodul zurlck in den
Cryopilot A flieBen zu lassen.

» Wenn kein HTF mehr flieBt, schlieBen Sie das HTF-Ablassventil,
entfernen den Schlauch von der Dichtschrauben-Leitung und bringen
die Dichtschraube wieder an.

» Beflllen Sie das Cryopilot A-System gemaB dem im Kapitel ,4.7
Beflllung mit Warmetragermedium HTF”, Seite 61 beschriebenen
Verfahren mit neuem HTF.
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8 Informationen und
Anweisungen zur Entsorgung
und Reparatur

Wird die Verpackung nicht mehr bendtigt, ist diese der 6rtlichen Mullent-
sorgung zuzufuhren. Die Verpackung besteht aus umweltfreundlichen
Materialien, die als Sekundarrohstoffe dienen kdnnen.

Das Gerat inklusive Zubehor und Batterien gehort nicht in den Hausmdll.
Die EU-Gesetzgebung fordert in ihren Mitgliedsstaaten, elektrische und
elektronische Gerate vom unsortierten Siedlungsabfall getrennt zu
erfassen, um sie anschlieBend wiederzuverwerten.

In Deutschland und einigen anderen Landern flhrt die Sartorius die
Ricknahme und gesetzeskonforme Entsorgung ihrer elektrischen und
elektronischen Produkte selbst durch. Diese Produkte dirfen nicht - auch
nicht von Kleingewerbetreibenden - in den Hausmull oder an Sammel-
stellen der ortlichen 6ffentlichen Entsorgungsbetriebe abgegeben werden.

Hinsichtlich der Entsorgung wenden Sie sich daher in Deutschland wie auch
in den Mitgliedsstaaten des Européaischen Wirtschaftsraumes bitte an unsere
Service-Mitarbeiter vor Ort oder an unsere Service-Zentrale in Gottingen:

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Goettingen, Deutschland

In Landern, die keine Mitglieder des Europaischen Wirtschaftsraumes sind
oderin denen es keine Sartorius-Filialen gibt, sprechen Sie bitte die
ortlichen Behorden oder |hr Entsorgungsunternehmen an.

Vor der Entsorgung bzw. Verschrottung des Gerétes sollten die Batterien
entfernt und einer Sammelstelle Ubergeben werden.

Mit gefahrlichen Stoffen kontaminierte Gerate (ABC-Kontamination)
werden weder zur Reparatur noch zur Entsorgung zurickgenommen.
AusfuUhrliche Informationen mit Service-Adressen zur Reparaturannahme
oder Entsorgung |lhres Gerates konnen Sie auf unserer Internetseite
(www.sartorius.com) finden oder Uber den Sartorius Service anfordern.

Kontaktdaten

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Gottingen, Deutschland

Telefon +49 551308 O
Fax +49 551308 3289

www.sartorius-stedim.com
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sartorius

biotech

EG-Konformitétserklarung

Firma Sartorius Stedim Systems GmbH

Adresse Schwarzenberger Weg 73-79
34212 Melsungen; Deutschland
Telefon +49.551.308.0, Fax +49.551.308.3289
www.sartorius-stedim.com

Hiermit erkldren wir, dass das nachfolgend bezeichnete Ge-
rat aufgrund seiner Konzeption und Bauart sowie in der von

|S ‘the Certificate uns in Verkehr gebrachten Ausfithrung den einschldgigen
grundlegenden Sicherheits- und Gesundheitsschutzanforde-
up to date? rungen der EG-Richtlinie entspricht.

Diese Erklarung verliert ihre Giiltigkeit, wenn an dem Gerat
Modifizierungen durchgefiihrt werden, die durch Sartorius
Stedim Systems nicht bescheinigt worden sind.

Dokumentationsbevollmachtigter Sartorius Stedim Biotech GmbH
z. Hd. Marc Hogreve
August-Spindler-StraBe 11
37079 Géttingen, Deutschland
Telefon +49.551.308.3752, Fax +49.551.308.2062

Bezeichnung des Gerites Benchtop Freeze-Thaw System
Geritetyp S3 System, CryoWedge System
Artikelnummer FTH-CS00000-0002, FTH-CS00000-0004, FTH-CS00000-0008,

FTH-CS00000-0008, FTH-CS00000-0010, FTH-CS00000-0012,
FTH-CS00000-0014, FTH-CS00000-0016

Einschlédgige EU-Richtlinien 2006/42/EG  Maschinenrichtlinie
2004/108/EG  Elektromagnetische Vertraglichkeit

2006/95/EG  Elektrische Betriebsmittel zur Verwendung
innerhalb bestimmter Spannungsgrenzen

Harmonisierte Normen EN ISO 12100-1:2003, EN ISO 12100-2:2003
EN 61326-1:2006
EN 61010-1:2001

Angewandte nationale Normen und nicht angewendet
technische Spezifikationen, insbesondere

Datum und Unterschrift 24012011 . . )
. / v S G
T e — 7

Funktion des Unterzeichners Lars Bottcher Dr. Susanne G/ righausen
Director of R&D for Director of Quality
Automation, Sensors Engineered Systems and
and Instruments Instruments
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Introduction

1 Introduction

Sartorius propose des solutions de congélation | décongélation basées sur
des technologies brevetées pour la manipulation, le stockage et le transport
de produits biopharmaceutiques, ainsi que des outils pour le développe-
ment de processus, garantissant un changement lineaire de I'échelle
laboratoire a I'échelle commerciale. Les configurations du systéme de
laboratoire sont congues pour reproduire les processus de congélation |
décongélation contrélés qui sont effectués en production dans les
processus de grand volume Celsius® et Cryovessel. Cryovessel est une
gamme de produit en acier inoxydable et Celsius® est une ligne de produit a
usage unique. Ces deux systemes utilisent le refroidisseur Cryopilot A et le
mélangeur Cryomixer Jr.

1.1 Cryovessel

Le systeme correspondant a Cryovessel a I'échelle du laboratoire s’appelle
Cryowedge. Le module Cryowedge reproduit une petite partie du
Cryovessel en faisant correspondre la géométrie de la surface d’échange
thermique, la longueur du trajet de congélation et la matiere de la
construction.

Pour réaliser des études de faisabilité, il est possible de réduire encore
davantage les exigences en matiére de volume du produit en utilisant une
Cryocassette. Il s'agit de récipients de 30 mL et de 100 mL en acier inoxydable
qui peuvent étre installés dans le Cryowedge dans des gaines en polymere.

1.2 Celsius®

Le systéme correspondant a Celsius® a I'échelle du laboratoire est le
module S*; S® signifie « Scale-down » (réduction d’échelle) et « Stability
Studies » (études de stabilité). Le module S® permet ‘imiter les modules de
congélation|décongélation FT16 et FT100 en faisant correspondre la
longueur du trajet de congélation.

Le systéme de congélation|décongélation Celsius® S° offre des temps de
congélation |décongélation identiques en permettant des tests de congéla-
tion | décongélation permettant des changements d’echelle lineaires et des
études de stabilité.

1.3 Références

Veuillez consulter les documents suivants pour obtenir davantage de
renseignements sur les composants de votre systeme de
congélation|décongélation pour laboratoire :

— Manuel d'utilisation Huber Unistat 705

— Schémas électriques Huber Unistat 705

— Informations sur le produit Dow Syltherm HF

— Fiche technique sur la sécurité des substances (FTSS) Dow Syltherm HF
— Fiche technique sur la sécurité des substances (FTSS) DuPont Suva 507
— Fiche technique surla sécurité des substances (FTSS) DuPont Suva 23
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2 Sécurité

Suivez scrupuleusement toutes les instructions de ce manuel afin d’éviter
tout risque de blessure grave ou de mort pour le personnel et de dommage
pour I'équipement. Toute utilisation des composants du systéme dans des
applications pour lesquelles ils ne sont pas prévus annule la garantie de
I'appareil et retire toute responsabilité a Sartorius.

Les symboles suivants signalent des informations importantes:

/A DANGER

Situations potentiellement dangereuses qui, si elles ne sont pas évitées,
peuvent entrainer la mort ou de graves blessures.

/A ATTENTION

Risques potentiels mineurs pour la sécurité du personnel ou de dommages
potentiels pour I'équipement ou les biens.

REMARQUE

Information importante mais ne concernant pas la sécurité.

2.1  Précautions généerales

P Assurez-vous de respecter en permanence les regles de securité en
vigueur dans I'entreprise.

p Coupez l'alimentation électrique et suivez les procédures appropriées
de Lock-Out|Tag-Out lorsque vous effectuez des opérations de
maintenance a l'intérieur des composants du systeme.

P Ne tirez pas surles Cryohoses pour les fixer au refroidisseur ou a
I'application. Il est préférable de déplacer le refroidisseur ou I'application
afin que les tuyaux ne soient pas tendus. Laissez du mou pour éviter que
les tuyaux ne soient coudés.

P Les composants du systeme sont lourds. Respectez les techniques
de levage et de manipulation adéquates.
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2.2 Fluide caloporteur

Le systeme fonctionne avec du fluide caloporteur silicone Dow Syltherm
HF. N'utilisez pas un autre type de fluide caloporteur.

L'utilisation de fluide caloporteur comporte plusieurs risques :

— Des températures de -75°C et de 250°C peuvent entrainer des blessures
graves sur la peay, les yeux et d’autres tissus mous. Utilisez des
équipements de protection individuelle adaptés lorsque vous travaillez
avec du fluide caloporteur ou que vous étes exposé de pres aux surfaces
chaudes ou froides du systéme.

— Syltherm HF a un point d'inflammation en vase clos de 63°C
conformément a ASTM D92. Conformément a NFPA et OSHA, il est
classifié en tant que liquide combustible de la classe IlIA. Veuillez
respecter les procédures de manipulation et de stockage appropriées.

— Syltherm HF a une faible tension superficielle et peut etre facilement en
renverser lors du remplissage du systeme le systeme. Une fois renversé,
le fluide est extrémement glissant. Utilisez des matieres absorbantes tels
que des serviettes en polypropyléne pour essuyer le fluide caloporteur
éventuellement renversé sur la paillasse et le sol.

— Le fluide caloporteur usagé et les matiéres absorbantes doivent étre
éliminés en tant que déchets dangereux. Pour plus de renseignements,
veuillez vous reporter aux informations sur le produit et a la FTSS.

2.3 Cryopilot A

Seuls des membres du personnel qualifiés sont autorisés a entretenir le
systéeme de réfrigération. Le Cryopilot A utilise les réfrigérants hydrofluoro-
carbones (HFC) R-507 et R-23. Ces réfrigérants sont sujets a des réglemen-
tations environnementales et ne doivent pas s’évacuer dans I'atmosphére.

P Pour plus de renseignements, veuillez vous reporter aux FTSS.

2.4  CryomixerJr.

p Pendant le fonctionnement, gardez les mains éloignées de la plaque
supérieure.

> Ne dépassez pas la vitesse d'agitation maximale recommandée qui est
indiquée dans la partie « Installation du systeme ».
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3 Composants du systeme

31  Cryopilot A

Le Cryopilot A est un refroidisseur a recirculation qui régle la température
d‘un fluide caloporteur en fonction d’une valeur de consigne. .

Un systéme de réfrigération en cascade refroidit le fluide caloporteur
quand sa température réelle est supérieure a la température de consigne.
Le systéme de réfrigération est principalement composé d’'un compresseur
de température élevée, d'un compresseur de basse température, d'un
condenseur, d'un détendeur automatisé et d'un évaporateur. Les réfrigé-
rants utilisés au cours des stades élevés et faibles sont respectivement R23
et R507. Le condenseur réfrigérant est refroidi a I'air.

Deux radiateurs a résistance électrique chauffent le fluide caloporteur
quand sa température réelle est inférieure a la température de consigne.
Un grand radiateur de 1500 W est utilisé pour de grandes variations de
température et un plus petit radiateur de 100 W est utilisé pour de petites
variations. Ce double dispositif de chauffage permet de régler avec
précision la température de I'alimentation en fluide caloporteur.

Une pompe a vitesse variable fait circuler le fluide caloporteur a travers
I'évaporateur, les radiateurs et I'application externe. Pour des applications
Cryowedge, le fluide caloporteur s'écoule a travers la jaquette et 'échangeur
de chaleur central. Pour des applications du module S, le fluide caloporteur
s'écoule a travers les parois adjacentes aux systemes de gestion fluidique
Celsius® Pak. Un réservoir d’expansion simplifie 'amorcage du systeme et
permet au fluide caloporteur de se dilater et de se contracter.

Le Cryopilot A est commandé par microprocesseur. L'interface utilisateur du
controleur est dotée de plusieurs boutons poussoirs, d’'un codeur rotatif,
d’un écran LCD tactile et d’'un schéma de systéme avec des LED d’état.

Principales caractéristiques du Cryopilot A:

Alimentation électrique

Remarque: Le Cryopilot A est fourni sans fiche. En raison des différents
types de prises de courant utilisés selon les pays, le client doit se procurer
lui-méme la fiche.

Amérique du Nord 208 VAC, 60 Hz,1~,20 A

Europe 230 VAC,50Hz 1~,15,6 A
Gamme de température du fluide -75°C a 250°C
Dimensions (L x1xh) 425x400x720 mm
Poids 90 kg
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3.2 Ordinateur

Le Cryopilot A est commandé et contrédlé par le logiciel Cryopilot installé sur
un ordinateur. Le logiciel Cryopilot commande et contrdle les composants
du systeme de laboratoire, y compris le refroidisseur a recirculation, le
meélangeur et les thermocouples. Reportez-vous a la partie intitulée
chapitre « 5 Logiciel Cryopilot », page 113 pour connatitre les exigences
minimales du systéme et obtenir des renseignements supplémentaires.

Les ordinateurs achetés chez Sartorius en tant qu’élément d’un systeme de
laboratoire ont les spécifications suivantes:

— Facteur de forme ordinateur portable

— Systéme d’exploitation : Microsoft Windows 10 Professional, 64 bits

— Microsoft Word et Excel

— Adobe Acrobat

— Logiciel Cryopilot préinstallé

3.3 Module Cryowedge

Le nom des modules Cryowedge correspond au volume des Cryovessels
utilisés a I'échelle de la production. Par exemple, un Cryowedge 125 est
destiné a simuler un Cryovessel de 125 L.

Volume de travail 350 -4 000 mL, en fonction de la taille
du Cryowedge.

Matériaux de construction

Corps acier inoxydable AISI 316L

Joints silicone

Couvercle polycarbonate transparent
Connexions HTF in (entrée du fluide caloporteur),

HTF out (sortie du fluide) avec
déconnexion rapide

Poids, vide
Cryowedge 20 15 kg
Cryowedge 125 21kg
Cryowedge 300 44 kg
Cryowedge 300 49 kg

Equivalence des tailles
Cryowedge 20 Cryovessel 20 L -40 L
Cryowedge 125 Cryovessel 60 L-150 L
Cryowedge 300 Cryovessel 200 L-300 L
Cryowedge 300 Cryovessel 300 L
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I1.1: Cryocassettes en acier inoxydable

3.4 Cryocassette

La Cryocassette diminue la quantité de produit utilisé a l'intérieur du
Cryowedge. Le Cryowedge peut alors étre rempli de tampon tandis que la
Cryocassette est remplie de produit. La conception de la Cryocassette
conserve les caractéristiques de congélation et de décongélation du
Cryowedge afin d’assurer le changement d’echelle lineaire vers les
Cryovessels utilisés en la production. La Cryocassette sert également pour
des etudes de stabilite.

Volume de travail — 10-4000 mL, en fonction de la taille
de la cassette

— Disponible en 30 mL et 100 mL

Matériaux de construction

Corps acier inoxydable AlISI| 316L
Nacelle — polypropyléne (30 mL) ou
— polyéthylene (100 mL)
Stérilisation autoclavable par le client
Finition 10 p-in Ra, EP

3.5 Celsius® Module §°

Le module S® de congélation | décongélation permet de reproduire les
processus obtenus avec les systéemes Celsius® FT100 et FT16 avec seulement
20 mL de produit. La configuration des surfaces de transfert de la chaleur a
I'intérieur du module fournit le méme flux de chaleur bidirectionnel que dans

le systéeme FT100 en utilisant des Celsius® Pak de matiere identique.

Capacité

1-10 échantillons de produit

Volume de travail

20 mLa 1L, enfonction de la taille
des Celsius® Paks

Matériaux de construction

Boitier

acier inoxydable AlISI 302-304

[I.2: Module de congélation | décongélation S*

Socle

aluminium 6061-Té

Revétement du chéassis du boitier

aluminium 5052

Plagues d’extrémité

plague en mousse PVC rigide

Isolation intérieure du boitier

caoutchouc mousse en silicone

Cache de la connexion de fluide  Delrin

caloporteur

Couvercle PVC transparent
Pression de calcul maximum de la 4,1 bar

tuyauterie de fluide caloporteur

Connexions

HTF in (entrée du fluide caloporteur),
HTF out (sortie du fluide) avec
connecteur rapide installée ; purge

Poids

environ 18 kg
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3.6 Celsius® Paks

Tous les Celsius® Paks, quelle que soit leur taille, sont construits avec le
méme matériau et ont la méme longueur de trajet de congélation et de
décongélation que celle représentée sur la photo 3.

Les Celsius® Paks étant des produits a usage unique, il n'est pas nécessaire
de les nettoyer.

— Disponibles en 30 mL et 100 mL
— Préts al'emploi et a usage unique
Frozen16.6 L .
Celsius® Pak — Pré-stérilisés (rayons Gamma 25-45 kGy)
: — Compatibles avec soudeuse a radio-frequence (RF)
— Congus pour permettre une mesure stérile de la température
— Des surpoches pour Celsius® Paks sont disponibles. Il est recommandé
IIl.3 : Comparaison entre les Celsius® Paks d'enutiliser dans le cadre d'études de stabilite effectuées a (température
30mlLet166L ambiante et supérieure).

Matériaux de construction des Celsius® Pak de 30 mL et 100 mL

Couche de contact avec le copolymere d'éthyléne et d'acétate de
produit vinyle (monomatiere)

Couche barriere augazeta EVA|EVOH|EVA

I'humidité

Couche de manipulation EVA

externe robuste

Raccords de remplissage et EVA

devidange

Tube d'extension C-Flex®

LuerLock® polycarbonate ou polypropyléne

(option C-Flex®)

Coude ou raccord double olive  polypropyléne (option C-Flex®)

Doigt de gant permettant la EVA
mesure de temperature

* C-Flex® is a registered trademark of Saint-Gobain Performance
Plastics Corporation.
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1.4 : Cryomixer Jr.

3.7  CryomixerJr.

Le Cryomixer Jr. est un mélangeur a mouvement alternatif qui est placé
sous le Cryowedge ou le module S* afin d'assurer I'homogénéité du produit
décongelé. Le mouvement alternatif démarre automatiquement dés que le
logiciel Cryopilot active le Cryomixer Jr. Le Cryomixer Jr. est utilisé pour des
applications d'agitation du Cryowedge et du module S°.

Caractéristiques

Course 25 mm, alternative

Alimentation électrique

Amérique du Nord 15V, 60 Hz, 1~
Europe 230V, 50 Hz, 1~
Dimensions (LxIxh) 505x585x120 mm

Poids 24 kg

3.8 Cryohose

Tous les systemes utilisent deux tuyaux Cryohoses pour I'alimentation et le
retour de fluide caloporteur de I'unité Cryopilot A. Ces tuyaux sont en acier
inoxydable avec une protection isolante.

3.9 Cryowrap

Cryowrap est une gaine en néoprene qui, lorsqu'elle est enroulée autour
des connexions Cryohose, évite la formation de gel pendant la congélation
de Cryowedge ou du module S°.

310 Systeme d'acquisition des données

Le systéme d'acquisition des données est un module compact qui sert a
numériser les signaux de thermocouples pour permettre un contréle par
I'ordinateur. Le systéme d’acquisition des données est doté d'un cable avec
des prises pour jusqu’a 16 thermocouples de type T.
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Installation du systeme

Ce chapitre est destiné a vous guider pour l'installation du systeme.

41  Outils|équipement nécessaires pour

I'installation

Les outils suivants sont nécessaires pour installer le systeme de
congélation|décongélation:

Différents tournevis pour vis cruciformes et a téte plate

Pince étau avec une poignée d’au minimum 15 cm

Différentes clés polygonales ou a molette

Matiere absorbante telle que des serviettes en polypropyléne pour
essuyer le fluide caloporteur renversé

Multimetre adapté pour mesurer la tension d'alimentation

4.2 Inventaire des composants du systeme

Quand tous les composants du systeme sont déballés, assurez-vous que les
éléments suivants sont disponibles pour l'installation :

Cryopilot A

Cryowedge ou module S°

Cryomixer Jr.

(2) Cryohoses

(4) Cryowraps

Thermocouples de type T (jusqu’a 10 selon le systeme)

USB vers céble Cryomixer Jr.

Ordinateur avec le logiciel Cryopilot

Systéme d’acquisition des données National Instruments USB-9213
USB vers cable Unistat

Fluide caloporteur Dow Syltherm HF (env.19 L)

Siphon de sécurité

Protection isolante de Cryowedge (seulement Cryowedge)
Trois Cryocassettes (seulement Cryowedge)

(10) Celsius® Paks (seulement avec module S°)

(10) Supports de thermocouples (seulement avec module S°)
Outil de desserrage de bride (seulement avec module S?)
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4.3 Choixdulieu d’installation

Installez le systéme sur une surface plane et seche telle qu’une paillasse ou
une table de laboratoire capable de supporter un poids total d’environ

180 kg. Un systéme sur paillasse typique nécessite de disposer d'un espace
d’environ 188 cm de largeur et 76 cm de profondeur. Voir le schéma 5 pour
la disposition convenable et 'espace libre nécessaire. Le Cryopilot A est
refroidi a I'air et nécessite une ventilation adaptée. Etant donné que le
Cryomixer Jr. oscille vers I'avant et vers l'arriére, évitez d'utiliser des chariots
mobiles.

188 cm (réf)
7
Module S*ou < Espace librejmin.de 8 cm
Cryowedge IS o e
[0}
o
I > g
V4 é@
|—— RS =
o
Cryopilot A —fi— ™~
Ordinatuer / «-46 cm min.»
portable [ 7

Boitier Cryomixer Jr.
de connexion

Profondeur nécessaire 76 cm (réf)

[1.5: Espace nécessaire

4.4 Installation du Cryowedge et du Cryohose

/A ATTENTION

Ne tirez pas ou ne pliez pas les Cryohoses pour les fixer au Cryowedge. Cela
peut provoquer des fuites. Laissez du jeu.

/A ATTENTION

Pour éviter d'endommager l'intérieur de la tuyauterie, appliquez un couple
antagoniste adéquat lorsque vous serrez les raccords unions Cryopilot A.

P Placez le Cryowedge dans la protection isolante fournie en vous
assurant que les raccords d’entrée et de sortie du fluide caloporteur ne
sont pas recouverts.

> Placez le Cryowedge isolé sur le Cryomixer Jr. Positionnez le Cryowedge
de maniére a ce que le mouvement du Cryomixer Jr. permette de
mélanger sur la longueur d’'une Cryocassette ou bien de 'emplacement
du Cryowedge (équivalent a la position de I'échangeur de chaleur
central d'un Cryovessel) vers la paroi extérieure (équivalent a la position
de la jaquette d’'un Cryovessel).

» Enfilez deux Cryowraps sur chaque tuyau.

Mode d’emploi Celsius® S* Benchtop System



Installation du systeme

REMARQUE

Les raccords rapides sont assemblés en usine sur les adaptateurs et sur les
tuyaux. S’il s"avere nécessaire de défaire et ensuite de refaire les connexions
en taillant des raccords filetés en biseau, utilisez un produit d’étanchéité
pour filetage tel que du Loctite 567.

Raccord M16x1 Raccord M24x1,5

_"raccord sanitaire*

Adaptateur Raccord 16 Mx1

|

%“—J\/\/\—W—HF Cryopilot A

N\
Cryowedge {

Adaptateur* Adaptateur

Raccordrapide Raccordrapide Tuyauisolant
méale %" femelle %" del5m

Il.6 : Installation du Cryohose pour Cryowedge

p» Connectez le raccord « Thermofluid out » du Cryopilot A au raccord
d’entrée du Cryowedge comme indiqué sur le schéma 6. Le raccord
d’entrée du Cryowedge se trouve sur la paroi extérieure qui équivaut a la
position de la jaquette sur un Cryovessel.

p Connectez le raccord « Thermofluid in » du Cryopilot A au raccord de
sortie du Cryowedge comme indiqué sur le schéma 6. Le raccord de
sortie du Cryowedge se trouve a I'endroit qui équivaut a I'échangeur de
chaleur central sur un Cryovessel.

p Vérifiez que tous les tuyaux sont parfaitement raccordés.

4.5 Installation du module S° et du Cryohose

A ATTENTION
Ne tirez pas ou ne pliez pas les Cryohoses pour les fixer au module S°. Cela
peut provoquer des fuites. Laissez du jeu.

A ATTENTION
Pour éviter d'endommager l'intérieur de la tuyauterie, appliquez un couple
antagoniste adéquat lorsque vous serrez les raccords unions Cryopilot A.
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» Placez le module S® sur le Cryomixer Jr. comme indiqué sur la photo 7 de
maniére a ce que le mouvement du Cryomixer Jr. permette de mélanger
sur la longueur d’'un Celsius® Pak.

—_

Pos.  Description

1.7 : Positionnement du module S*

1 Port sortie
2 Port entrée
3 Boutons de montage

P Fixez le module S® a la plaque du Cryomixer Jr. en serrant les quatre
boutons de montage dans le bas du module.
» Enfilez deux Cryowraps sur chaque tuyau.

REMARQUE

Les raccords rapides sont assemblés en usine sur le S® et sur les tuyaux. S'il
s'avere nécessaire de défaire et ensuite de refaire les connexions en taillant
des raccords filetés en biseau, utilisez un produit d’étanchéité pour filetage
tel que du Loctite 567.

Raccord M16x1 Raccord M24x1,5

Adaptateur Raccord 16 Mx1

|

Module $? %“—\N\/\—W—HF Cryopilot A

Adaptateur

Raccord rapide Raccord rapide Tuyauisolant
male %" femelle %" del5m

I11.8 : Installation de Cryohose pour le module S*

» Connectez le raccord « Thermofluid out » du Cryopilot A au raccord
d’entrée du module S°. Le S® est équipé de 2 raccords rapides, le raccord
d’entrée est celui qui se trouve en bas.

p» Connectez le raccord « Thermofluid in » du Cryopilot A au raccord de
sortie du module S°. Le S® est équipé de 2 raccords rapides, le raccord de
sortie est celui qui se trouve en haut.

P Vérifiez que tous les tubes sont parfaitement raccordés.
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Installation du systeme

4.6 Installation de Cryopilot A

A\ DANGER
Toutes les installations électriques doivent étre réalisées par un électricien
qualifié.

P Assurez-vous que l'interrupteur principal de Cryopilot A est sur la
position « OFF » ou « O ». Linterrupteur est rouge et jaune et se trouve a
I'arriere de Cryopilot A comme indiqué sur la photo 9.

P Un électricien qualifié doit installer une fiche (non fournie) sur le cordon

d’alimentation de Cryopilot A. La fiche doit correspondre au boitier et

doit étre adaptée a la tension et a l'intensité de votre réseau. Reportez-
vous au chapitre « 3 Composants du systéme », page 100 pour
connaitre les caractéristiques de I'alimentation électrique.

Connectez I'unité Cryopilot A a I'alimentation électrique.

Mettez l'interrupteur principal de Cryopilot A sur la position « ON ».

Vérifiez que tous les voyants s'allument brievement et que I'écran LCD

rectangulaire est allumé. Si ce n’est pas le cas, vérifiez que l'unité

Cryopilot A est bien alimentée en courant. Sil'unité Cryopilot A est

alimentée en courant, mais que le contréleur n’est pas sous tension,

veuillez contacter le service aprés-vente (voir page 139).

vVVvy

4.7 Remplissage du fluide caloporteur

[l est recommandé de disposer d’environ 19 L de fluide caloporteur pour
effectuer 'installation du systéme. Dow Syltherm HF est utilisé comme
fluide caloporteur en raison de son point de congélation peu élevé et de sa
faible viscosité sur une large gamme de température. Pour plus
d'informations, veuillez vous reporter a la Fiche Technique sur la Sécurité
des Substances Dow Syltherm HF.

REMARQUE
Dow Syltherm HF est le seul fluide caloporteur autorisé a étre utilisé dans ce
systeme.

P Fermezlavanne devidange en la tournant dans le sens des aiguilles
d’une montre pour qu’elle soit en position verticale et en fermant la vis
d’étanchéité du bas située surle c6té de Cryopilot A comme indiqué sur
la photo 10.
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1 2 3

[11.110 : Vanne de vidange du fluide caloporteur et vis d'étanchéité de Cryopilot A

Pos.  Description

Vis d‘étanchéité du raccord de vidange principal
Vanne de purge du fluide caloporteur

2 Vanne de vidange du fluide caloporteur
3 Vitre du regard

Vis d'étanchéité de lavidange

Vanne de purge du fluide caloporteur

P Enlevez le bouchon du reservoir de remplissage de remplissage placé
dans le haut du Cryopilot A.

» Elevezle bidon de Syltherm HF au-dessus du Cryopilot A.

P Insérez I'extrémité du tuyau du siphon de sécurité dans le Cryopilot A et
I'extrémité de la vanne dans le bidon de Syltherm HF. Immergez
I'extrémité de la vanne rouge dans le Syltherm HF et remuez-la de haut
en bas pour démarrer le siphon. Pour arréter le flux de fluide caloporteur,
sortez I'extrémité de la vanne rouge du Syltherm HF. Remplissez I'unité
Cryopilot A jusqu’a ce que vous atteigniez la marque de 2 L inscrite sur la
vitre du regard.

» Démarrez une purge d’air manuelle (appuyez sur Start, Start air purge,
30s interval, OK). Ajoutez encore du fluide caloporteur jusqu’a ce que le
niveau sur la vitre du reservoir se stabilise sur 2 L.

» Vérifiez qu'il n’y a pas de fuites au niveau des raccordements de tuyaux.

P Arrétez la pompe (appuyez sur Stop, Air purge off).

P Fixez les Cryowraps au-dessus des surfaces métalliques découvertes a

chaque extrémité des deux tuyaux.
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4.8 Installation de CryomixerJr,

» Connectez le Cryomixer Jr. a I'alimentation électrique.

P Mettez le bouton de commande manuelle placé surla face avant du
Cryomixer Jr. dans la position « O ».

p Mettez le commutateur Manuel | Automatique qui se trouve a l'arriere du
Cryomixer Jr. dans la position manuelle (en bas) comme indiqué sur la
photo 11.

P Tournezle bouton de réglage de la vitesse completement dans le sens
inverse des aiguilles d'une montre (O t/min.).

p Tournezle bouton de commande manuelle sur la position « | ».

» Tournez doucement le bouton de réglage de la vitesse dans le sens des
aiguilles d'une montre jusqu’a ce que vous atteigniez le nombre de
tours|minute correct, et enregistrez la vitesse de rotation affichée sur
I'écran LCD du Cryomixer Jr. Les réglages standard sont les suivants :
— Cryowedges CW20 et CW125:45 t/min.

— Cryowedges CW300 (30”) et CW300 (34”) : 35 t/min.
— Module $*:120 t/min.

REMARQUE

Les réglages de la vitesse du mélangeur peuvent varier en fonction des
caractéristiques du produit du client. Veuillez contacter Sartorius si vous
souhaitez effectuer des modifications par rapport aux recommandations
indiquées ci-dessus.

p Mettez le commutateur Manuel | Automatique qui se trouve a l'arriere
du Cryomixer Jr. dans la position automatique (en haut).

4.9 Installation de lI'ordinateur

p Connectez lI'ordinateur et I'écran a I'alimentation électrique. Il est
recommandé d’utiliser une protection contre les surtensions (non
fournie).

P Mettez I'ordinateur et I'écran sous tension. Répondez aux questions du
dialogue d’installation Windows. Il peut s’avérer nécessaire de demander
certaines informations aupres du service informatique de votre
entreprise.

A ATTENTION

Aucun programme antivirus n‘est installé sur les ordinateurs livrés par
Sartorius. Il est recommandé d’installer un programme antivirus
conformément aux directives de votre société.
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410 Installation du systeme d’acquisition de
données

p Connectez le National Instruments USB-9213 a I'ordinateur avec un
cable USB.

p Connectez une des extrémités du cadble USB vers le Cryomixer Jr. a la
prise située a l'arriere du Cryomixer Jr. Branchez I'autre extrémité a un
port USB de l'ordinateur.

p Pourles modules S°, branchez les connecteurs de thermocouples males
du module S* au cable de thermocouples. Branchez le connecteur 1dans
la fiche 1, le connecteur 2 dans la fiche 2, et ainsi de suite. Branchez les
thermocouples Celsius® Pak dans la réglette de fiches située a l'intérieur
du boitier du capot de S°.

p Connectez I'une des extrémités du cable USB vers Unistat a un port USB
de l'ordinateur et I'autre extrémité au port série placé sous la ComBox
comme indiqué sur la photo 12. La ComBox est située a l'arriere du
Cryopilot A.

[11.112 : Port série de Cryopilot A
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5 Logiciel Cryopilot

51 Description génerale

Le systeme de laboratoire est commandé et contrdlé par le logiciel
Cryopilot qui est une application graphique concue pour des ordinateurs
équipés de Microsoft Windows. Le logiciel Cryopilot permet aux utilisateurs
d’effectuer avec souplesse les opérations de congélation et de
décongélation.

Le schéma ci-dessous illustre la maniére dont les composants du systéme
sont reliés entre eux. Le logiciel Cryopilot a une interface avec le refroidis-
seur Cryopilot A et le mélangeur Cryomixer Jr. via un USB et avec jusqu’a
16 thermocouples par I'intermédiaire d'un systéme d’acquisition des
données National Instruments.

Computer
usBe UsB usB
Iy
USB to Unistat Cable USB to Cryomixer Jr. Cable
USB Cable FTH-DA00D00-0062 FTH-DA000O0-0061
Y Y Y
National
Instruments Cryopilot A Cryomixer Jr.
USB-9213

A

16x Type T Thermocouple Cable
FTH-DAD0000-0065

Cryowedge or §*

111.113 : Systéme Cryopilot

5.2 Configuration requise

Le logiciel Cryopilot est installé en usine sur les ordinateurs commandés

aupres de Sartorius en tant que composant d'un systéme de laboratoire. ||

est également disponible sur USB Flash Drive pour les systemes qui

répondent aux exigences suivantes:

— Systéme d’exploitation : Microsoft Windows 7 Professional, 32 bits avec
Service Pack 1 ou Microsoft Windows 10 Professional, 64 bits.

— Systeme d’acquisition des données : National Instruments USB-9213.

Le logiciel Cryopilot est livré avec un programme qui installe automatique-

ment le logiciel Cryopilot et tous les pilotes tiers requis sur votre ordinateur.
Vous devez avoir les droits administratifs pour installer Cryopilot.
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53 Composants

Le logiciel Cryopilot est installé par défaut dans C:\Programmes\Sartorius
Stedim Biotech\Cryopilot 5 pour un systeme d’exploitation de 32 bits et
dans C:\Program Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 pour un
systeme d’exploitation de 64 bits et que nous allons désormais appeler
« répertoire d'installation » dans la suite de ce manuel. Vous trouverez
ci-dessous une description des fichiers et des dossiers que contient le

répertoire d'installation :

Composant Description

Profiles/ Répertoire des fichiers profils
standard fournis avec Cryopilot.

BouncyCastle.Crypto.dll Bibliotheque de support

Cryopilot.chm

Fichier d’aide

Cryopilot.exe

Fichier exécutable pour le logiciel
Cryopilot. Les raccourcis vers ce
fichier se trouvent sur le bureau et
dans le menu de démarrage.

Cryopilot.exe.config

Fichier de réglages

ICSharpCode.SharpZipLib.dll Bibliotheque de support
libftdi.dll Bibliotheque de support
log4net.dll Bibliotheque de support

Nationallnstruments.Common.dll

Bibliotheque de support

Add Nationallnstruments.
NiLmClientDLL.dII

Bibliotheque de support

Add Nationallnstruments.
MStudioCLM.dII

Bibliotheque de support

Nationallnstruments.DAQmx.dll

Bibliotheque de support

NPlot.dll

Bibliotheque de support

uninsO00.dat

Fichier de support du programme de

désinstallation

uninsO00.exe

Programme de désinstallation

En plus des fichiers dans le répertoire d’installation, le programme

d’installation Cryopilot crée un dossier appelé Cryopilot dans le dossier Mes

documents de chaque utilisateur. Désormais, nous appellerons ce dossier
« répertoire utilisateur ». Vous trouverez ci-dessous une description des
fichiers et des dossiers que contient le répertoire utilisateur :
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Composant Description

Data/ Répertoire par défaut pour les fichiers sauvegardés par
les utilisateurs. Les utilisateurs peuvent choisir de
sauvegarder les fichiers ailleurs sur I'ordinateur ou sur un
lecteur de réseau.

Custom Répertoire par défaut pour les profils personnalisés

Profiles/ sauvegardés par les utilisateurs. Les utilisateurs peuvent
choisir de sauvegarder les fichiers ailleurs sur I'ordinateur
ou surun lecteur de réseau.

Les fichiers qui sont sujets a des modifications mais qui sont communs a
tous sont enregistrés dans C:\ProgramData\Sartorius Stedim Biotech\
Cryopilot 5.

Composant Description

log.txt Fichier utilisé pour le logiciel de dépannage

settings.xml Fichier de réglages

Le programme d’installation Cryopilot installe également plusieurs
bibliotheques supplémentaires : Microsoft .NET Framework 4.6.1, National
Instruments NI-DAQmx et des pilotes USB.

5.4 Installation

Pour installer le logiciel Cryopilot, insérez I'USB Flash Drive et double-cli-
quez sur mysetup.exe. L'installation exige de disposer de droits d’adminis-
trateur. Contactez I'administrateur de votre systéme si vous n‘avez pas de
droits suffisants.

En général, les réglages par défaut sont adaptés.

Une fois que la procédure d’installation est terminée, on vous demande de
redémarrer votre ordinateur.

REMARQUE

[l est important que I'ordinateur soit configuré de maniére a ne pas s’arréter
ou se mettre hors tension pendant un processus de congélation | décongé-
lation.

Pour Windows 7 ou Windows 10, allez dans le Panneau de configuration >
Systéme et sécurité > Options d'alimentation. Sélectionnez le mode

« Performances élevées ». Cliquez sur « Modifier les parametres du mode »,
puis sur « Modifier les paramétres d’alimentation avancés ». Réglez « Disque
dur > Arréter le disque dur aprés » sur O (jamais). Réglez « Paramétres USB >
Parameétre de la suspension sélective USB » sur « Désactivé ». Cliquez sur
OK, puis fermez la fenétre du Panneau de configuration.
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5.5 Interface utilisateur

551 Fenétre principale

La fenétre principale est I'écran primaire utilisé dans le logiciel Cryopilot. Elle
contient les options du menu qui permettent d’interagir avec le programme, un
graphique pour afficher les données du processus et une légende pour
sélectionner les courbes a représenter sur le graphique.

1 —=3 CryoPilot - N:\CryoPilot\Data\2009-03-03-13-48-43.cpd LEE
2 ——File  Edt Process Tooks Help
3 — A S )b a e
Temperature vs. Elapsed Time 0:23:59—‘— 6
=L ) HTF Setpoint |
24 - — 7
: 0.0« |
HITF Supply
20 = — 8
1 ] 1.3 < |
4 is ] || product 1 9
-
o™ - 22.8 °C |
%12 || Product 2
Sl ] 24.8
- a8l — || Product 3
S 1 === oC
ar T Product 4
A ] =—aC
0 Product 5
N 3
== o
4 o.’os o‘ ] |1 0‘1 o Izs o‘.: ] ‘35 Product 6
Elapsed time, h ro
5 Tjon\lne
[1.14 . Fenétre principale
Pos. Commande Description
1 Barre de titre Affiche le nom de I'application et le nom
du fichier actuel, s'ily ena un
2 Barre de menu Contient les menus permettant
d’effectuer les tadches courantes.
3 Barre d’outils Contient les boutons permettant
d’effectuer les taches courantes
4 Graphique Affiche une courbe de température par
rapport au temps écoulé
5 Barre d'état Indique si I'équipement est en ligne ou
hors ligne.
6 Compteur de temps Indique combien de temps s’est écoulé
écoulé depuis que le processus a été démarré.
7 Légende « HTF Setpoint  Affiche la valeur de consigne du fluide
caloporteur
8 Légende « HTF Supply »  Affiche la température réelle du fluide
caloporteur
9 Légende du produit x Affiche la température du thermocouple

de type Tn°x.
Selon le matériel, il est possible de
contrdler jusqu’a 16 thermocouples
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5.5.2 Dialogue Start Process

Le dialogue Start Process (démarrer le processus) demande a I'utilisateur

d’entrer des informations qui seront utilisées au cours du processus.

Start Process
General
1 ——— Chart title: Temperature vs, Elapsed Time
2 ——— Datafilename: | N:\CryoPilot\Data|2009-03-03-14-52-52.cpd lead —or ¢
3 ——— Use profile: ) None
(®) Standard
Application: |53 30mL v 7
Process: Freeze .v ! 8
() Custom
4 0 9
5 - Description: 10 Celsius-Paks 30ml containing buffer, used For
profile development
[ oK ] I Cancel ]
1 10

I11.115: Dialogue Start Process

Pos. Commande Description

1 Chart title Titre indiqué au-dessus du graphique. Le titre
par défaut est « Temperature vs. Elapsed Time »
(Température vs Temps écoulé).

2 Data filename Nom complet du fichier ou les données de ce
processus seront enregistrées. Le nom par
défaut est [Répertoire utilisateur]\Data\[code
date].cpd, [code date] étant une chaine
numeérique comprenant I'année, le mois, le jour,
les heures, les minutes et les secondes.

3 Sélecteur du Trois options sont disponibles : None pour

type de profil aucun profil, Standard pour un profil standard
fourni par Sartorius ou Custom pour un profil
fourni par I'utilisateur.

4 Nom de fichier Nom complet du fichier ou se trouve le profil

du profil Custom.

5 Description Zone pour entrer des informations

supplémentaires sur le processus.

Mode d’emploi Celsius® S* Benchtop System
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Pos. Commande

Description

6 Bouton de

sélection du nom

Ouvre un dialogue pour sélectionner un dossier
et un nom de fichier ou les données de ce
processus seront enregistrées.

Propose six options si le profil Standard a été

sélectionné:

— S°30mL: pour les systemes S* avec dix
Celsius® Paks de 30 mL

— $°100mL: pourles systémes S® avec dix
Celsius® Paks de 100 mLCelsius® Paks

— Cryowedge 12"

— Cryowedge 24"

— Cryowedge 30"

— Cryowedge 34"

du fichier

7 Liste déroulante
Application

8 Liste déroulante
Process

Propose trois options si le profil Standard a été

sélectionné:

— Freeze : pour effectuer uniquement une
congélation

— Thaw: pour effectuer uniquement une
décongélation

— Freeze and Thaw : pour effectuer une
congélation suivie d'une décongélation

9 Bouton de

sélection du nom
de fichier du profil

Ouvre un dialogue pour sélectionner un dossier
et un nom de fichier ou se trouve le profil
Custom.

10 Bouton Cancel

Pourignorer les informations et fermer la fenetre
de dialogue sans démarrer le processus.

N Bouton OK

Pour accepter les informations, fermer la fenetre
de dialogue et démarrer le processus.
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5.5.3 Dialogue Options

Le logiciel Cryopilot peut étre configuré a I'aide du dialogue de configura-
tion Cryopilot. Dans la fenétre principale, sélectionnez I'option du menu
Tools (Outils) > Options.

7
m‘_
Certificates IHardWarB |

Digital certificates are used to ensure the authenticity and inkegrity of CryoPilot data
files, Yaou may obtain a digital certificate by clicking the Create button below or by
contacking waur swstem administratar,

Select a digital certificate to use when saving data files:

| Issued b | Issued to | Friendly name | Expiration date |
M SARTORIL-7ED..,  SARTORIU-7E4,..  CryoFilot 3442011

Create Wienw Manage

[0]4 I Cancel |
i

2 3 4

I11.116 : Dialogue Options - Onglet Certificates

Pos. Commande Description
1 Liste des Pour afficher une liste de certificats numériques
certificats disponibles. Pour chaque certificat, la liste

indique qui a délivré le certificat, a qui il a été
délivré, le nom convivial et la date d’expiration.

2 Bouton Create Pour créer un nouveau certificat auto-signé et
I'installe dans le dossier Trusted Root
Certification Authorities.

3 Bouton View Pour afficher des détails supplémentaires pour
le certificat sélectionné.

4 Bouton Manage Pour ouvrir Microsoft Management Console
pour des taches supplémentaires de gestion
des certificats telles que le renouvellement et
la suppression de certificats.

5 Bouton OK Pour accepter les modifications et fermer le
dialogue.

6 Bouton Cancel Pour refuser les modifications et fermer le
dialogue.

7 Onglet Hardware  Pour afficher I'onglet Hardware.

Mode d’emploi Celsius® S* Benchtop System 19
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7

Certificates | Hardware |

Data Acquisition
A data acquisition device is used to read temperature sensors. Select an
available device from the st below or select None to disable data acquisition:

Device: |UsB-9213 (Dev1) ]

Chiller

A chiller is used to control the temperature of the heat transfer fluid (HTF).
Select a device from the list below:

Type:  |Huber Unistat v

Port: [coms |v

Shaker

A shaker is used to agitate product during thaw. Select a device from the
list below or select None to disable shaking.

Device: ‘USBCryoMixsf . Interface .V.]

o [ cancel |
|
5 6
[11.117 : Dialogue Options - Onglet Hardware
Pos. Commande Description
1 Champ de sélec- Loption « None » (Aucun) ne configure

tion du systeme

d’acquisition de de données. Si un systéme d'acquisition de

données (Data
Acquisition)

2 Champ de sélec-  Loption « None » (Aucun) ne configure

tion du refroidisse-

I'application pour aucun refroidisseur. Sivous

ment (Chiller) sélectionnez I'option « Huber Unistat »,

I'application sera configurée pour collecter les
données d’un refroidisseur Huber équipé d'un

controleur Unistat, tel qu’un Cryopilot A.

3 Champ de sélec-  Pour afficher une liste de ports (COM) série
tion port COM disponibles.

4 Champ de L'option « None » (Aucun) ne configure

sélection Shaker
(mélangeur)

vers le cable Cryomixer Jr. est détecté, il sera
automatiquement sélectionné.

5 Bouton OK Pour accepter les modifications et fermer le
dialogue.

6 Bouton Cancel Pour refuser les modifications et fermer le
dialogue.

7 Onglet Certificates Pour afficher 'onglet Certificates.

Mode d’emploi Celsius® S* Benchtop System
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5.6 Mise en service

Avant de pouvoir démarrer un profil, vous devez configurer le logiciel.
Assurez-vous que le systéme d’acquisition de données (DAQ) et le
refroidisseur sont connectés et sous tension. Ensuite, sélectionnez I'option
du menu Tools (Outils) > Options pour afficher le dialogue Options.

5.61 Sélection d’'un certificat numérique

Tout d’abord, vous devez sélectionner un certificat numérique. Cryopilot
utilise un certificat numérique pour garantir I'authenticité et I'intégrité des
fichiers enregistrés. L'onglet Certificates contient une liste de certificats
disponibles. Il est recommandé d’utiliser un certificat délivré par une
autorité de certification (AC) reconnue. Si le service informatique de votre
entreprise a déja établi une infrastructure de certificat numérique, il peut
étre en mesure de fournir un certificat a utiliser avec Cryopilot.

Au cas ou vous n‘auriez pas de certificat a utiliser avec Cryopilot, vous
pouvez créer ce que I'on appelle un certificat autosigné. « Autosigné »
signifie que la personne qui crée le certificat se porte également garante de
sa légitimité. Pour cela, cliquez sur le bouton « Create », puis sur le bouton

« Yes » dans le dialogue qui apparatit. Le certificat nouvellement créé
apparaitra dans la liste des certificats disponibles.

5.6.2 Configuration du matériel

Vous devez ensuite sélectionner le matériel. Longlet Hardware (Matériel)
contient les réglages pour les configurations courantes du matériel. La
structure la plus courante consiste en un systéme d’acquisition de données
(DAQ), en un refroidisseur et en un mélangeur. Dans la plupart des cas, le
matériel sera détecté automatiquement.

Sivous ne voulez pas démarrer de processus, mais seulement utiliser
Cryopilot pour revoir des fichiers, sélectionnez « None » (Aucun) pour
I'acquisition des données, le refroidisseur et le mélangeur.

Pour enregistrer les options, cliquez sur OK.

5.6.3 Déroulement du programme

Quand le logiciel Cryopilot est lancé, I'écran initial apparait brievement,
puis la fenétre principale s'affiche.

A ce stade, le logiciel est en attente et ne va rien faire jusqu’a ce que
I'utilisateur démarre un processus.

Pour démarrer un processus, sélectionnez 'option du menu Process > Start
ou cliquez sur le bouton de démarrage d’un processus (Start Process) dans
la barre d’outils. La boite de dialogue Start Process apparait. Une fois que
I'utilisateur a cliqué sur OK, le logiciel essaie de se connecter au systeme
d’acquisition de données, au mélangeur et au refroidisseur, s'ils sont confi-
gurés. Sil'un des systemes est configuré mais qu’il n’est pas connecté, un
message demande a l'utilisateur de vérifier les connexions et de réessayer
ou bien d‘annuler.

Une fois qu’un processus est démarré, le graphique de température et la
légende sont reconfigurés pour afficher les courbes appropriées ; la
communication est établie avec le refroidisseur et le systeme d’acquisition
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de données (DAQ) est initialisé. Une fois que l'initialisation est terminée, le
message d’initialisation disparait et un premier groupe de points de
données est tracé. Les points de données suivants sont affichés en fonction
de l'intervalle d’échantillonnage fixé a 15 secondes.

Quand l'utilisation du refroidisseur est configurée, le logiciel Cryopilot
utilise un lien série pour envoyer des commandes au refroidisseur et pour en
recevoir des réponses.

Pendant un processus, I'état de connexion est affiché dans le coin inférieur
gauche de la fenétre principale. Un message vert « Online » indique que la
connexion avec le systéme d’acquisition de données et le refroidisseur est
correcte. Un message rouge « Offline » indique qu'il y a un probléme de
connexion.

Le bouton Stop Process arréte I'acquisition de données et éteint le refroidis-
seur et le mélangeur. L'utilisateur peut alors revoir les données. Le fichier de
données doit étre fermé pour que 'utilisateur puisse démarrer un autre
processus.

5.6.4 Examen desdonnées

Cryopilot peut ouvrir et afficher des fichiers enregistrés dans Cryopilot 4 et
Cryopilot 5. Notez que les fichiers créés par Cryopilot 4 peuvent étre utilisés
uniquement a des fins d’examen. Tous les nouveaux fichiers sont enregistrés
au format Cryopilot 5 de maniere a ce que l'intégrité et 'authenticité des
données puissent étre vérifiées a I'aide de la signature numérique.

Il est possible de n“ouvrir qu’un seul fichier a la fois.

Pour ouvrir un fichier, procédez de I'une des facons suivantes :
p» Cliquez surle bouton Ouvrir dans la barre d’outils

» Ouvrezle menu File et cliquez sur Open

P Utilisez le raccourci clavier Ctrl+O

Sivous utilisez le dialogue Open Data File (Ouvrir un fichier), sélectionnez le
fichier que vous voulez ouvrir. Assurez-vous de sélectionner le type de
fichier dans la liste déroulante « Files of type » (Type de fichiers).

Cryopilot 5 utilise des signatures numériques pour attester que les données
n‘ont pas été modifiées depuis qu’elles ont été enregistrées a I'origine. Si

I'intégrité et I'authenticité du fichier ne peuvent pas étre vérifiées au moyen
d’une signature numérique, un message vous le signale et vous demande de
continuer ou d’annuler. Ce message apparait principalement dans deux cas:

— Quand on ouvre un fichier Cryopilot 4. Les fichiers Cryopilot 4 ne
contiennent pas de signature numérique.
— Sile certificat utilisé pour le fichier n’est pas fiable.

Une fois que le fichier est chargé, les données qu'il contient sont envoyées
au graphique ou elles peuvent étre étudiées exactement comme si elles
provenaient a l'instant d’un processus en cours.

En cliquant sur le graphique avec le bouton droit de la souris et en cliquant
sur l'option Review, vous pouvez faire défiler le graphique vers la droite et
vers la gauche et vérifier les valeurs pour chaque courbe a un point précis
dans le temps. Quand la ligne d’examen défile vers la droite ou vers la
gauche, la légende est mise a jour pour montrer I'horodatage et les valeurs
de courbe pour ce point dans le temps.
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5.6.5 Utilisation du graphique

Le graphique permet d’afficher la température d'un processus par rapport
au temps écoulé. Le temps écoulé est affiché en heures sur I'axe X et la
température en degrés Celsius sur I'axe Y. Une légende permet d’identifier
et d’afficher la valeur actuelle pour chaque courbe.

Panoramique et zoom

L'échelle est ajustée automatiquement par défaut pour adapter le
graphique aux données disponibles. Cette fonction d'ajustage automatique
de I'échelle peut étre activée ou désactivée a I'aide des options « Auto Scale
X» et « Auto Scale Y » dans le menu pop-up qui apparait lorsque I'on clique
sur le graphique avec le bouton droit de la souris.

[l est possible de modifier I'échelle directement en tirant les axes X et Y. Pour
afficher le graphique en panoramique, tirez-le tout en maintenant le bouton
gauche de la souris enfoncé. Quand on change I'échelle ou qu’on affiche le
graphique en panoramique, Auto Scale (échelle automatique) est désac-
tivé. Double-cliquez sur le graphique pour réactiver Auto Scale.

Légende

La légende identifie chacune des courbes sur le graphique. Chaque courbe
a sa propre légende indiquant son nom, sa couleur, ses unités et la valeur
actuelle. Pour cacher une courbe, double-cliquez sur sa légende et elle
apparaitra estompée. Pour afficher la courbe, double-cliquez a nouveau sur
la légende. Cela peut étre utile quand on essaie de regarder des fichiers
avec beaucoup de courbes superposées.

Mode Review

Le mode Review permet a |'utilisateur de revoir les données a n‘importe
quel stade du processus. Le mode Review peut étre activé et désactivé dans
le menu pop-up représenté sur la figure 19. Quand on est en mode Review,
une ligne verticale est affichée sur le graphique et le temps écoulé et les
légendes affichent les valeurs qui correspondent a cet endroit sur le
graphique.

5.6.6 Exportdesdonnéees

Cryopilot provides two different methods to export data. It can export an
image of the current chart view or it can export raw data for viewing in a
spreadsheet application.

Export du graphique

Pour exporter le graphique, sélectionnez I'option du menu Edit > Copy >
Chart. Le graphique est copié dans le presse-papiers Windows comme
image bitmap. Le graphique peut étre collé dans d’autres applications en
sélectionnant Edit > Paste ou en appuyant sur Ctrl+V. Cette option est utile
lorsque I'on a besoin rapidement d’un instantané des données, par exemple
dans une présentation avec des diapositives. Utilisez I'option Copy > Data
pour analyser davantage les données.
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Export des données

Pour exporter les données, sélectionnez I'option du menu Edit > Copy >
Data. Les donnés brutes sont copiées dans le presse-papiers Windows au
format délimité par les tabulations. Il est possible de coller les donnés dans
des tableurs tels que Microsoft Excel ou OpenOffice Calc en sélectionnant
la cellule de destination et en sélectionnant Edit > Paste ou en appuyant sur
Ctrl+V.

5.6.7 Impression

Cryopilot peut créer un rapport pour le fichier ouvert. Le rapport est un
instantané de la représentation actuelle du graphique y compris du titre et
de lalégende. Le rapport peut étre affiché surl'écran sous la forme d'un
apercgu ou étre envoyé a une imprimante. Si un pilote d'impression PDF tel
qu’Adobe Acrobat est installé sur votre ordinateur, vous pouvez enregistrer
le rapport au format PDF sur un disque.

Pour imprimer un rapport, procédez de I'une des facons suivantes :

» Cliquez surle bouton Impression dans la barre d’outils

» Ouvrezle menu File et cliquez sur Print

P Utilisez le raccourci clavier Ctrl+P Le dialogue Print (Impression) apparait
et vous demande de sélectionner I'imprimante de destination et le
nombre de copies. D'autres réglages tels que les marges et le format du
papier peuvent étre effectués dans Page Setup. Cliquez sur OK pour
envoyer le rapport a I'imprimante sélectionnée.

5.6.8 Profils

Le logiciel Cryopilot commande le refroidisseur et le mélangeur en suivant
un profil. Un profil est une recette qui contient des instructions servant a
modifier la température de consigne du refroidisseur et le mode de
consigne du mélangeur (marche|arrét) selon une fonction de temps. Le
logiciel Cryopilot est fourni avec un ensemble de profils standard qui sont
adaptés a de nombreuses applications avec le module S* et le Cryowedge.

Il peut s'avérer nécessaire de créer un nouveau profil adapté a une
application spécifique. Lors de la création d’'un nouveau profil, il faut tenir
compte de plusieurs facteurs :

— Quelles opérations veut-on effectuer : congélation, décongélation ou les
deux?

— Des cycles multiples de congélation et de décongélation sont-ils
nécessaires ?

— Quelle est la température initiale de la matiére a congelerou a
décongeler ? Si elle est variable, une étape d'équilibrage au début du
profil peut améliorer la reproductibilité.

— Le systeme doit-il rester en marche ou s’arréter une fois que la
congélation ou la décongélation est terminée ?

Les taux de congélation et de décongélation sont ajustés de maniére
empirique. Si on souhaite avoir une valeur de consigne plus basse pour une
congélation, il peut étre nécessaire d’augmenter la durée de la valeur de
consigne finale ou de réduire la température ajustée. Sivous essayez de
décongeler rapidement sans dépassement, utilisez une température de
consigne élevée pour une courte durée et ensuite diminuez la température
de consigne avant que la température cible ne soit dépassée.
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Edition d’un profil

Les profils peuvent étre créés et édités manuellement avec des éditeurs de
texte (par ex. Microsoft Notepad) ou des tableurs (par ex. Microsoft Excel).
Quand vous utilisez un éditeur de texte, utilisez toujours la touche de
tabulation pour séparer les colonnes ; nutilisez pas la touche espace. Pour
une nouvelle ligne, utilisez la touche Retour ou Entrée apres avoir entré
I'état du mélangeur.

Sivous utilisez un profil standard comme point de départ, assurez-vous de
I'enregistrer sous un nouveau nom de fichier et ensuite d’effectuer les
modifications.

Comportement de la derniére étape

Par défaut, une fois que le logiciel Cryopilot exécute la derniére étape d'un
profil, il laisse le refroidisseur et le mélangeur tels quels jusqu’a ce que
I'utilisateur arréte le profil en cliquant sur le bouton STOP. Dans certains cas,
il est utile d'éteindre le refroidisseur et le mélangeur au bout d’un certain
temps. Cela est possible en placant une instruction TURN CHILLER OFF
(Arréter le refroidisseur) aprés l'instruction STOP. Notez que cela n’est pas
possible a I'aide de I'éditeur de profil Cryopilot, mais doit étre effectué
manuellement avec un éditeur de texte ou un tableur. Par exemple, le profil
suivant va arréter le refroidisseur et le mélangeur a 311 minutes :

0 -40  OFF
31000 -60  OFF
STOP

311.00 TURN CHILLER OFF

Linstruction TURN CHILLER OFF (Arréter le refroidisseur) est visible dans
I'éditeur de profil Cryopilot, mais aucune température n'y est associée.

Format des fichiers

Les profils sont sauvegardés sur disque comme fichiers délimités par les
tabulations. L'encodage des caractéres est ASCII et le format du fichier ne
fait pas la distinction entre les majuscules et les minuscules. Toutes les
lignes trouvées avant le signe START sont une description du fichier. Cela
signifie que la description ne peut pas contenir le mot « start ». Entre le
signe START et le signe STOP optionnel, chaque ligne représente une étape
dans le profil. Lheure de démarrage indique quand I'étape doit démarrer;
elle a des unités en minutes écoulées et est exprimée en décimales. Lheure
de démarrage de |'étape doit étre O et les heures de démarrage des étapes
successives doivent augmenter de maniére constante. Notez que I'heure de
démarrage pour chaque étape fait référence a I'heure de démarrage du
profil si bien qu’une étape de 30 minutes doit avoir les heures de démarrage
0, 30 et 60. La valeur de consigne du refroidisseur est indiquée en degrés
Celsius et elle est exprimée en décimales.

Siunsigne STOP est présent, la ligne suivante peut étre un signe TURN
CHILLER OFF (Arréter le refroidisseur).
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La syntaxe suivante est utilisée pour décrire le format du fichier:

\n Caractere de nouvelle ligne, définicomme CRLF
\s Zéro ou plus de caractéres blancs

\t Caractére de tabulation

<variable> Elément variable

[FOO] Elément optionnel

OFF|ON Valeur énumérée, élément doit étre I'un ou l'autre
Indigque une structure qui se répéete

Format:

[<description>\n]

START\s\n

<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n

[STOP\n
[<start time>\tTURN CHILLER OFF]]

Exemple (\n implicite) :
II's’agit d'un profil de test avec trois étapes.

START
0 -20 OFF
30 -60 ON

200 10 OFF

5.6.9 Fichiers de données

Pendant un processus, le logiciel Cryopilot contréle les composants du
systéme et enregistre les valeurs importantes dans un fichier sur
I'ordinateur.

Le logiciel Cryopilot 5 peut ouvrir des fichiers créés par Cryopilot 4 ou des

fichiers créés par Cryopilot 5. Toutefois, tous les nouveaux fichiers enregis-

trés par Cryopilot 5 sont enregistrés au format Cryopilot 5. Le fichier

contient les valeurs de processus suivantes:

— Température de consigne du fluide caloporteur du refroidisseur et
température réelle du fluide caloporteur

— Valeur de consigne du mode du refroidisseur (marche|arrét)

— Valeur de consigne du mode du mélangeur (marche|arrét)

— Jusqu’a 14 température mesurée par thermocouples de type T

L'extension par défaut des fichiers Cryopilot 5 est .cpd.

Un fichier Cryopilot est un fichier ZIP contenant deux fichiers :
— data.txt qui est un fichier délimité par les tabulations
— data.txt.p7s qui est une signature numérique au format PCKS#7.

Des tableurs tels que Microsoft Excel peuvent importer le fichier délimité
par les tabulations, mais il est plus facile de transférer les données en
utilisant I'option du menu File > Copy > Data. N'essayez pas d’ouvrir le
fichier pour un processus en cours car le tableur peut condamner le fichier
pour empécher le logiciel Cryopilot d’écrire des données supplémentaires.
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Format des fichiers

Le fichier data.txt et les résultats de la commande File > Copy > Data

contiennent tous les deux un texte délimité par les tabulations. L'encodage

des caractéres est ASCII et le format du fichier ne fait pas la distinction
entre les majuscules et les minuscules. La premiére ligne doit contenir le
créateur et la version comme spécifié ci-dessous. Toutes les valeurs de
température sont indiquées en degrés Celsius.

La syntaxe suivante est utilisée pour décrire le format du fichier:

\n Caractere de nouvelle ligne, défini comme CRLF
\s Zéro ou plus de caractéres blancs
\t Caractére de tabulation

<variable> Elément variable

[FOQO] Elément optionnel

OFF|ON  Valeur énumérée, élément doit étre I'un ou l'autre
Indigue une structure qui se répete

Notez que les heures sont spécifiées comme Universal Coordinated Time

(UCT) qui peut différer de I'heure locale en fonction de votre fuseau horaire.

La oU aucune donnée n’est disponible, le fichier contient le symbole « NaN »

(Not a Number).

Format:

Cryopilot 5.0\n

METADATA\n

Title\t<title>\n

Process Start\t<timestamp format=yyyy-MM-dd HH :mm :ssZ>\n
Computer\t<computer name>\n

User\t<user name>\n

Description\t<description>\n

START\n

Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply
Temperature Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\
tProduct Temperature 1(C)\tProduct Temperature 2(C)\t...Product
Temperature n(C)\n

<timestamp format=yyyy-MM-dd HH :mm :ssZ>\t<elapsedhours
format=0.000000x>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n
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Exemple avec quatre thermocouples (\n implicite) :

Cryopilot 5.0

METADATA

Title Température vs temps écoulé

Démarrage du processus 2009-03-03 21:49:227

Ordinateur DEMO _LAPTOP

Utilisateur DEMO_LAPTOP\Administrator

Description

DEMARRAGE

Date/Heure(UTC) Temps écoulé(h) Etat du refroidisseur Température de
consigne de I'alimentation en fluide caloporteur(C) Température de I'alimentation en fluide caloporteur(C)
Etat du mélangeur Température (C)

produit 1 Température (C) produit 2 Température (C) produit 3

Température (C) produit 4

2009-03-03 21:49:31Z 0.002500 On 0.0 21.0 On 228 254 NaN NaN
2009-03-03 21:49:46Z 0.006667 On 0.0 20.7 On 228 253 NaN NaN
2009-03-03 21:50:01Z 0.010833 On 0.0 203 On 228 253 NaN NaN
2009-03-03 21:50:16Z 0.015000 On 0.0 20.0 On 228 252 NaN NaN
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5.610 Diagnostics|Dépistage des erreurs

Des messages d’erreur et d’état sont affichés dans la zone de message en
bas a droite de la fenétre principale. Cette partie décrit les erreurs courantes
et ce que I'on peut faire poury remédier.

Refroidisseur

Si un probléme se produit au niveau du refroidisseur, procédez de la

maniére suivante :

> Vérifiez les deux extrémités du céble entre I'ordinateur et le refroidisseur.

P Vérifiez le journal des erreurs du refroidisseur. Pour plus de détails,
consultez le mode d’emploi Huber Unistat 705.

P Vérifiez que les réglages de communication du refroidisseur sont correc-
tement configurés. Le Cryopilot A devrait étre réglé de maniere a utiliser
une vitesse de transmission de 9 600 bauds et le protocole RS232. Pour
plus de détails, consultez le mode d’emploi Huber Unistat 705.

P Endernierrecours, quittez le programme Cryopilot, éteignez puis
rallumez le refroidisseur et redémarrez le programme Cryopilot. Essayez
de déterminer I'origine du probléme avant de redémarrer un autre
processus. Assurez-vous que les réglages effectués dans le dialogue
Options sont corrects.

Si une coupure de courant se produit pendant un processus, il se peut que
le refroidisseur se déconnecte ou que les données provenant du refroidis-
seur soient endommagées. La présence de NaN (not a number) dans les
zones de température du fichier indique également une erreur au niveau du
refroidisseur.

Mélangeur

Sile mélangeur ne fonctionne pas comme il devrait, procédez de la maniere

suivante:

P Vérifiez le cable entre I'ordinateur et le mélangeur.

P Veérifiez que le commutateur de mode situé a l'arriere du mélangeur est
en position Auto.

P Vérifiez que la vitesse est correctement réglée.
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Systéme d’acquisition de données | Thermocouples

Les erreurs suivantes sont des erreurs courantes concernant le systéme

d’acquisition de données ou les thermocouples :

— Un capteur ne répond pas aux changements de température comme les
autres capteurs.

Si cela se produit, procédez de la maniére suivante :

» Vérifiez que le capteur en question est connecté a la bonne fiche du céble
de thermocouples raccordé au systéme d’acquisition des données.

P Assurez-vous que chaque capteur est placé et fixé correctement. Une
petite erreur dans 'emplacement peut entrainer de grands écarts par
rapport aux autres capteurs.

p Vérifiez les connexions entre |'ordinateur et le systéme d’acquisition des
données.

P |l se peut qu'un capteur soit endommagé. Vérifiez le capteur avec un
calibrateur de process (par ex. Fluke 725) capable de mesurer des
thermocouples de type T.

5611 21CFR Part 11

Le logiciel Cryopilot 5 est congu pour faciliter la conformité avec les
exigences de 21 CFR Part 11.

Les signatures numériques sont utilisées pour prouver I'authenticité et I'in-
tégrité des fichiers de Cryopilot 5, méme sur des systemes ouverts (c’'est-a-
dire non fiables). Il ne faut pas confondre les termes « signature numérique »
et « signature électronique ». Une signature numérique est une méthode
cryptographique tandis qu’une signature électronique est I'équivalent élec-
tronique d’une signature manuscrite avec des implications légales. Les réfé-
rences aux signatures électroniques dans 21 CFR Part 11 ne s’appliquent pas
aux signatures numeériques utilisées dans les fichiers de Cryopilot 5.

Quelques remarques générales concernant la mise en oeuvre :

— Cryopilot 5 repose sur le systéme d’exploitation pour des fonctions de
gestion des comptes, d'authentification et d’autorisation.

— L'algorithme de signature numérique utilisé par Cryopilot 5 est
SHA-1avec RSA; il est écrit au format PKCS#7.

— Le systeme de fichiers est traité comme un systeme non fiable.

— Quand un processus est arrété, le fichier est fermé et ne peut pas étre
rouvert pour effectuer des modifications. Toute modification des
données par d’autres moyens, qu’elle soit accidentelle ou intentionnelle,
est détectée par le mécanisme de signature numeérique.

— Une fois que les données ont été exportées hors du Cryopilot (par ex.
vers un tableur), leur authenticité et leur intégrité ne peuvent plus étre
assurées.
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6 Fonctionnement du systeme

6.1  Préparation d'un processus

611  Cryowedge

Pour préparer le Cryowedge :

P Enlevez la moitié supérieure de la protection isolante du Cryowedge.

P Enlevez les écrous-papillons qui maintiennent le couvercle transparent
et mettez-les de coté.

» Enlevez le couvercle transparent. Remplissez le Cryowedge avec la
solution de test a I'aide d’une éprouvette graduée. Les volumes standard
pour chaque taille de Cryowedge sont les suivants:

Taille du Cryowedge Volume (mL)
CW20 (12 pouces 350
CW125 (20 pouces) 650
CW300 (30 pouces) 3000
CW300 (34 pouces) 4000
P Remettez le couvercle transparent.
P Remettez les écrous-papillons et serrez-les a la main. Ne serrez pas trop
les filetages ou ne les laissez pas apparents.
P Remettez la moitié supérieure de la protection isolante du Cryowedge.
P Assurez-vous que le cable du Cryomixer Jr. est connecté au Cryomixer

Jr.etal'ordinateur.

P Assurez-vous qu’au moins six thermocouples sont connectés au systeme
d’acquisition des données, en partant de la position 1.

P Placez cing des thermocouples a travers les trous pré-percés dans le
couvercle transparent. Fixez les thermocouples sous la surface de
la solution de test a I'aide de piéces d’écartement en plastique ou de
morceaux de tube en silicone.

P Placez le thermocouple restant en haut du couvercle transparent pour
qu’il serve de température de référence a la surface extérieure du
Cryowedge.

» Pourvotre information, notez le numéro et la position de chaque
thermocouple.

612 Module §?

Les Celsius® Paks sont livrés préstérilisés aux rayons Gamma. lls sont fournis
avec des raccords Luer femelles et des capuchons sur 2 raccords de
remplissage|de vidange. Une variante avec des rallonges de tube C-Flex®
est également disponible pour effectuer un remplissage stérile. Tous les
Celsius® Paks sont dotés d'un capteur thermométrique fermé en
silicone|EVA pour insérer une sonde de température.

Pour obtenir des résultats réguliers, chargez toujours le module S® avec le
méme nombre de Celsius® Paks. Assurez-vous que chaque Celsius® Pak
contient le méme volume. Le thermocouple doit étre placé a chaque fois a
la méme profondeur.
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SRS

[11.20 : Support de thermocouple fixé au
Celsius®- Pak

Les profils de congélation standard fournis avec le logiciel Cryopilot sont
concus pour 10 Celsius® Paks, soit de 30 ou de 100 mL, remplis jusqu’au
volume nominal. Placez des thermocouples a au moins un1cm de
profondeur sous la surface du liquide des Celsius® Paks. Les Celsius® Paks
vides doivent étre remplis de tampon échantillon. N’utilisez pas d’eau
désionisée dans des Celsius® Paks vides car elle surrefroidit. Si vous utilisez
moins de 10 Celsius® Paks, la congélation est plus rapide et le profil ne
transfere pas directement a une plus grande échelle.

Différentes étapes de la procédure destinée a préparer, remplir et charger le
Celsius® Pak :

P Préparezl'échantillon et|ou le tampon pour remplir les Celsius® Paks.

P Insérez une étiquette dans le support a étiquette dans le bas du Celsius®
Pak. Une étiquette mesurant environ 2 x5 cm passe entierement dans le
support. Il est recommandé d’utiliser une étiquette et de I'encre résistant
a l'eau. N'écrivez pas sur les Celsius® Paks car les solvants utilisés dans
I'encre peuvent pénétrer dans le Celsius® Pak et contaminer le produit.

P Utilisez une seringue ou une pompe péristaltique pour remplir les
Celsius®- Paks d'échantillon ou de tampon par un des raccords de
remplissage|vidange. Raccordez la seringue ou la pompe a la ligne
optionnelle C-Flex® via un raccord Luer® méle ou en les soudant.

» Remplissez les Celsius® Paks de 30 mL avec au maximum 30 mL et les
Celsius® Paks de 100 mL avec au maximum 100 mL.

A ATTENTION

Ne remplissez pas trop les Celsius® Paks ou videz tout I'air par le haut des
Celsius® Paks car il provoquera une expansion du liquide et de la glace dans
le tuyau du raccord.

P Fermezle tube de remplissage avec le bouchon Luer® fourni ou avec un
collier de serrage.

P Avant de commencer la congélation, essuyez 'humidité de toutes les
surfaces se trouvant a l'intérieur du module S°.

Les Celsius® Paks sont maintenus dans le module S* par un mécanisme de
pince a ressort qui sert de surface active de transfert de la chaleur. Effec-
tuez les étapes suivantes pour charger le module S*:

» Fixez le support de thermocouple au Celsius® Pak en alignant le raccord
Luer lock® femelle placé sur le support de thermocouple avec le raccord
Luer lock® méle se trouvant en haut du capteur thermométrique. Aprés
avoir serré le raccord Luer lock® au capteur thermométrique, notez que
I'avant du support de thermocouple doit se trouver dans la méme direc-
tion que I'étiquette avant du Celsius® Pak.

P Mesurez1cm a partir de I'extrémité du thermocouple et faites une
marque a cet endroit pour placer le thermocouple dans le Celsius® Pak.

p Dévissez doucement le circlip du thermocouple en veillant a conserver
les deux petits joints toriques qui se trouvent dans le circlip. Placez le
circlip et deux joints toriques sur I'extrémité du thermocouple et vissez
I'écrou de sécurité juste assez pour I'empécher de tomber du support du
thermocouple.
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p Abaissez le thermocouple dans le capteur thermomeétrique. Ne poussez
jamais trop fort pour ne pas transpercer I'extrémité du capteur thermo-
métrique. Pour un contréle thermique précis, mettez toujours les ther-
mocouples a 1cm sous la surface du liquide dans le Celsius® Pak en vous
assurant que la marque sur le thermocouple correspond a la surface du
liquide.

I11.21: Thermocouple a 1cm sous la surface du
liquide

P Serrez le circlip pour maintenir le thermocouple en place a l'intérieur du
capteur thermométrique.

P Placez-vous a gauche du module S°; insérez un Celsius® Pak entre les
meécanismes de pinces en commencant par I'emplacement 10, 'empla-
cement le plus éloigné de I'alimentation et du renvoi en fluide calopor-
teur. Ouvrez le mécanisme en mettant I'outil de déclenchement de la
pince au-dessus des 2 chevilles de guidage sur les 2 blocs de serrage en
acier inoxydable pour 'emplacement et en appuyant dessus.

P Tout en appuyant sur I'outil de déclenchement de la pince, glissez
chaque cété du Celsius® Pak vers le bas entre un bloc noir et un bloc de
serrage en acier inoxydable du mécanisme de serrage. Placez le haut du
Celsius® Pak de maniéere a ce qu’il soit au méme niveau que la partie
supérieure de la barre fixe en métal noir du mécanisme de la pince.
Notez que le Celsius® Pak doit étre tourné vers la gauche pour passer
correctement dans le module S°.

I1.22 : Ouverture du mécanisme de la pince de
serrage

P Retirez I'outil de déclenchement de la pince. Le Celsius® Pak est main-
tenu fermement de chaque c6té entre deux blocs en métal, I'un noir et
I'autre en acier inoxydable. Connectez les fiches méales du thermocouple
a laréglette de fiches pour thermocouples correspondante.

I11.23 : Installation du support de thermocouple
et de Celsius® Pak
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II1.24 : Mise en place du Celsius® Pak et connexion du thermocouple

P Recommencez cette procédure pour les emplacements 9 a 1. La schéma
26 présente I'emplacement final de tous les Celsius® Paks et de tous les
thermocouples.

REMARQUE

Pour assurer la reproductibilité, chargez le module S* avec le méme nombre

de Celsius® Paks, remplissez chaque Celsius® Pak avec la méme quantité
d'échantillon ou de tampon et placez les thermocouples dans les capteurs
thermométriques a 1cm sous la surface du liquide. Tous les profils de congéla-
tion développés par Sartorius ne fonctionnent correctement que si le systeme
est entierement chargé (10 Celsius® Paks). Les résultats obtenus permettent un
changement d’echelle lineaire vers 16,6 litres. Sil'on change le nombre de
Celsius® Paks, la linearite du changement d’echelle de ces profils s'en trouve
affectée.

P Dessinez un schéma avec la position et le numéro de chaque
thermocouple dans un carnet de laboratoire ou en conformité avec les
réglementations de votre entreprise.

» Fermez et verrouillez le couvercle du module S°.

Réglette de fiches de thermocouples
OO OOEO
Emplacement des Celsius® Paks remplis
' N " ' N Y ™ ) ' I Erirde
de fluide
caloporteur
Sortie
1 de fluide
10 9 8 7 6 5 4 3 2 1 Sloporteur
\_/ \_/ \_/ \_/ \_/ / \_/ \_/ \_/ \_/

I1I1.25 : Emplacement des thermocouples et des Celsius® Paks dans le module S*
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6.2 Fonctionnement d'un profil

REMARQUE

Lorsque vous décongelez avec le module S°, assurez-vous que les 4
boutons de montage du module S® sont serrés et que le module est
maintenu de maniére slre sur la plaque du Cryomixer Jr.

/A ATTENTION

Ne dépassez jamais une valeur de 120 t/min. pour le Cryomixer Jr.

>

Double-cliquez sur I'icone du logiciel Cryopilot pour initialiser le logiciel
Cryopilot.

Sélectionnez 'option du menu Process > Start pour afficher le dialogue
Start Process.

Donnez un nom au fichier ou les données de I'heure et de la température
du nouveau processus seront enregistrées.

Sélectionnez le type de profil Standard et sélectionnez votre application
et 'opération souhaitée (congélation, décongélation ou congélation et
décongélation). Ou bien sélectionnez un profil personnalisé.

Cliquez sur le bouton OK pour démarrer le processus.

Vérifiez que le refroidisseur répond aux commandes du logiciel.

« Online » doit étre affiché en bas a gauche de I'écran. Un délai de

2 a 5 minutes est nécessaire avant que le compresseur ne démarre et
que le réglage de température ne commence.

Laissez le profil fonctionner jusqu’a la fin du temps programmé.
Sélectionnez 'option du menu Process > Stop pour arréter le processus.
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6.3 Enlever des Celsius® Paks congelés du
module S°

Dans certains cas, il est souhaitable d’enlever les Celsius® Paks du module S*
alors qu'ils sont encore congelés.

» Enlevez le couvercle transparent du module S°.

REMARQUE

Sil'appareil reste ouvert pendant une période prolongée pendant qu'il est
maintenu a faible température, du gel se forme sur les pinces, les

Celsius®- Paks et les supports de thermocouples et il est difficile d’enlever
les Celsius® Paks. Une fois que 'appareil est ouvert, enlevez rapidement les
Celsius® Paks congelés et remettez le capot en place.

P Enlevez les thermocouples des Celsius® Paks. Si un thermocouple ne
s'enléve pas facilement, tordez-le doucement jusqu’a ce qu’il se détache.
Enlevez le support de thermocouple de chaque emplacement. Side la
condensation se forme a la surface des pinces, elle forme une
«adhérence en glace » entre les supports de thermocouples et les blocs
de refroidissement en métal noir. Il est alors pratiquement impossible de
retirer les supports de thermocouples. Essuyez I'humidité sur toutes les
surfaces avant de commencer une congélation.

P Enlevezles Celsius® Paks congelés du module S* a I'aide de 'outil de
déclenchement de la pince pour remonter et sortir les Celsius® Paks.
Placez-les dans un récipient de transport isolant.

P Conservez les Celsius® Paks congelés dans un récipient de protection
placé dans un congélateur a la température souhaitée. Sivous réalisez
des tests de stabilité ou des études de formulation, il est préférable
d’utiliser un congélateur commandé avec un contrdle thermique.

6.4 Retrait d’échantillons décongelés du
module S*

Enlevez les thermocouples et les supports de thermocouples.

Enlevez les Celsius® Paks décongelés du module S°.

Retournez chaque Celsius® Pak trois fois pour mélanger le produit de

maniere uniforme.

P Soutirez la quantité souhaitée d'échantillon du Celsius® Pak par le
raccord de remplissage | de vidange inutilisé. Vous pouvez utiliser une
seringue, une pompe ou une évacuation par gravité.

P Jetez les Celsius® Paks usagés. Comme les Celsius® Paks sont parfois

déformés pendant la congélation et la décongélation, ils ne s'adaptent

pas aussi bien entre les mécanismes de serrage si on les réutilise. Cela
peut provoquer une congélation et une décongélation prolongées en
raison de la faiblesse du transfert thermique.

vvyy
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/  Maintenance du systeme

Les opérations de maintenance peuvent étre effectuées par I'utilisateur
final ou par Sartorius. Contactez le service aprés-vente de Sartorius pour
établir un contrat de maintenance préventive.

En cas de probléme, consultez tout d’abord le chapitre sur les codes
d’erreur qui se trouve dans le mode d’emploi Huber Unistat 705. Sivous ne
pouvez pas remédier au probleme, appelez le service client (voir page 139).

/.1 Nettoyage

Les surfaces exposées du systeme sont généralement compatibles avec des
sprays et des lingettes contenant de I'alcool isopropylique. Les surfaces en
acier inoxydable peuvent étre nettoyées avec un produit a polir I'inox.

Le compartiment interne du S°® contient plusieurs parties en aluminium
anodisé qui est incompatible avec des solutions basiques telles que
I'hydroxyde de sodium (NaOH) ou les oxydants. Ces matieres ne doivent
pas étre utilisées pour nettoyer le compartiment interne. S'il est nécessaire
de nettoyer le compartiment interne, il est plutét recommandé d’utiliser de
I'alcool isopropylique ou d’autres solutions de nettoyage non-oxydantes.

72  Changement du fluide caloporteur

Changez le fluide caloporteur si vous voyez qu’il est contaminé par de I'eau
ou des particules ou si vous constatez une baisse d’efficacité du transfert
de chaleur (c’est-a-dire quand l'appareil n‘atteint pas la température de
consigne ou n’y reste pas). Changez toujours tout le fluide caloporteur. Si
I'efficacité du transfert de chaleur ne s"améliore pas aprés que vous avez
changé le fluide caloporteur, contactez le service clientéle (voir page 139).

Pour changer le fluide caloporteur, suivez la procédure suivante :

p Vérifiez que la vanne de purge du fluide caloporteur du systeme située
surl'avant de I'appareil est fermée. La fente du capuchon de la vis est
verticale quand la vanne de purge est fermée. Voir « [I.10 : Vanne de
vidange du fluide caloporteur et vis d’étanchéité de Cryopilot A »,
page 110.

> Enlevez lavis d’étanchéité dans le tuyau inoxydable proéminent placé
sur le coté gauche de I'appareil et connectez un morceau de tuyau
flexible sur I'extrémité du tuyau. Fixez-le fermement avec un collier de
serrage pour tuyau.

P Mettez I'autre extrémité du tuyau dans un bidon qui contient au moins
12 L de fluide caloporteur.

p Ouvrez lavanne de purge du fluide caloporteur en la tournant dans le
sens inverse des aiguilles d'une montre jusqu’a ce que la fente soit
horizontale.

P Sipossible, essayez de soulever le Cryowedge ou le module S* pour
vider le reste de fluide caloporteur du module d’application relié au
Cryopilot A.
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» Quand le fluide caloporteur ne s’écoule plus, fermez la vanne de purge
du fluide caloporteur, enlevez le tuyau flexible du tuyau de la vis
d’étanchéité et replacez la vis d’étanchéité.

P Remplissez le systéeme Cryopilot A avec du nouveau fluide caloporteur
en suivant la procédure expliquée dans le chapitre « 4.7 Remplissage du
fluide caloporteur », page 109.
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8 Instructions d’élimination des
déchets et de réparation

Sivous n‘avez plus besoin de 'emballage de votre appareil, veuillez I'ap-
porter au service local de retraitement des déchets. Cet emballage se
compose entiérement de matériaux écologiques pouvant étre recyclés.

L'appareil, y compris les accessoires, les piles et les batteries, ne doit pas étre
jeté dans les ordures ménagéres normales. La Iégislation de I'Union euro-
péenne prescrit aux Etats membres de collecter les équipements élec-
triques et électroniques séparément des déchets municipaux non triés afin
de permettre ensuite de les récupérer, de les valoriser et de les recycler.

En Allemagne et dans quelques autres pays, la société Sartorius se charge
elle-méme de reprendre et d'éliminer ses équipements électriques et
électroniques conformément a la loi. Ces appareils ne doivent pas étre jetés
(méme par de petites entreprises) dans les ordures ménageres ni apportés
dans les points de collecte des services locaux d’élimination des déchets.

Pour obtenir de plus amples renseignements sur I'élimination des déchets,
veuillez vous adresser en Allemagne, tout comme dans les Etats membres
de I'Espace Economique Européen, a notre responsable local du service
aprés-vente ou a notre centre de service aprés-vente a Goettingen en
Allemagne:

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Goettingen, Allemagne

Dans les pays qui ne font pas partie de I'Espace Economique Européen ou
dans lesquels Sartorius n’est représenté par aucune filiale, succursale, ni
aucun revendeur ou distributeur, veuillez vous adresser aux autorités locales
ou a une entreprise d’élimination des déchets.

Les piles, batteries et accumulateurs rechargeables ou non doivent étre
enlevés avant de jeter 'appareil ou de le mettre au rebut et ils doivent étre
jetés dans les boites de collecte locales prévues a cet effet.

Les appareils contaminés par des substances dangereuses (contaminations
NBC) ne sont pas repris par Sartorius, ses filiales, ses succursales ni par ses
revendeurs pour étre réparés ou éliminés. Veuillez visiter notre site Internet
(www.sartorius.com) pour obtenir davantage de renseignements ainsi que
les adresses des centres de service aprés-vente a contacter si vous envi-
sagez le renvoi en réparation, I'élimination ou le recyclage de votre appareil.

Contact

Sartorius Stedim FMTS.AS.

Z| des Paluds

Avenue de Jouques - CS 91051
13781 Aubagne Cedex

Tél. +33 442 845600
Fax +33 442 845619
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sartorius

biotech

Déclaration CE de conformité

Société

Sartorius Stedim Systems GmbH

Adresse

Schwarzenberger Weg 73-79

34212 Melsungen; Allemagne

Téléphone +49.551.308.0, Fax +49.551.308.3289
www.sartorius-stedim.com

Is the certificate

up to date?

Nous déclarons qu'en raison de sa conception et de sa cons-
truction ainsi que de la version que nous mettons en circu-
lation, I'appareil mentionné ci-aprés est conforme aux
exigences fondamentales et pertinentes de la directive CE
relative a la sécurité et a la protection de la santé.

Cette déclaration perd sa validité si des modifications qui
n‘ont pas été certifiées par Sartorius Stedim Systems sont
effectuées sur 'appareil.

Personne autorisée pour la documentation

Sartorius Stedim Biotech GmbH

a l'attention de Marc Hogreve
August-Spindler-Strasse 11

37079 Goettingen, Allemagne

Téléphone +49.551.308.3752, Fax +49.551.308.2062

Désignation de I'appareil

Benchtop Freeze-Thaw System

Modéle, version

S3 System, CryoWedge System

No cat.

FTH-CS00000-0002, FTH-CS00000-0004, FTH-CS00000-0006,
FTH-CS00000-0008, FTH-CS00000-0010, FTH-CS00000-0012,
FTH-CS00000-0014, FTH-CS00000-0016

Directives importantes de la CE

2006/42/CE
2004/108/CE  Compatibilité électromagnétique

2006/95/CE  Matériel électrique destiné & étre employé
dans certaines limites de tension

Machines

Normes harmonisées applicables

EN 1SO 12100-1:2003, EN 1SO 12100-2:2003
EN 61326-1:2006
EN 61010-1:2001

Normes nationales applicables et
caractéristiques techniques

n'a été pas appliquée

4
/ = Al _’/
Date et signature 25.01.2011 . i l /
. l..( s \‘ \,\Q
Fonction du signataire ars Bottcher Dr. Susanne g(éighausen
Director of R&D for Director of Quality

Automation, Sensors
and Instruments

Engineered Systems and
Instruments
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Introduzione

1 Introduzione

Sartorius offre delle soluzioni di congelamento-scongelamento scalabili
utilizzando tecnologie brevettate per manipolazione, stoccaggio e trasporto
di prodotti biofarmaceutici, nonché gli strumenti per lo sviluppo di processi,
I'esecuzione su scala pilota e la produzione su scala commerciale. Le
configurazioni del sistema benchtop sono concepite per riprodurre i
processi di congelamento-scongelamento controllati che hanno luogo nei
processi Celsius® e Cryovessel di grande volume su scala produttiva.
Cryovessel € una linea di prodotto in acciaio inox e Celsius® € una linea di
prodotto monouso. Entrambi i sistemi utilizzano il refrigeratore Cryopilot A
e l'agitatore Cryomixer Jr.

1.1 Cryovessel

[l sistema su piccola scala per Cryovessel € chiamato Cryowedge. Il modulo
Cryowedge riproduce una piccola sezione del Cryovessel facendo corri-
spondere la geometria della superficie di scambio termico, la lunghezza del
tratto di congelamento e il materiale di costruzione.

Per gli studi di fattibilita € possibile ridurre i requisti in materia di volume di
prodotto utilizzando una Cryocassette. Si tratta di recipientida 30 mL e
100 mL in acciaio inox che possono essere installati nel Cryowedge in
guaine polimeriche.

1.2 Celsius®

Il sistema su piccola scala per Celsius® & chiamato modulo S* S® significa
“Scale-down” (riduzione di scala) e “Stability Studies” (studi di stabilita).

[l modulo S* permette di imitare i moduli di congelamento-scongelamento
FT16 e FT100 facendo corrispondere la lunghezza del tratto di
congelamento. Il sistema di congelamento-scongelamento Celsius® S*
genera dei tempi di congelamento-scongelamento simili, consentendo
quindi dei test di congelamento-scongelamento scalabili e degli studi di
stabilita.

1.3 Referenze

Ulteriori informazioni sui componenti del vostro sistema benchtop di
congelamento-scongelamento sono contenute nei seguenti documenti:
— Manuale d'uso Huber Unistat 705

— Schemi elettrici Huber Unistat 705

— Informazioni sul prodotto Dow Syltherm HF

— Scheda tecnica sulla sicurezza del materiale (MSDS) Dow Syltherm HF
— Scheda tecnica sulla sicurezza del materiale (MSDS) DuPont Suva 507
— Scheda tecnica sulla sicurezza del materiale (MSDS) DuPont Suva 23
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2 Sicurezza

Osservare con attenzione tutte le istruzioni per evitare lesioni gravi o mortali
per il personale e danni alle apparecchiature. Qualsiasi uso dei componenti
del sistema in applicazioni per le quali non sono destinati annulla le garanzie
dell’apparecchio e solleva Sartorius da ogni e qualsiasi responsabilita.

| seguenti simboli segnalano informazioni importanti:

A AVVISO
Situazioni potenzialmente pericolose che potrebbero causare lesioni
mortali o gravi se non fossero evitate.

/A ATTENZIONE

Rischi potenziali minori per la sicurezza del personale o danni potenziali per
apparecchiature o beni.

NOTA

Informazioni che sono importanti ma che non riguardano la sicurezza.

2.1 Precauzioni generali

» Assicurarsi che vengano sempre rispettate le regole di sicurezza
dell’azienda.

P Scollegare I'alimentazione elettrica e seguire le procedure appropriate
di bloccaggio e sbloccaggio (lock-out|tag-out) quando si eseguono
interventi di manutenzione all'interno dei componenti del sistema.

» Non tendere i Cryohose per collegarli al refrigeratore o all'impianto. A
tale scopo e preferibile spostare il refrigeratore o I'impianto per poter
collegare i tubi flessibili senza che siano tesi. Lasciare che ci sia gioco
sufficiente in modo che non si formino delle pieghe.

P | componenti del sistema sono pesanti. Osservare le tecniche adeguate
per il sollevamento e montaggio.
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2.2 Fluido di scambio termico

[l sistema utilizza il fluido siliconico per scambio termico Dow Syltherm HF
(HTF). Non usare un altro tipo di fluido di scambio termico.

L'utilizzo del fluido di scambio termico comporta diversi rischi:

Le temperature di -75°C e di 250°C possono causare lesioni gravi a
pelle, occhi e altri tessuti morbidi. Usare attrezzature di protezione
individuale adatte quando si lavora con il fluido di scambio termico o
vicino alle superfici esposte calde o fredde dell’apparecchio.

Syltherm HF ha un punto di infiammabilita in vaso chiuso di 63°C (145°F)
secondo ASTM D92. In conformita con NFPA e OSHA esso é classificato
come liquido combustibile di classe IIIA. Osservare le procedure
adeguate perla manipolazione e lo stoccaggio.

Syltherm HF ha una tensione superficiale bassa e puo essere difficile
evitare degli spruzzi durante il iempimento o lo svuotamento del
sistema. Il liquido fuoriuscito & estremamente scivoloso. Usare materiale
assorbente come dei pad in polipropilene per asciugare il fluido di
scambio termico versato sul banco o sul pavimento.

[l fluido di scambio termico usato e il materiale assorbente devono
essere smaltiti come rifiuti pericolosi. Per maggiori informazioni si
rimanda alle informazioni sul prodotto e alla scheda tecnica sulla
sicurezza dei materiali (MSDS).

2.3 Cryopilot A

La manutenzione del sistema di raffreddamento deve essere eseguita solo
da personale qualificato. Il Cryopilot A utilizza i refrigeranti idrofluorocarburi
(HFC) R-507 e R-23. Questi refrigeranti sono soggetti a normative
ambientali e non devono essere dispersi nell’atmosfera.

P Per maggiori informazioni si rimanda alla scheda tecnica sulla sicurezza

dei materiali (MSDS).

2.4  CryomixerJr.

» Durante il funzionamento tenere le mani distanti dalla piastra di

copertura superiore.

> Non superare la velocita di agitazione massima consigliata che ¢ indicata

nel capitolo “Installazione del sistema”.
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3 Componentidel sistema

31  Cryopilot A

I Cryopilot A & un refrigeratore a ricircolo che regola la temperatura del
fluido di scambio termico in funzione di un valore nominale di temperatura.

Un sistema di refrigerazione in cascata raffredda il fluido di scambio termico
quando la sua temperatura reale supera la temperatura nominale. |
componenti principali del sistema di refrigerazione sono un compressore ad
alta temperatura, un compressore a bassa temperatura, un condensatore,
una valvola di espansione automatica e un evaporatore. | refrigeranti
impiegati negli stadi elevati e bassi sono rispettivamente R23 e R507. I
condensatore refrigerante é raffreddato ad aria.

Due radiatori a resistenza elettrica riscaldano il fluido di scambio termico
quando la sua temperatura reale scende al di sotto della temperatura
nominale. Per forti variazioni di temperatura si usa un grande radiatore di
1500W, mentre per piccole variazioni della temperatura si usa un piccolo
radiatore di 1TO0OW. Questa configurazione a due radiatori fornisce un
controllo preciso della temperatura di alimentazione del fluido di scambio
termico.

Una pompa a velocita variabile fa circolare il fluido attraverso I'evaporatore, i
radiatori e I'impianto esterno. Per le applicazioni con Cryowedge il fluido
scorre attraverso la camicia e nell’area dello scambiatore di calore interno.
Per le applicazioni con il modulo S? il fluido scorre attraverso le pareti
adiacenti ai morsetti di serraggio dei Celsius® Pak. Un vaso di espansione
semplifica 'adescamento del sistema e permette I'espansione e la
contrazione del fluido di scambio termico.

Il Cryopilot A & controllato da un microprocessore. Linterfaccia utente del
controller & dotata di diversi pulsanti, un encoder rotativo, un display LCD
con touch screen e un diagramma di sistema con LED di stato.

Qui di seguito sono elencate le specifiche principali di Cryopilot A:

Alimentazione elettrica

NOTA: il Cryopilot A & fornito senza spina. Essendoci diversi tipi di presa
elettrica, a seconda del paese di utilizzo, il cliente deve procurarsi la propria
spina.

North America 208 VAC, 60 Hz,1~,20 A
Europe 230 VAC, 50 Hz, 1~,15,6 A
Campo di temperature del fluido -75°C fino a 250°C
Dimensioni (LxPxA) 425x400x720 mm
(16,7"x15,7"x28,3")
Peso 90 kg
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3.2 Computer

[l Cryopilot A & comandato e controllato per mezzo del software Cryopilot
installato su un computer. Il software Cryopilot comanda e controlla i
componenti del sistema benchtop, compresi il refrigeratore, il miscelatore e
le termocoppie. Si rimanda al capitolo “5 Software Cryopilot”, pagina 159
per conoscere i requisiti minimi del sistema e per maggiori informazioni.

| computer acquistati presso Sartorius come parte di un sistema benchtop
hanno le seguenti specifiche:

— Fattore di forma computer portatile

— Sistema operativo:

— Microsoft Windows 10 Professional, 64 bit

— Microsoft Excel

— Adobe Acrobat

— Software Cryopilot preinstallato

3.3 Modulo Cryowedge

I nomi dei moduli Cryowedge corrispondono al volume di Cryovessel usati
su scala produttiva. Per esempio, un Cryowedge 125 (20”) simula un
Cryovessel 125 L.

Volume di lavoro 350 -4000 mL, in base alla misura del
Cryowedge

Materiali di costruzione

Corpo acciaio inox 316L

Guarnizioni silicone

Copertura policarbonato trasparente
Connessioni HTF in (ingresso del fluido di scambio

termico), HTF out (uscita del fluido di
scambio termico) con raccordi a
disinnesto rapido

Peso, vuoto
Cryowedge 20 (127) 15 kg
Cryowedge 125 (20") 21 kg
Cryowedge 300 (307) 44 kg
Cryowedge 300 (34") 49 kg

Equivalenza delle misure
Cryowedge 20 (127) Cryovessel 20L-40 L
Cryowedge 125 (207) Cryovessel 60 L-150 L
Cryowedge 300 (307) Cryovessel 200 L-300 L
Cryowedge 300 (34") Cryovessel 300 L
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3.4 Cryocassette

La Cryocassette diminuisce la quantita di prodotto usata all'interno del
Cryowedge. Il Cryowedge pud essere riempito con soluzione tampone,
mentre la Cryocassette viene riempita con il prodotto. Il design della
Cryocassette mantiene le caratteristiche di congelamento e scongelamento
del Cryowedge per garantire la scalabilita verso i Cryovessel utilizzati nella
produzione. La Cryocassette serve anche come contenitore con stabilita

scalabile.
Volume dilavoro — 10-100 mL, in base alla misura della cassetta
— Disponibile in misure da 30 mL e 100 mL
Fig.1: Cryocassette in acciaio inox Materiali di costruzione
Corpo acciaio inox 316L
Navicella — polipropilene (30 mL)
— o polietilene (100 mL)
Sterilizzazione Sterilizzabile in autoclave da parte del cliente
Finitura 10 p-in Ra, EP

3.5 Celsius® Modulo S?

[ modulo S® di congelamento-scongelamento consente la modellazione dei
sistemi Celsius® FT100 e FT16 con soltanto 20 mL di prodotto. La
/(7%777< configurazione delle superfici di scambio termico all’interno del modulo

(AN AL

~I‘\ N

fornisce lo stesso flusso di calore bidirezionale come nel sistema FT100
utilizzando la struttura e i design dei Celsius® Pak.

Capacita 1-10 campioni di prodotto

Volume di lavoro 20 mLfinoa 1L, in base alla misura dei
Celsius® Pak

Materiali di costruzione

Involucro acciaio inox 302-304
Base alluminio 6061-Té6
Fig.2: Celsius® Modulo S® di congelamento- .
scongelamento Copertura della struttura alluminio 5052

dell'involucro

Piastre terminali piastra in schiuma di PVC rigida

Isolamento interno gomma spugna siliconica
dell’involucro

Copertura terminale Delrin
dell’attacco per fluido di
scambio termico

Copertura PVC trasparente
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Frozen 16.6 L
Celsius® Pak

Fig.3: Confronto tra i Celsius® Pak 30 mL
el6,6 L

Pressione di calcolo massima
della tubazione per fluido di
scambio termico

41 barg (60 psig)

Connessioni HTF in (ingresso del fluido di scambio
termico), HTF out (uscita del fluido di
scambio termico) con raccordi a
disinnesto rapido installati; scarico
Peso ca.18 kg

3.6 Celsius® Paks

Tutti i Celsius® Pak, indipendentemente dalla misura, sono costruiti con lo
stesso materiale e hanno la stessa lunghezza del tratto di congelamento e
scongelamento come mostrato nella figura 3.

| Celsius® Pak sono monouso e pertanto la pulizia non € necessaria.

— Disponibili nelle misure di30 mL e 100 mL

— Contenitore pieghevole monouso, pronto per I'uso

— Presterilizzati (raggi gamma 25-45 kGy)

— Compatibili con saldatura a radiofrequenza (RF)

— Concepiti per permettere una misurazione sterile della temperatura

— Sono disponibili degliinvolucri per i Celsius® Pak. L'uso di un involucro
€ consigliato per studi condotti con temperature piu alte (temperatura

ambiente o superiore).

Materiali di costruzione dei Celsius® Pak da 30 mL e 100 mL

Strato a contatto coniil
prodotto

EVAM (copolimero di etilene acetato
divinile, monomateriale)

Strato barriera a gas e umidita

EVA|EVOH |EVA

Strato di manipolazione EVA
esterno robusto

Raccordi per riempimento e EVA
scarico

Tubi di prolunga C-Flex®

LuerLock®

policarbonato o polipropilene
(opzione C-Flex®)

Gomito di raccordo doppio o
elemento diraccordo

polipropilene (opzione C-Flex®)

Pozzetto termometrico

silicone vulcanizzato al platino

* C-Flex® is a registered trademark of Saint-Gobain Performance

Plastics Corporation.
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Fig.4: Cryomixer Jr.

3.7  CryomixerJr.

Il Cryomixer Jr. & un miscelatore a movimento alternativo che € posizionato
sotto il Cryowedge o il modulo S® per garantire 'omogeneita del prodotto
scongelato. Il movimento alternativo si avvia automaticamente quando il
software Cryopilot attiva il Cryomixer. Il Cryomixer Jr. viene usato per
applicazioni di agitazione sia di Cryowedge che del modulo S°.

Specifiche

Corsa 25 mm, a movimento alternativo

Alimentazione elettrica

Nord America 15V, 60 Hz, 1~

Europa 230V, 50 Hz, 1~
Dimensioni Lx Px A 505x585x120 mm (20”"x23"x5")
Peso 24 kg

3.8 Cryohose

Tutti i sistemi usano due tubi Cryohose per la mandata e il ritorno del fluido
di scambio termico dall’apparecchio Cryopilot A. Questi tubi sono in acciaio
inox avvolti da una guaina isolante.

3.9 Cryowrap

Cryowrap & una guaina in neoprene che viene avvolta attorno alle connes-
sioni Cryohose per prevenire la formazione di gelo durante I'operazione di
congelamento di Cryowedge o del modulo S°.

310 Dispositivo di acquisizione dati

Il dispositivo di acquisizione dati € un modulo compatto che serve a digitaliz-
zare i segnali delle termocoppie per permettere il monitoraggio da parte del
computer. Questo dispositivo € dotato di un cavo breakout con connettori
femmina per fino a 16 termocoppie del tipo T.
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Questo capitolo vi guidera attraverso l'installazione del sistema benchtop.

41  Attrezzi|Apparecchiature richiesti per

I'installazione

Per l'installazione del sistema di congelamento-scongelamento sono
richiesti i seguenti utensili:

Svariati cacciaviti per viti con testa a croce e con testa piatta

Pinza a morsa con impugnatura dialmeno 15 cm

Svariate chiavi a tubo o chiavi inglesi regolabili

Materiale assorbente come dei pad in polipropilene per asciugare il
fluido di scambio termico eventualmente fuoriuscito

Multimetro adatto per misurare la tensione di alimentazione

4.2 Inventario dei componenti del sistema

Una volta che tuttii componenti sono stati disimballati, verificare che i
seguenti articoli siano disponibili per l'installazione:

Cryopilot A

Cryowedge o modulo S*

Cryomixer Jr.

(2) Cryohose

(4) Cryowrap

Termocoppie del tipo a T (fino a 10 a seconda del sistema)

Cavo USB verso Cryomixer Jr.

Computer con software Cryopilot

Dispositivo di acquisizione dati, National Instruments USB-9213
Cavo USB verso Unistat

Liquido di scambio termico Dow Syltherm HF (ca.19 L)

Sifone di sicurezza

Copertura coibentata di Cryowedge (solo per Cryowedge)

Tre Cryocassette (solo per Cryowedge)

(10) Celsius® Pak (solo per il modulo S°)

(10) Supporti delle termocoppie (solo per il modulo S°)

Utensile di sblocco dei morsetti di serraggio (solo per il modulo S°)
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4.3 Scelta del posto diinstallazione

Installare il sistema su una superficie piana e asciutta, come un banco da
laboratorio o un tavolo in grado di reggere un peso complessivo di ca.

180 kg. L'ingombro di un tipico sistema benchtop & all'incirca di 188 cm di
larghezza e 76 cm di profondita. Si rimanda alla figura 5 per la disposizione
appropriata e per lo spazio libero richiesto. Il Cryopilot A e raffreddato ad
aria e richiede una aerazione adeguata. Dato che il Cryomixer Jr. oscilla
avanti e indietro, evitare di usare dei carrelli mobili.

188 cm (rif)
2 7
Module S0 o} 8cmdispaziollibero
Cryowedge 2 Rl
E‘ =
| £ S
E ©
Vs °%
EURS] IS
P s}
Cryopilot A —fi— i
Computer —4—— / ‘¢46 cm min. -»|
portatle N &

Dispositivo di Cryomixer Jr.
acquisizione dati

Profondita richiesta 76 cm (rif)

Fig.5: Spazio richiesto

4.4 Installazione di Cryowedge e dei Cryohose

A ATTENZIONE
Non tendere o piegare i Cryohose per collegarli al Cryowedge. Cio pud
causare delle perdite. Lasciare che ci sia gioco sufficiente.

A\ ATTENZIONE
Applicare una controcoppia adeguata quando si serrano gli elementi di
raccordo di Cryopilot A per evitare che si danneggi I'interno della tubazione.

P Mettere il Cryowedge nella copertura coibentata fornita facendo
attenzione che gli attacchi diingresso e uscita del fluido di scambio
termico rimangano esposti.

P Collocare il Cryowedge coibentato sul Cryomixer Jr. Posizionare il
Cryowedge in modo che il movimento del Cryomixer Jr. consenta di
miscelare sull’intera lunghezza di una Cryocassette o a partire dal punto
del Cryowedge (equivalente alla posizione dello scambiatore di calore
interno di un Cryovessel) fino alla parete esterna (equivalente alla
posizione della camicia di un Cryovessel).

P Infilare due Cryowrap su ciascun tubo.
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NOTA

| raccordi a disinnesto rapido sono assemblati in fabbrica sugli adattatori e
sui tubi. Se & necessario scollegare e ricollegare le connessioni con
filettature coniche, usare un sigillante per filettature come Loctite 567.

Elemento di Elemento di
_"flangia sanitaria* raccordo M16x1 raccordo M24x1,5
Adattatore Elemento di

raccordo M16x1

|
%“—\W—W—HF Cryopilot A

Cryowedge {

Adattatore* Adattatore
Maschio %" Raccordo Tubo
Raccordo rapido coibentato
rapido femmina %" 1,5m

Fig. 6: Installazione di Cryohose per Cryowedge

p» Collegare il raccordo “Thermofluid out” del Cryopilot A al raccordo di
ingresso del Cryowedge come mostrato nella figura 6. Il raccordo di
ingresso del Cryowedge si trova sulla parete esterna che equivale alla
posizione della camicia di un Cryovessel.

p Collegareil raccordo “Thermofluid in” del Cryopilot A al raccordo di
uscita del Cryowedge come mostrato nella figura 6. |l raccordo di uscita
del Cryowedge si trova sul punto che equivale alla posizione dello
scambiatore di calore interno di un Cryovessel.

P Verificare che tuttii tubi siano connessi correttamente.

45 Installazione del modulo S* e dei Cryohose

A ATTENZIONE
Non tendere o piegare i Cryohose per collegarli al modulo S°. Cio pud causare
delle perdite. Lasciare che ci sia gioco sufficiente.

A\ ATTENZIONE
Applicare una controcoppia adeguata quando si serrano gli elementi di
raccordo di Cryopilot A per evitare che si danneggi l'interno della tubazione.
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p Collocare il modulo S* sul Cryomixer Jr. come mostrato nella figura 7 in
modo che il movimento del Cryomixer Jr. consenta di miscelare
sullintera lunghezza di un Celsius® Pak.

—_

Pos. Descrizione

Fig.7: Posizionamento del Modulo S*

1 Qutlet Port
2 Inlet Port
3 Mounting Knobs

P Fissare ilmodulo S® alla piastra del Cryomixer Jr. serrando i quattro
pomelli di fissaggio sul fondo del modulo.
P Infilare due Cryowrap su ciascun tubo.

NOTA

| raccordi a disinnesto rapido sono assemblati in fabbrica sul S® e sui tubi. Se
€ necessario scollegare e ricollegare le connessioni con filettature coniche,
usare un sigillante per filettature come Loctite 567.

Elemento di
raccordo M24x1,5

Elemento di
raccordo M16x1

Elemento di
raccordo M16x1

|
Modulo S3 %“—\/\Aﬁ—m—uk Cryopilot A

Adattatore

Adattatore

Raccordo Raccordo Tubo
maschio %" femmina %" coibentato
Raccordo rapido Raccordo rapido 1,5m

Fig.8: Installazione di Cryowedge per il modulo S*

P Collegare il raccordo “Thermofluid out” del Cryopilot A al raccordo di
ingresso del modulo S°. Dei due raccordi a disinnesto rapido presenti sul
S®, il raccordo diingresso & quello in basso.

» Collegare il raccordo “Thermofluid in” del Cryopilot A al raccordo di
uscita del modulo S°. Dei due raccordi a disinnesto rapido presenti sul S°,
il raccordo di uscita & quello in alto.

» Verificare che tuttii tubi siano connessi correttamente.
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4.6 Installazione di Cryopilot A

A AVWVISO
Tutti i collegamenti elettrici devono essere eseguiti da un elettricista
qualificato.

P Verificare che l'interruttore di alimentazione principale di Cryopilot A sia
nella posizione “OFF” 0 “O”. Linterruttore é rosso e giallo e si trova sul
retro del Cryopilot A come mostrato nella figura 9.

P Rivolgersia un elettricista qualificato per installare una spina (non
fornita) sul cavo di alimentazione del Cryopilot A. La spina deve
corrispondere alla presa elettrica ed essere conforme alla tensione e alla
corrente della rete elettrica. Si rimanda al capitolo “3 Componenti del
sistema”, pagina 146 per le specifiche dell’alimentazione elettrica.

» Collegare I'apparecchio Cryopilot A all’alimentazione elettrica.

P Girare l'interruttore di alimentazione principale di Cryopilot A nella
posizione “ON”.

» Verificare che tuttii LED s'illuminino brevemente e che il display LCD
rettangolare sia illuminato. Se cid non accade, controllare che ci sia
alimentazione elettrica sull’apparecchio Cryopilot A. Se c’é
alimentazione elettrica sul Cryopilot A, ma il controller non si accende, si
prega di contattare il Servizio Clienti (vedi pagina 184).

4.7 Riempimento con il fluido di scambio
termico

Si consiglia di predisporre circa 19 litri di fluido di scambio termico per
I'installazione del sistema benchtop. Come fluido viene usato il Dow
Syltherm HF, poiché presenta un basso punto di congelamento e una bassa
viscosita su un ampio campo di temperatura. Per maggiori informazioni si
rimanda alla scheda tecnica sulla sicurezza del materiale Dow Syltherm HF.

NOTA
Dow Syltherm HF & I'unico fluido di scambio termico autorizzato ad essere
usato in questo sistema.
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>

Assicurarsi che la valvola di scarico sia chiusa girandola in senso orario
nella posizione verticale e chiudendo la vite di tenuta che si trova in
basso sul lato del Cryopilot A come mostrato nella figura 10.

1 2 3

Fig.10: Valvola di scarico del fluido di scambio termico e viti di tenuta di Cryopilot A

Pos. Descrizione

Vite di tenuta del raccordo di scarico principale
Valvola di scarico fluido scambio termico

Valvola di scarico fluido scambio termico

Vetro spia Vite di tenuta scarico
Valvola di scarico fluido scambio termico

vvy

Togliere il tappo del raccordo di riempimento che si trova sulla parte
superiore del Cryopilot A, dietro il vetro spia.

Alzare il contenitore di Syltherm HF sopra al Cryopilot A.

Inserire 'estremita del tubo del sifone di sicurezza nel Cryopilot Ae I'e-
stremita della valvola nel contenitore di Syltherm HF. Immergere I'estre-
mita della valvola rossa nel Syltherm HF e muoverla su e giu per avviare il
sifone. Per arrestare il flusso del fluido di scambio termico, estrarre I'e-
stremita della valvola rossa dal Syltherm HF. Riempire 'apparecchio
Cryopilot A fino a raggiungere la tacca di 2 litri sul vetro spia.

Avviare uno spurgo manuale dell’aria (premere Start, Start air purge, 30s
interval, OK). Aggiungere ancora del fluido di scambio termico fino a
quando il livello del vetro spia si stabilizza a 2 litri.

Verificare che non ci siano delle perdite nelle connessioni dei tubi.
Arrestare la pompa (premere Stop, Air purge off).

Fissare i Cryowrap sopra le superfici metalliche scoperte su ciascuna
estremita dei due tubi.
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4.8 Installazione di Cryomixer Jr.

p» Collegare il Cryomixer Jr. all’alimentazione elettrica.

p Mettere il pulsante di comando manuale del pannello frontale del
Cryomixer Jr. nella posizione “O”.

P Mettere il pulsante Manuale|Automatico che si trova sul retro del
Cryomixer Jr. nella posizione manuale (gil) come mostrato nella figura 11.

P Girareil pulsante della velocita completamente in senso orario
(O giri/ min).

P Girare il pulsante di comando manuale nella posizione “I”.

P Girare lentamente il pulsante della velocita in senso orario fino a raggiun-
gere il numero di giri al minuto corretti e registrare il numero di giri visua-
lizzato sul display LCD del Cryomixer Jr. Le impostazioni standard sono le
seguenti:

— Cryowedge CW20 e CW125: 45 giri/min.
— Cryowedge CW300 (30”) e CW300 (34"): 35 giri/min.
— Modulo S% 120 giri/min.

NOTA

Le impostazioni della velocita del miscelatore possono variare secondo le
caratteristiche del prodotto del cliente. Contattare Sartorius se si vogliono
eseguire delle modifiche rispetto a quelle consigliate sopra.

P Mettere il pulsante Manuale|Automatico che si trova sul retro del
Cryomixer Jr. nella posizione automatica (su).

4.9 Installazione del computer

p Collegare il computer e il display all'alimentazione elettrica. Si consiglia
di usare un dispositivo di protezione contro le sovratensioni (non fornito).

» Accendere il computer e il display. Rispondere alle domande nelle
finestre di dialogo di configurazione Windows “Primo avvio”. Forse &
necessario richiedere alcune informazioni presso il vostro servizio
informatico.

A\ ATTENZIONE

Sui computer acquistati presso Sartorius non ¢ installato un software
antivirus. Si consiglia di installare un software antivirus secondo le linee
guida della vostra azienda.
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410 Installazione del dispositivo di acquisizione
dati

p Collegare il National Instruments USB-9213 al computer con un cavo
USB.

p Collegare un’estremita del cavo USB verso Cryomixer Jr. alla presa posta
sul retro del Cryomixer Jr. Inserire I'altra estremita in una porta USB del
computer.

p Perimoduli S inserire il gruppo di connettori maschi delle termocoppie
del modulo S3 nel cavo breakout delle termocoppie. Inserire il connet-
tore 1nella presa 1, connettore 2 nella presa 2, e cosi via. Inserire le ter-
mocoppie Celsius® Pak nella striscia di prese che si trova nell’area della
copertura del S°.

P Collegare un’estremita del cavo USB verso Unistat alla porta USB del
computer e l'altra estremita alla porta seriale posta sotto la ComBox
come mostrato in figura 12. La ComBox si trova sul retro del Cryopilot A.

Fig.12: Porta seriale Cryopilot A
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5 Software Cryopilot

51 Visione d’'insieme

[l sistema benchtop &€ comandato e controllato per mezzo del software
Cryopilot che & un’applicazione grafica per computer con sistema operativo
Microsoft Windows. Il software Cryopilot permette agli utenti di eseguire
con flessibilita le operazioni di congelamento e scongelamento.

[l diagramma sottostante mostra le relazioni tra i componenti del sistema. Le
interfacce software Cryopilot sono collegate mediante USB al refrigeratore
Cryopilot A e all’agitatore Cryomixer Jr,, nonché fino ad un numero di 16
termocoppie mediante un dispositivo di acquisizione dati National

Instruments.

USB to Cryomixer Jr. Cable

Computer
usBe usB usB
Iy A
USB to Unistat Cable
USB Cable FTH-DA0D000-0062 FTH-DA00000-0061
A4 | J Y
National

Instruments Cryopilot A Cryomixer Jr.
USB-9213

A

16x Type T Thermocouple Cable
FTH-DAQ0000-0065

Cryowedge or §*

Fig.13: Sistema Cryopilot

5.2 Requisiti minimi del sistema

Il software Cryopilot & installato in fabbrica sui computer ordinati presso

Sartorius come parte di un sistema benchtop. Altrimenti € disponibile su

USB Flash Drive per i sistemi che soddisfano i seguenti requisiti:

— Sistema operativo: Microsoft Windows 7 Professional, 32 bit con Service
Pack 1o Microsoft Windows 10 Professional, 64 bit.

— Dispositivo di acquisizione dati: National Instruments USB-9213.

[l software Cryopilot & dotato di un programma di installazione che installa
automaticamente il software Cryopilot e tuttii driver di terzi necessari sul
vostro computer. Per installare Cryopilot & necessario avere diritti di

amministratore.
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53 Componenti

Il software Cryopilot & installato di default in C:\Program Files\Sartorius
Stedim Biotech\Cryopilot 5 per uno sistema operativo di 32-bit e in C:\
Program Files (x86)\Sartorius Stedim Biotech\Cryopilot 5 per uno sistema
operativo di 64-bit.,che sara denominato in seguito directory di
installazione. Nella tabella sottostante sono descritti i file e le cartelle
contenuti nella directory di installazione:

Componente Descrizione

Profiles/ Directory per file dei profili standard
forniti con Cryopilot

BouncyCastle.Crypto.dll Biblioteca di supporto

Cryopilot .chm

File di aiuto

Cryopilot .exe

File eseguibile per il software
Cryopilot. Collegamenti (shortcuts)
per questo file si trovano sul desktop
e nel menudiavvio

Cryopilot .exe.config

File di configurazione

ICSharpCode.SharpZipLib.dll Biblioteca di supporto
libftdi.dll Biblioteca di supporto
log4net.dll Biblioteca di supporto

Nationallnstruments.Common.dll

Biblioteca di supporto

Add Nationallnstruments.
NiLmClientDLL.dII

Biblioteca di supporto

Add Nationallnstruments.
MStudioCLM.dII

Biblioteca di supporto

Nationallnstruments.DAQmx.dll

Biblioteca di supporto

NPlot.dll

Biblioteca di supporto

uninsO00.dat

File di aiuto del programma di
disinstallazione

uninsO00.exe

Programma di disinstallazione

Oltre ai file nella directory di installazione, il programma di installazione
Cryopilot crea una cartella chiamata “Cryopilot” nella cartella “My
Documents” di ciascun utente. Questa cartella sara denominata in seguito
“directory utente”. Nella tabella sottostante sono descritti i file e le cartelle

contenuti della directory utente:

Componente  Descrizione

Data/ Directory di default per i file di dati salvati dagli utenti.
Gli utenti possono scegliere di salvare i file in un‘altra
posizione sul computer o su un‘unita di rete.

Custom Directory di default per profili personalizzati salvati dagli
Profiles/ utenti. Gli utenti possono scegliere di salvare i file in
un’altra posizione sul computer o su un‘unita di rete.
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| file che sono soggetti a modifiche ma che sono comuni a tutti gli utenti
sono salvati in C:\ProgramData\Sartorius Stedim Biotech\Cryopilot 5.

Componente Descrizione
log.txt File usato per la risoluzione degli errori del software
settings.xml File di configurazione

[l programma di installazione Cryopilot installa inoltre diverse biblioteche
aggiuntive: Microsoft NET Framework 4.6.1, National Instruments
NI-DAQmx e driver USB.

5.4 Installazione

Per installare il software Cryopilot, inserire il USB Flash Drive e cliccare due
volte sul file mysetup.exe. Per il setup € necessario avere i diritti di
amministratore. Contattare il proprio amministratore di sistema se non
avete i diritti richiesti.

Le impostazioni di default sono in genere perfettamente adeguate.

Una volta terminato il setup, vi sara richiesto di riavviare il computer.

NOTA
E importante che il computer venga configurato in modo che non si arresti o
non si spenga durante un processo di congelamento | scongelamento.

Per Windows 7 o Windows 10, accedere a Pannello di controllo > Sistema e
sicurezza > Opzioni risparmio energia. Selezionare “Prestazioni elevate”.
Cliccare su “Modifica impostazioni combinazione”, poi su “Cambia imposta-
zioni avanzate risparmio energia”. Impostare “Disco rigido > Disattiva disco
rigido dopo” su O (mai). Impostare “Impostazioni USB > Impostazione
sospensione selettiva USB” su “Disabilitata”. Cliccare su “OK” e chiudere la
finestra Pannello di controllo.
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55

5.51

Interfaccia

utente

Finestra principale

La finestra principale € la schermata primaria usata nel software Cryopilot.
Questa finestra contiene le voci di menu per interagire con il programma, un
grafico per visualizzare graficamente i dati di processo e una legenda per
selezionare le tracce da visualizzare sul grafico.

1 —=HCryoPilot - N:\CryoPilot\Data\2009-03-03-13-48-43.cpd 9w X
2 ——File  Edt Process Tools Help
3 wadlg Rl e el
Temperature vs. Elapsed Time 0:23:59 = 6
e T T T T = |
HTF Setpoint
24 - — 7
0.0
2t x] |
HTF Supply
20 = — 8
P ] 1.3 < |
4 - Product 1 9
||
1 i 22.8 «
v || product 2.
S [i0.255,13.36)]
Bl ] 24.8 «
2
sl - || Product 3
5 5 ——— o
ab - || product 4
il 4
[
o Product 5
2k ]
—
4 1 I | I 1 L I
0.08 o1 o4 0z 25 0z 035 Product &
Elapsed time, h -
5 Tjon\lne

Fig.14: Finestra principale

Pos. Controllo Descrizione
1 Barra del titolo Visualizza il nome dell’applicazione e il nome
del file di dati attuale, se disponibile
Barra dei menu Contiene i menu per eseguire attivita comuni
Barra degli Contiene i pulsanti per eseguire attivita
strumenti comuni
4 Grafico Visualizza un tracciato della temperatura in
relazione al tempo trascorso
5 Barra di stato Mostra lo stato degli apparecchi sia online
che offline
6 Indicatore del Mostra il tempo trascorso a partire dall’avvio
tempo trascorso del processo
7 Elemento legenda Visualizza il valore nominale del fluido di
“HTF Setpoint” scambio termico (HTF)
8 Elemento legenda Visualizza la temperatura reale del fluido di
“HTF Supply” scambio termico
9 Elemento legenda Visualizza la temperatura della termocoppia

“Product N”

ditipo T. A seconda dell’hardware & possibile
monitorare fino a 16 termocoppie

Manuale d'uso Celsius® S* Benchtop System




Software Cryopilot

5.5.2 Finestra di dialogo “Start Process”

La finestra di dialogo “Start Process” richiede all’'utente di inserire le
informazioni che saranno usate nel corso del processo.

Start Process
General
1 ——— Chart title: Temperature vs, Elapsed Time
2 ——— Datafilename: | N:\CryoPilot\Data|2009-03-03-14-52-52.cpd lead —or ¢
3 ——— Use profile: ) None
(®) Standard
Application: |53 30mL v|——— 7
Process: Freeze .v!—— 8
() Custom
4 v 2
5 =y Description: 10 Celsius-Paks 30ml containing buffer, used For
profile development
o J[ concel |

1 10

Fig.15: Finestra di dialogo “Start Process”

Pos. Controllo Descrizione

1 Chart title [l titolo mostrato in cima al grafico. Il titolo di
default € “Temperature vs. Elapsed Time”
(Temperatura in funzione del tempo trascorso)

2 Data filename [ nome completo del file in cui vengono salvatii
dati per questo processo. | nome di default &
[User Directory]\Data\[date code].cpd, dove
[date code] & una stringa numerica costituita da
anno, mese, giorno, ora, minuto e secondo.

3 Selettore “Profile  Offre tre opzioni: “None” per nessun profilo;
type” “Standard” per un profilo standard fornito da
Sartorius, “Custom” per un profilo fornito
dall’'utente.
4 Profile filename [ nome completo del file in cui si trova il profilo

definito dall’'utente

5 Description Un campo per inserire informazioni aggiuntive
relative al processo.
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Pos. Controllo

Descrizione

6 Selettore “Data
filename”

Apre una finestra di dialogo per selezionare una
cartella e un nome di file in cui vengono salvati
i dati per questo processo.

7 Selettore
“Application”

Offre sei opzioni se & stato selezionato il tipo di

profilo “Standard™:

— $*30mL - ersistemi S con dieci Celsius® Pak
da 30 mL Celsius® Paks

— $*100mL - per sistemi S* con dieci
Celsius®- Pak da 100 mL

— Cryowedge 12"

— Cryowedge 24"

— Cryowedge 30"

— Cryowedge 34"

8 Selettore
“Process”

Offre tre opzioni se e stato selezionato il tipo di

profilo “Standard™:

— Freeze - esegue solo I'operazione di
congelamento

— Thaw - esegue solo 'operazione di
scongelamento

— Freeze and Thaw - esegue l'operazione di
congelamento seguita dall'operazione di
scongelamento

9 Selettore “Profile
filename”

Apre una finestra di dialogo per selezionare una
cartella e un nome di file in cui si trova il profilo
definito dall’'utente.

10 Pulsante “Cancel

”

Ignora le informazioni e chiude la finestra di
dialogo senza avviare il processo.

" Pulsante “OK”

Accetta le informazioni, chiude la finestra di
dialogo e avvia il processo.
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5.5.3 Finestra di dialogo “Options”

[l software Cryopilot pud essere configurato usando la finestra di dialogo
“Cryopilot Configuration”. Selezionare nella finestra principale la voce di
menu “Tools > Options”.

7
M‘

Certificates IHardWarB |

Digital certificates are used to ensure the authenticity and inkegrity of CryoPilot data
files, Yaou may obtain a digital certificate by clicking the Create button below or by

contacking waur swstem administratar,

Select a digital certificate to use when saving data files:

| Issued b

| Issued to

| Friendly name

SARTORIU-754...

Create

SARTORIU-7E4...

Wienw

| Expiration date |

CryoPilok

Manage

Cancel |

2 3

grcl
|
5

4

Fig.16: Finestra di dialogo “Options” - Scheda “Certificates”

Pos. Controllo Descrizione
1 Elenco dei Visualizza un elenco dei certificati digitali
certificati disponibili. Per ciascun certificato nell’elenco &
indicato chi ha emesso il certificato, per chi e stato
emesso, il nome descrittivo e la data di scadenza.
2 Pulsante Crea un nuovo certificato autofirmato e lo installa
“Create” nella cartella “Trusted Root Certification
Authorities”.
3 Pulsante “View”  Visualizza ulteriori dettagli del certificato
selezionato.
4 Pulsante Apre la Microsoft Management Console per
“Manage” ulteriori attivita di gestione dei certificati, comeiil
rinnovo e I'eliminazione del certificati.
Pulsante “OK” Accetta le modifiche e chiude la finestra di dialogo.
Pulsante Elimina le modifiche e chiude la finestra di dialogo.
“Cancel”
7 Scheda Visualizza la scheda dell’hardware.
“Hardware”
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7

Data Acquisition

Certificates | Hardware |

A data acquisition device is used to read temperature sensors. Select an
available device from the list below or select None to disable data acquisition:

1 Device: |UsB-9213 (Dev1) v
Chiller
A chiller is used to control the temperature of the heat transfer fluid (HTF).
Select a device from the list below:
2 Type: ’ Huber Unistat %
3 Port: [coms |v
Shaker

A shaker is used to agitate product during thaw. Select a device from the
list below or select None to disable shaking.

4 Device: ‘USBCryoMixsr Jr. Interface .V.J

2

][ Cancel ]

Fig.17: Finestra di dialogo “Options” - Scheda “Hardware”

Pos. Controllo

Descrizione

1 Selettore
“Data
acquisition
device”

L'opzione “None” configura l'applicazione per

“No data acquisition” (Nessuna acquisizione dati).
Se viene rilevato un dispositivo di acquisizione dati
National Instruments compatibile, esso viene
selezionato automaticamente.

2 Selettore
“Chiller”

Selezionando l'opzione “None” si configura I'appli-
cazione per “No chiller” (Nessun refrigeratore).
Selezionando I'opzione “Huber Unistat” si confi-
gura l'applicazione per acquisire i dati da un refri-
geratore Huber dotato di un controller Unistat,
come un Cryopilot A.

3 Selettore
“COM port”

Mostra un elenco delle porte seriali (COM)
disponibili.

4 Selettore
“Shaker”

L'opzione “None” configura l'applicazione per
“No shaker” (Nessun agitatore). Se viene rilevato
un cavo USB verso Cryomixer Jr., esso viene
selezionato automaticamente.

Pulsante “OK”

Accetta le modifiche e chiude la finestra di dialogo.

Elimina le modifiche e chiude la finestra di dialogo.

6 Pulsante
“Cancel”
7 Scheda

“Certificates”

Visualizza la scheda dei certificati.
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5.6 Attivitainiziali
Prima di poter avviare un profilo, si deve configurare il software. Verificare
che il dispositivo di acquisizione dati (DAQ) e il refrigeratore siano connessi

e accesi. Poi selezionare la voce di menu “Tools > Options” per visualizzare la
finestra di dialogo “Options”.

5.6.1 Selezione di un certificato digitale

Per prima cosa si deve selezionare un certificato digitale. Cryopilot usa un
certificato digitale per garantire I'autenticita e l'integrita dei file di dati
salvati. La scheda dei certificati mostra un elenco dei certificati disponibili. Si
consiglia di usare un certificato emesso da una Autorita Certificativa (CA) di
fiducia. Se il vostro servizio informatico ha gia creato un’infrastruttura di
certificati digitali, puo quindi fornire un certificato da usare con il Cryopilot.

Nel caso in cui non siate in possesso di un certificato da usare con il
Cryopilot, potete creare un cosiddetto certificato autofirmato.
“Autofirmato” significa che la persona che crea il certificato ne garantisce
anche la legittimita. Cliccare sul pulsante “Create” e poi nella finestra di
dialogo che appare cliccare sul pulsante “Yes”. Il nuovo certificato creato
apparira nell’'elenco dei certificati disponibili.

5.6.2 Configurazione dell’hardware

Sideve poi selezionare I'hardware. La scheda “Hardware” contiene le
impostazioni per le configurazioni hardware comuni. La combinazione piu
comune e costituita da un dispositivo di acquisizione dati (DAQ), un
refrigeratore e un agitatore. Nella maggioranza dei casi I'hardware viene
riconosciuto automaticamente.

Se non s‘intende eseguire alcun processo e si vuole usare il Cryopilot solo
per la revisione dei file di dati, selezionare in tal caso “None” per tutti i campi
“Data Acquisition”, “Chiller” e “Shaker”.

Cliccare su “OK” per salvare le opzioni.

5.6.3 Flussodel programma

Dopo I'avvio del software Cryopilot appare brevemente la schermata iniziale
e poiviene visualizzata la finestra principale.

A questo punto il software € inattivo e rimane in questo stato fino a quando
un utente non avvia un processo.

Per avviare un processo, selezionare la voce “Process > Start” o cliccare sul
pulsante “Start Process” nella barra degli strumenti. Apparira la finestra di
dialogo “Start Process”. Dopo che l'utente ha cliccato su “OK?, il software
cerca diinstaurare una connessione con il dispositivo di acquisizione dati,
I'agitatore e il refrigeratore, se sono configurati. Se uno di questi apparecchi
e configurato ma non ancora collegato, all’'utente verra chiesto di
controllare le connessioni e di eseguire di nuovo 'operazione o di annullarla.

Una volta che un processo e stato avviato, il grafico della temperatura e la
legenda vengono riconfigurati allo scopo di visualizzare i tracciati
corrispondenti, le comunicazioni con il refrigeratore vengono instaurate e il
dispositivo di acquisizione dati (DAQ) viene inizializzato. Terminata
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I'inizializzazione, scompare il messaggio di inizializzazione e viene tracciato il
primo gruppo di punti dati. | punti dati successivi sono visualizzati in
funzione dell'intervallo di campionamento che & fissato a 15 secondi.

Se é stato configurato per l'uso di un refrigeratore, il software Cryopilot
utilizza un link seriale per inviare comandi e ricevere risposte al e dal
refrigeratore.

Durante il processo lo stato della connessione & mostrato nell’angolo in
basso a sinistra della finestra principale. Un messaggio verde “Online” indica
che la connessione con il dispositivo di acquisizione dati e il refrigeratore &
corretta. Un messaggio rosso “Offline” indica che c’@ un problema di
connessione.

Con il pulsante “Stop Process” si puo interrompere l'acquisizione dei dati e
spegnere il refrigeratore e il miscelatore. In seguito I'utente pud revisionare i
dati. Prima di poter avviare un altro processo, I'utente deve chiudere il file di
dati.

5.6.4 Revisione dei dati

Cryopilot pud aprire e visualizzare i file salvati in Cryopilot 4 e Cryopilot 5.
Considerare che i file creati da Cryopilot 4 sono supportati solo per scopi di
revisione. Tutti i nuovi file di dati sono salvati nel formato Cryopilot 5 in
modo che l'integrita e I'autenticita dei dati possa essere verificata mediante
firma digitale.

Si puo aprire solo un file di dati alla volta.

Per aprire un file di dati procedere come segue:

p Cliccare sul pulsante “Open” nella barra degli strumenti
P Aprire il menu “File” e cliccare su “Open”

P Usare la combinazione di tasti Ctrl+O

Usare la finestra di dialogo “Open Data File” per selezionare il file che si
desidera aprire. Accertarsi di selezionare il tipo di file nell’elenco a discesa
“Files of type”.

Cryopilot 5 usa firme digitali per comprovare che i dati non sono stati
modificati dal momento in cui sono stati salvati. Se I'integrita e I'autenticita
del file di dati non possono essere verificate mediante una firma digitale,
appare un messaggio che richiede di continuare o annullare 'operazione.
Cisono due casi in cui compare questo messaggio:

— Quando si apre un file di dati Cryopilot 4. | file Cryopilot 4 non
contengono una firma digitale.
— Se il certificato usato per firmare il file di dati non ¢ affidabile.

Una volta che il file di dati & caricato, il grafico viene popolato con i dati del
file ed e possibile analizzare i dati come se provenissero da un processo
realmente in corso.

Cliccando sul grafico con il tasto destro del mouse e cliccando sulla voce
“Review”, si puo scorrere a destra e a sinistra del grafico per verificare i valori
di ciascun tracciato in un determinato momento. Quando si scorre la linea di
revisione a destra o a sinistra, la legenda viene aggiornata per mostrare
I'indicatore temporale e i valori del tracciato per quel momento specifico.
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5.6.5 Utilizzo del grafico

[l grafico permette di rappresentare la temperatura di un ciclo in relazione al
tempo trascorso. Il tempo trascorso & visualizzato in ore sull'asse X e la
temperatura ¢ visualizzata in gradi Celsius sull’asse Y. E disponibile una
legenda per identificare e mostrare il valore corrente per ciascun tracciato.

Panoramica e zoom

Perimpostazione predefinita, le scale del grafico vengono adattate
automaticamente ai dati disponibili. Questa funzione di messa in scala
automatica pud essere attivata o disattivata usando le opzioni “Auto Scale
X" e “Autoscale Y” nel menu pop-up che appare cliccando sul grafico con il
tasto destro del mouse.

La dimensione della scala puo essere modificata direttamente trascinando
gliassi X e Y. Per fare una panoramica del grafico, trascinare il grafico
tenendo premuto il tasto sinistro del mouse. Quando si modifica la scala o si
fa una panoramica del grafico, la funzione “Auto Scale” viene disattivata.
Cliccare due volte sul grafico per riattivare la funzione “Auto Scale”.

Legenda

La legenda identifica ogni tracciato presente sul grafico. Ciascun tracciato
ha una propria legenda indicante il nome, il colore, le unita e il valore cor-
rente. Per nascondere un tracciato, cliccare due volte sulla sua legenda; essa
sara visualizzata in grigio. Per mostrare un tracciato, ricliccare due volte sulla
sua legenda. Cio puo essere utile quando si analizzano file di dati con molti
tracciati che si sovrappongono.

Modo “Review”

[ modo “Review” permette all’'utente di revisionare i dati in ogni momento
durante il processo. Questo modo viene attivato e disattivato usando il
menu pop-up mostrato nella figura 18. Quando si € nel modo “Review”, una
linea verticale € visualizzata sul grafico e le voci tempo trascorso e legenda
visualizzano i valori che corrispondono a questa posizione sul grafico.

5.6.6 Esportazione dei dati

Cryopilot offre due metodi differenti per esportare i dati. Si pud esportare
un‘immagine della rappresentazione attuale del grafico o si puo esportare i
dati grezzi per visualizzarli in un‘applicazione foglio di calcolo.

Esportazione del grafico

Per esportare il grafico, selezionare la voce di menu “Edit > Copy > Chart”. Il
grafico viene copiato come immagine bitmap negli Appunti di Windows. ||
grafico pud essere incollato in altre applicazioni selezionando “Edit>Paste” o
premendo i tasti Ctrl+V. Questa opzione & utile quando si ha bisogno di
un’istantanea rapida dei dati, per esempio in una presentazione con slide.
Usare I'opzione “Copy>Data” se i dati devono essere analizzati
ulteriormente.
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Esportazione dei dati

Per esportare dati, selezionare la voce di menu “Edit > Copy > Data”. | dati
grezzi vengono copiati in un formato delimitato da tabulazione negli
Appunti di Windows. | dati possono essere incollati in applicazioni foglio di
calcolo come Microsoft Excel o OpenOffice Calc selezionando la cella di
destinazione e selezionando “Edit>Paste” o premendo i tasti Ctrl+V.

5.6.7 Stampa

Cryopilot puo creare un report per il file di dati aperto. Il report € un’istanta-
nea (snapshot) della rappresentazione attuale del grafico comprensivo di
titolo e legenda. Il report pud essere visualizzato come anteprima o inviato
ad una stampante. Se sul computer € installato un driver di stampante PDF
come Adobe Acrobat, si puo salvare il report come File PDF sul disco rigido.

Per stampare un report procedere come segue:

P Cliccare sul pulsante “Print” nella barra degli strumenti
P Aprire il menu “File” e cliccare su “Print”

P Usare la combinazione di tasti Ctrl+P

Appare la finestra di dialogo “Print” che richiede di selezionare la stampante
di destinazione e il numero di copie. Altre impostazioni come i margini e il
formato della carta possono essere configurate in “Page Setup”. Cliccare su
“OK” perinviare il report alla stampante selezionata.

5.6.8 Profili

Il software Cryopilot controlla il refrigeratore e il miscelatore seguendo un
profilo. Un profilo € una ricetta contente istruzioni per modificare il valore
nominale della temperatura del refrigeratore e il valore nominale del modo
del miscelatore (on|off) come una funzione del tempo. Il software Cryopilot
viene fornito con un set di profili standard che sono adatti per molte
applicazioni con il modulo S* e il Cryowedge.

Potrebbe essere necessario creare un nuovo profilo per rispondere ad
un‘applicazione specifica. Durante la creazione di un nuovo profilo ci sono
diversi fattori da considerare:

— Quali operazioni si devono eseguire - congelamento, scongelamento o
entrambe?

— Sono richiesti cicli di congelamento e scongelamento multipli?

— Qual e la temperatura iniziale del materiale da congelare o scongelare?
Se questa & variabile, una fase di equilibratura all’avvio del profilo pud
migliorare la riproducibilita.

— Gliapparecchi devono rimanere in funzione o venire spenti al termine
dell'operazione di congelamento o scongelamento?

La regolazione dei tassi di congelamento e scongelamento viene eseguita
empiricamente. Se si desidera avere un punto finale piu basso per
un‘operazione di congelamento, potrebbe essere necessario aumentare la
durata del valore nominale finale o ridurre la temperatura impostata. Se si
vuole scongelare velocemente senza superamento della temperatura target
(overshoot), usare per una breve durata un valore nominale di temperatura
piu alto e poi abbassarlo prima che la temperatura target venga superata.
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File Edit Format View Help

START
0.00

140.00
150.00
160.00
180.00
200. 00
STOP

4

ntegrated Biosystems Scale Down Temperature profile i

The first column is the time (in minutes),
the second column is the temperature (in degrees C),
and the third column is the mixer state

-50 OFF
=25 OFF
-25 OFF
=35 OFF
-45 OFF
-55 OFF

Fig.19:

Un profilo in Microsoft Notepad
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Modifica di un profilo

| profili possono essere creati e modificati manualmente con editor di testo
(per es. Microsoft Notepad) o programmi foglio di calcolo (per es. Microsoft
Excel). Quando si usa un editor di testo, utilizzare sempre un tasto TAB per
separare le colonne; non usare la barra spaziatrice. Per una nuova riga, usare
il tasto Ritorno o Invio dopo aver inserito lo stato del miscelatore.

Se si usa un profilo standard come punto di partenza, accertarsi di salvarlo
con un nuovo nome di file e poi effettuare le modifiche.

Comportamento dell’'ultima fase

Perimpostazione predefinita, una volta che il software Cryopilot esegue
I'ultima fase di un profilo, esso lascia il refrigeratore e il miscelatore nello
stato in cui si trovano fino a quando l'utente non arresta il profilo premendo
il pulsante “STOP”. In alcuni casi € utile spegnere il refrigeratore e il
miscelatore dopo un certo tempo. Cio si stabilisce impostando un’istruzione
“TURN CHILLER OFF” dopo l'istruzione “STOP”. Osservare che cid non &
possibile usando I'editor di profili Cryopilot, ma deve essere fatto
manualmente con un editor di testo o unapplicazione foglio di calcolo. Per
esempio, il profilo seguente spegnera il refrigeratore e il miscelatore dopo
311 minuti:

0 -40  OFF
31000 -60  OFF
STOP

311.00 TURN CHILLER OFF

Listruzione “TURN CHILLER OFF” sara visibile nell’editor di profili
Cryopilot, ma a questa non sara associata alcuna temperatura.

Formato dei file

| profili sono salvati sul disco rigido come file di dati delimitati da
tabulazione. La codifica caratteri ¢ ASCII e il formato del file non fa
distinzione tra maiuscole e minuscole. Tutte le righe che si trovano prima del
token “START” sono una descrizione del file. Cio significa che la descrizione
non puo contenere la parola “start”. Tra il token “START” e il token opzionale
“STOP”, ogniriga rappresenta una fase nel profilo. Il tempo di avvio segnala
quando la fase dovrebbe iniziare; esso & indicato in minuti trascorsi ed &
espresso con notazione decimale. Il tempo di avvio della prima fase deve
essere O e i tempi di avvio per le fasi successive devono aumentare in
maniera monotona. Notare che il tempo di avvio per ciascuna fase si
riferisce al tempo di avvio del profilo. Pertanto tre fasi di 30 minuti avranno
deitempidiavvio di 0, 30 e 60.

[l valore nominale del refrigeratore & indicato in gradi Celsius ed & espresso
con notazione decimale.

Se é presente un token “STOP”, la riga successiva puo essere un token
“TURN CHILLER OFF”.
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La seguente sintassi viene usata per descrivere il formato del file:

\n Carattere di una nuova riga, qui definito come CRLF
\s Zero o piu caratteri di spazio

\t Carattere di tabulazione

<variable> Elemento variabile

[FOO] Elemento opzionale

OFF|ON  Valore enumerato, I'elemento deve essere I'uno o l'altro
Indica la struttura che siripete

Formato:

[<description>\n]

START\s\n

<start time>\t<chiller setpoint>\t<mixer = OFF|ON>\n

[STOP\n
[<start time>\tTURN CHILLER OFF]]

Esempio (implicito \n):
Questo € un profilo di prova con tre fasi.

START
0 -20 OFF
30 -60 ON

200 10 OFF

5.6.9 Filedidati

Durante un ciclo, il software Cryopilot monitora i componenti del sistema
benchtop e registra i valori chiave del processo in un file di dati sul
computer.

Il software Cryopilot 5 pu0 aprire sia i file di dati creati da Cryopilot 4 sia i file
creati da Cryopilot 5. Tuttavia, tutti i nuovi file di dati salvati da Cryopilot 5
saranno salvati nel formato Cryopilot 5. Questo file di dati contiene i
seguenti valori di processo:

— llvalore nominale della temperatura del fluido di scambio termico del
refrigeratore e la temperatura reale del fluido di scambio termico

— Valore nominale del modo del refrigeratore (On|Off)

— Valore nominale del modo del miscelatore (On|Off)

— Temperatura misurata da fino a 14 termocoppie di tipo T

Perimpostazione predefinita, i file di dati Cryopilot 5 hanno I'estensione
.cpd. Un file di dati Cryopilot € un file ZIP contenente due file:

— data.txt, che & un file di dati delimitato da tabulazione

— data.txt.p7s, che & una firma digitale nel formato PCKS#7

| programmi foglio di calcolo come Microsoft Excel possono importare i file
di dati delimitati da tabulazione, tuttavia & piu facile trasferire i dati usando
la voce di menu “File > Copy > Data”. Non tentare di aprire il file di dati per
un ciclo in corso, poiché I'applicazione foglio di calcolo pud bloccare il file
perimpedire che il software Cryopilot scriva dati aggiuntivi nel file.
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Formato del file

[l file data.txt e i risultati del comando “File > Copy > Data” contengono
entrambi un testo delimitato da tabulazione. La codifica caratteri € ASClII e il
formato del file non fa distinzione tra maiuscole e minuscole. La prima riga
deve contenere 'autore e la versione come specificato sotto. Tutti i valori
della temperatura sono indicatiin °C.

La seguente sintassi viene usata per descrivere il formato del file:

\n Carattere di una nuova riga, qui definito come CRLF
\s Zero o piu caratteri di spazio
\t Carattere di tabulazione

<variable> Elemento variabile

[FOQ] Elemento opzionale

OFF|ON Valore enumerato, I'elemento deve essere I'uno o l'altro
Indica la struttura che siripete

Osservare che gli orari specificati sono espressi come tempo coordinato
universale (UTC); pertanto questi possono differire dall’ora locale che
dipende dal vostro fuso orario.

Se non ci sono dati disponibili, il file contiene il simbolo “NaN”
(Not a Number).

Formato:

Cryopilot 5.0\n

METADATA\n

Title\t<title>\n

Process Start\t<timestamp format=yyyy-MM-dd HH:mm:ssZ>\n
Computer\t<computer name>\n

User\t<user name>\n

Description\t<description>\n

START\n

Date/Time(UTC)\tElapsed Time(h)\tChiller Status\tHTF Supply
Temperature Setpoint(C)\tHTF Supply Temperature(C)\tMixer Status\
tProduct Temperature 1(C)\tProduct Temperature 2(C)\t...Product
Temperature n(C)\n

<timestamp format=yyyy-MM-dd HH:mm:ssZ>\t<elapsedhours
format=0.000000x>\t<chiller = Off|On|Unknown>\t<value format=0.0>\
t<value format=0.0>\t<mixer = Off|On|Unknown>\t<value format= 0.0>\
t<value format= 0.0>\t...<value format=0.0>\n

Manuale d’'uso Celsius® S* Benchtop System 173



Software Cryopilot

Esempio per quattro termocoppie (implicito \n):

Cryopilot 5.0

METADATA

Titolo Temperatura in funzione del tempo trascorso

Avvio processo 2009-03-03 21:49:227

Computer DEMO_LAPTOP

Utente DEMO_LAPTOP\Administrator

Descrizione

AVVIO

Data/Ora(UTC) Tempo trascorso(ore) Stato refrigeratore Valore nominale

temperatura di alimentazione fluido di scambio termico(C)
alimentazione fluido di scambio termico(C) Stato miscelatore Temperatura(C)

prodotto 1 Temperatura(C) prodotto 2

Temperatura(C) prodotto 4

2009-03-03 21:49:31Z 0.002500 On
2009-03-03 21:49:46Z 0.006667  On
2009-03-03 21:50:01Z 0.010833 On
2009-03-03 21:50:16Z 0.015000  On

0.0
0.0
0.0
0.0

21.0 On
20.7 On
20.3 On
20.0 On
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5.610 Diagnostica|Risoluzione degli errori

| messaggi di errore e di stato sono visualizzati nell’area dei messaggi
nell'angolo in basso a destra della finestra principale. Questa sezione
descrive gli errori comuni e i possibili rimedi.

Refrigeratore

Se si verificano dei problemi con il refrigeratore, possono essere utili le

seguenti soluzioni:

P Controllare le due estremita del cavo tra il computer e il refrigeratore.

» Verificare il registro errori del refrigeratore. Per maggiori informazioni si
rimanda al manuale d'uso Huber Unistat 705.

P Verificare che le impostazioni di comunicazione del refrigeratore siano
configurate correttamente. Il Cryopilot A dovrebbe essere configurato
per usare una velocita di trasmissione (baud rate) 9600 e il protocollo
RS232. Per maggiori informazioni si rimanda al manuale d’'uso Huber
Unistat 705.

» Come ultimo rimedio, chiudere il software Cryopilot, spegnere e
riaccendere il refrigeratore e riavviare il software Cryopilot. Cercare di
determinare la causa del problema prima di avviare un altro ciclo.
Assicurarsi che tutte le impostazioni nella finestra di dialogo “Options”
siano corrette.

Se durante un ciclo vi € un’interruzione di corrente elettrica, il refrigeratore
potrebbe scollegarsi dall’alimentazione elettrica o i dati provenienti dal
refrigeratore potrebbero danneggiarsi. La presenza di NaN (not a number)
nei campi della temperatura del file di dati € un’ulteriore indicazione che c’e
un errore a livello del refrigeratore.

Agitatore

Se 'agitatore non si muove quando dovrebbe, possono essere utili le

seguenti soluzioni:

» Controllareil cavo tra il computer e I'agitatore.

» Verificare che il commutatore dei modi posto sul retro del miscelatore sia
nella posizione “Auto”.

P Verificare che I'impostazione della velocita sia corretta.
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Dispositivo di acquisizione dati

Qui di seguito sono elencati i comuni errori relativi all’hardware di

acquisizione dati o alle termocoppie:

— Un sensore non risponde alle modifiche della temperatura come gli altri
sensori.

Se siverifica questo problema, possono essere utili le seguenti soluzioni:

P Verificare che il sensore in questione sia collegato alla presa corretta del
cavo breakout della termocoppia che & connesso al dispositivo di
acquisizione dati.

P Accertarsi che ogni sensore sia posizionato e fissato correttamente. Un
piccolo errore di posizione puod comportare grandi scostamenti rispetto
agli altri sensori.

» Controllare le connessioni tra il computer e il dispositivo di acquisizione
dati.

P Un sensore potrebbe essere danneggiato. Controllare il sensore con uno
strumento di misurazione calibrato (per es. Fluke 725) capace di misurare
le termocoppie ditipo T.

5611 CFRPart!

Il software Cryopilot 5 & stato sviluppato per facilitare la conformita ai
requisiti 21 CFR Part 11.

Le firme digitali sono usate per provare l'autenticita e I'integrita dei file di
dati Cryopilot 5, persino su sistemi aperti (cioe inaffidabili “untrusted”).

[l termine “firma digitale” non va confuso con il termine “firma elettronica”.
Una firma digitale € un metodo crittografico, mentre una firma elettronica &
I'equivalente elettronico di una firma autografa con implicazioni legali. |
riferimenti alle firme elettroniche in 21 CFR Part 11 non si applicano alle firme
digitali usate nei file di dati Cryopilot 5.

Alcune indicazioni generali riguardanti I'implementazione:

— Cryopilot 5 si basa sul sistema operativo per le funzioni di gestione degli
account, autentificazione e autorizzazione.

— L'algoritmo di firma digitale utilizzato da Cryopilot 5 € SHA-1 con RSA;
esso e scritto nel formato PKCS#7.

— Il sistema difile & considerato come un sistema inaffidabile.

— Seun processo viene arrestato, il file di dati viene chiuso e non & piu
apribile per eseguire delle modifiche. Qualsiasi modifica dei dati con altri
mezzi, sia accidentale che intenzionale, sara rilevata dal meccanismo di
firma digitale.

— Seidativengono esportati da Cryopilot (per es. in un foglio di calcolo),
la loro autenticita e integrita non possono piu essere garantite.
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6 Funzionamento del sistema

6.1  Preparazione diun ciclo

611  Cryowedge

Per preparare il Cryowedge per I'utilizzo:

P Togliere la meta superiore della copertura coibentata di Cryowedge.

P Togliere i dadi ad alette che fissano la copertura trasparente e metterli
da parte.

p Togliere la copertura trasparente.

» Riempire il Cryowedge con una soluzione di prova usando un cilindro |
volumi standard per ciascuna misura di Cryowedge sono i seguenti:

Misura Cryowedge Volume (mL)
CW20 (127 350

CW125 (207) 650
CW300 (30 3000
CW300 (34") 4000

» Rimettere la copertura trasparente.

p Rimettere i dadi ad alette e serrarlia mano. Non stringere
eccessivamente o non rovinare le filettature.

P Rimettere la meta superiore della copertura coibentata di Cryowedge.

» Verificare che il cavo di Cryomixer Jr. sia collegato al Cryomixer Jr. e al
computer.

P Verificare che almeno sei termocoppie siano collegate al dispositivo di
acquisizione dati, partendo dalla posizione 1.

P Inserire cinque termocoppie attraverso i fori predisposti nella copertura
trasparente. Fissare le termocoppie sotto la superficie della soluzione di
prova usando distanziatori di plastica o pezzi di tubo di silicone.

P Mettere la termocoppia restante sopra la copertura trasparente per
essere usata come temperatura di riferimento sulla superficie esterna di
Cryowedge.

P Annotare il numero e la posizione di ogni termocoppia per riferimento
futuro.

612 Modulo $?

| Celsius® Pak sono forniti presterilizzati con raggi gamma. Essi sono dotati
diraccordi Luer femmina e di tappi sui 2 raccordi di riempimento | scarico.
E disponibile anche una versione con tubi di prolunga C-Flex® per il
riempimento sterile. Tutti i Celsius® Pak dispongono di un pozzetto
termometrico chiuso in silicone/EVA per I'inserimento di una sonda
termocoppia.

Per ottenere risultati coerenti, equipaggiare il modulo S* sempre con

lo stesso numero di Celsius® Pak. Assicurarsi che ciascun Celsius® Pak sia
riempito con lo stesso volume. La termocoppia dovrebbe essere messa ogni
volta alla stessa profondita.
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SRR

Fig.20: Supporto della termocoppia fissato al
Celsius® Pak

| profili di congelamento standard forniti con il software Cryopilot sono
concepiti per 10 Celsius® Pak, sia da 30 o da 100 mL, riempiti fino al volume
nominale. Mettere le termocoppie ad almeno 1 cm di profondita sotto la
superficie del liquido di Celsius® Pak. | Celsius® Pak vuoti dovrebbero essere
riempiti con soluzione tampone. Non usare acqua deionizzata per i

Celsius® Pak vuoti, poiché questa si sottoraffredda. Se si utilizzano meno di
10 Celsius® Pak, I'operazione di congelamento ¢ pil rapida e il profilo non
trasferisce direttamente su una scala pitu ampia.

Procedura passo-passo per preparazione, riempimento e caricamento dei

Celsius® Pak:

P Preparare il campione e|o la soluzione tampone per il riempimento dei
Celsius® Pak.

P Inserire I'etichetta nel porta etichetta sul fondo di Celsius® Pak.
Un’etichetta che misura ca. 2 + 5 cm passa completamente nel porta
etichetta. Per I'etichetta si consiglia di usare materiale e inchiostro
resistenti all'acqua. Non scrivere sui Celsius® Pak, poiché i solventi usati
nellinchiostro possono penetrare nei Celsius® Pak e contaminare il
prodotto.

Usare una siringa o una pompa peristaltica per riempire i Celsius® Pak con il
campione o la soluzione tampone attraverso uno dei raccordi di riempi-
mento | scarico. Collegare la siringa o la pompa alla linea opzionale C-Flex®
mediante un raccordo Luer® maschio o mediante saldatura.

Riempire i Celsius® Pak da 30 mL con un volume massimo di 30 mL e il
Celsius® Pak da 100 mL con un massimo di 100 mL.

A\ ATTENZIONE

Non riempire in eccesso i Celsius® Pak o non svuotare tutta |'aria dalla parte
superiore dei Celsius® Pak, poiché cio provoca una dilatazione del campione
e del ghiaccio nel tubo del raccordo.

Chiudere il tubo di riempimento con il tappo Luer® fornito o con un
morsetto stringitubo.Prima di avviare un’operazione di congelamento,
rimuovere I'umidita in eccesso da tutte le superfici del modulo S°

| Celsius® Pak vengono sorretti nel modulo S* da un meccanismo di
bloccaggio a molla che tiene fermo il Celsius® Pak e che funge da superficie
di scambio termico attiva. Eseguire i seguenti passaggi per caricare il
modulo S*

» Fissare il supporto delle termocoppie a Celsius® Pak allineando il rac-
cordo Luer lock femmina che si trova sul supporto con il raccordo Luer
lock maschio che sitrova in cima al pozzetto termometrico. Dopo aver
fissato il raccordo Luer lock al pozzetto termometrico, il lato frontale del
supporto della termocoppia deve essere rivolto nella stessa direzione
dell’etichetta frontale del Celsius® Pak.

p Misurare 1cm a partire dalla fine della termocoppia e apporre un segno
in questo punto per posizionare la termocoppia nel Celsius® Pak.

p Svitare lentamente la fascetta di bloccaggio della termocoppia, facendo
attenzione a conservare i due piccoli O-ring posti all'interno della
fascetta. Mettere la fascetta di bloccaggio e i due O-ring sopra |'estre-
mita della termocoppia e avvitare il dado di bloccaggio di quel tanto in
modo che non si stacchi dal supporto della termocoppia.
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p Abbassare la termocoppia nel pozzetto termometrico. Mai premere
troppo forte per non perforare I'estremita del pozzetto termometrico.
Per un controllo termico accurato, mettere sempre le termocoppie a
1cm sotto la superficie del liquido nel Celsius® Pak, verificando che il
segno sulla termocoppia corrisponda alla superficie del liquido.

Fig.21: Termocoppia a 1 cm sotto la superficie
del liquido
P Serrare la fascetta di bloccaggio per fissare la termocoppia nel pozzetto
termometrico.
P Mettersi difronte alla parte sinistra del modulo S3 inserire un Celsius®-
Pak tra i meccanismi di serraggio partendo dalla sede (slot) 10 che & la
sede piu distante dalla linea di mandata e ritorno del fluido di scambio
termico. Aprire il meccanismo mettendo 'utensile di sblocco dei morsetti
sopra i 2 perni di guida dei 2 blocchi di serraggio in acciaio inox della
sede e premere in giu.

» Premendo in giu I'utensile di sblocco dei morsetti, spingere ciascun lato
del Celsius® Pak verso il basso tra un blocco nero e un blocco di serrag-
gio in acciaio inox del meccanismo di serraggio. Posizionare la parte
superiore del Celsius® Pak in modo che sia allineata con la parte supe-
riore della barra fissa nera in metallo del meccanismo di serraggio. Fare
attenzione che il Celsius® Pak deve essere rivolto a sinistra per poter
essere inserito correttamente nel modulo S°.

» Rimuovere I'utensile di sblocco dei morsetti. [l Celsius® Pak viene tenuto
fermo da ogni lato tra due blocchi metallici, uno nero e uno in acciaio
inox. Collegare i connettori maschi della termocoppia alla striscia di
prese corrispondente per termocoppie.

Fig.23: Installazione del supporto della
termocoppia e del Celsius® Pak
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Fig.24: Posizionamento di Celsius® Pak e connessione della termocoppia

P Ripetere questa procedura dalla sede 9 alla sede 1. La figura mostra uno
schema del posizionamento finale di tuttii Celsius® Pak e delle
termocoppie.

NOTA

Ai fini della riproducibilita, caricare il modulo S* con lo stesso numero di Celsius®
Pak, riempire ogni Celsius® Pak con la stessa quantita di campione o soluzione
tampone e mettere le termocoppie nei pozzetti termometricia 1cm sotto la
superficie del liquido. Tutti i profili di congelamento sviluppati da Sartorius
funzionano correttamente solo se il sistema viene caricato completamente

(10 Celsius® Pak). Pertanto i risultati ottenuti con i profili di congelamento forniti
con il software di installazione sono scalabili direttamente su 16,6 litri.
Modificando il numero di Celsius® Pak si influisce sulla scalabilita di questi
profili.

P Fare un diagramma della posizione e del numero di ogni termocoppia in
un quaderno di laboratorio o conformemente ai regolamenti della vostra
azienda.

p Chiudere e bloccare la copertura del modulo S°.

Striscia di prese per termocoppie
OO OOEO
Posizione della sede del Celsius® Pak riempito

(M) (M) (M) (M) (M) M) (M) (M) Ingresso fluido
di scambio
termico
U'scita fIL{ido

10 9 8 7 6 5 4 3 2 1 di scambio

\_/ \_/ \_/ \_/ \_/ / \_/ \_/ \_/ \_/

Fig.25: Posizionamento delle termocoppie e dei Celsius® Pak nel modulo S
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6.2 Esecuzione diun profilo

NOTA

Quando il modulo S* viene scongelato, controllare che i 4 pomelli di
montaggio del modulo S*siano serrati e che il modulo sia ben fissato sulla
piastra del Cryomixer Jr.

/A ATTENZIONE

Mai superare un valore di 120 giri al minuto per il Cryomixer Jr.

>

Per inizializzare il software Cryopilot, cliccare due volte sull’icona
corrispondente.

Selezionare la voce di menu “Process > Start” per visualizzare la finestra
di dialogo “Start Process”.

Dare un nome al file in cui saranno salvati i dati di tempo e temperatura
per il nuovo processo.

Selezionare il tipo di profilo standard nonché la propria applicazione e
I'operazione che si intende eseguire (congelamento, scongelamento o
congelamento e scongelamento). Altrimenti selezionare un profilo
personalizzato.

Cliccare sul pulsante “OK” per avviare il processo.

Verificare che il refrigeratore risponda ai comandi del software.
Lindicatore di stato nell’'angolo in basso a sinistra dovrebbe indicare
“Online”. Ci sara un ritardo di 2-5 minuti prima che il compressore si avvii
e che abbia inizio la regolazione della temperatura.

Lasciare che il profilo venga eseguito fino allo scadere del tempo
programmato.

Selezionare la voce di menu “Process > Stop” per arrestare il processo.
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6.3 Rimozione dei Celsius® Pak congelati dal

modulo S*

In alcuni casi & opportuno rimuovere i Celsius® Pak dal modulo S® quando
sono ancora congelati.

>

Togliere la copertura trasparente del modulo S°.

NOTA

Se 'apparecchio e stato lasciato aperto per un periodo prolungato
mantenendolo a bassa temperatura, si forma del gelo sui morsetti, sui
Celsius® Pak e sui supporti delle termocoppie rendendo piu difficile la
rimozione dei Celsius® Pak. Una volta che I'apparecchio & aperto, togliere
rapidamente i Celsius® Pak congelati e rimettere la copertura.

>

Rimuovere le termocoppie dai Celsius® Pak. Se una termocoppia non si
toglie facilmente, girarla delicatamente fino a quando si stacca.
Rimuovere il supporto della termocoppia da ciascuna sede. Se si forma
della condensa sulle superfici dei morsetti, si crea un “ponte di ghiaccio”
tra i supporti delle termocoppie e i blocchi di raffreddamento in metallo
nero. In tal caso € praticamente impossibile rimuovere i supporti delle
termocoppie. Togliere I'umidita in eccesso da tutte le superfici prima di
avviare un’‘operazione di congelamento.

Rimuovere i Celsius® Pak congelati dal modulo S® per mezzo dell’'utensile
di sblocco dei morsetti che permette di alzare e togliere i Celsius® Pak.
Metterliin un contenitore termico per il trasporto.

Mettere i Celsius® Pak congelati in un contenitore protettivo e
conservarli nel freezer alla temperatura desiderata. Se si eseguono test di
stabilita o studi di formulazione, & preferibile usare un freezer controllato
con monitoraggio termico.

6.4 Prelievo dei campioni scongelati dal

vvyy

modulo S3

Rimuovere le termocoppie e i loro supporti.

Rimuovere i Celsius® Pak congelati dal modulo S2.

Girare ciascun Celsius® Pak tre volte per garantire una miscelazione
omogenea del prodotto.

Prelevare la quantita desiderata di campione dal Celsius® Pak mediante il
raccordo di riempimento|scarico non utilizzato. A tale scopo usare una
siringa o una pompa, o svuotare per gravita.

Smaltire i Celsius® Pak usati. Siccome i Celsius®s-Pak si deformano
qualche volta durante il congelamento e scongelamento, quando
vengono riutilizzati non si inseriscono perfettamente tra i meccanismi di
serraggio. Cid puo prolungare I'operazione di congelamento e
scongelamento a causa di un basso trasferimento termico.
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/  Manutenzione del sistema

La manutenzione puo essere eseguita dall’'utente finale o da Sartorius.
Contattare il Service di Sartorius per concordare un contratto di
manutenzione preventiva.

Se siverifica un problema, consultare per prima cosa la sezione relativa ai
codici di errore nel manuale d’uso di Huber Unistat 705. Se non si & in grado
dirisolvere il problema, rivolgersi al Servizio Clienti (vedi pagina 184).

VA Pulizia

In generale le superfici esposte delle apparecchiature possono essere pulite
spruzzando e passando un panno con alcol isopropilico. Le superficiin
acciaio inox possono essere pulite opzionalmente con un prodotto per
acciaio inox.

Lo scomparto interno del modulo S® contiene molte partiin alluminio ano-
dizzato che non & compatibile con le soluzioni basiche come idrossido di
sodio (NaOH) o ossidanti. Questi agenti non devono essere usati per pulire
lo scomparto interno. Se € necessario eseguirne la pulizia, si consiglia di
usare alcol isopropilico o altre soluzioni detergenti non ossidanti.

7.2  Sostituzione del fluido di scambio termico

Sostituire il fluido di scambio termico se si vede che € contaminato con
acqua o particolato, oppure se si constata una diminuzione dell’efficienza
di scambio termico (vale a dire quando 'apparecchio non raggiunge o
mantiene la temperatura nominale). Sostituire sempre l'intera quantita di
fluido di scambio termico. Se I'efficienza di scambio termico non migliora
dopo la sostituzione del fluido di scambio termico, rivolgersi al Servizio
Clienti (vedi pagina 184).

Per sostituire il fluido di scambio termico, procedere come segue:

P Verificare che la valvola di scarico del fluido di scambio termico del
sistema posta sulla parte frontale dell’apparecchio sia chiusa. La valvola &
chiusa quando I'intaglio nel cappuccio della vite & in posizione verticale.
Vedi “Fig.10: Valvola di scarico del fluido di scambio termico e viti di
tenuta di Cryopilot A", page 156.

» Togliere la vite di tenuta del tubo in acciaio inox sporgente che si trova a
sinistra dell’apparecchio e collegare un pezzo di tubazione flessibile
sull’'estremita del tubo. Fissare il pezzo con una fascetta stringitubo.

P Mettere l'altra estremita della tubazione flessibile in un recipiente che
puo contenere almeno 12 litri di fluido di scambio termico.

P Aprire la valvola di scarico del fluido di scambio termico girando in senso
antiorario fino a quando l'intaglio € orientato orizzontalmente.

P Se possibile, provare a sollevare il Cryowedge o il modulo S? per far
defluire il fluido residuo dal modulo di applicazione verso il Cryopilot A.

» Quandoil fluido smette di defluire, chiudere la valvola di scarico del
fluido, togliere la tubazione flessibile dal tubo con vite di tenuta
e rimettere la vite di tenuta.

p Riempire il sistema Cryopilot A con nuovo fluido di scambio termico
secondo la procedura descritta nella capitolo “4.7 Riempimento con il
fluido di scambio termico”, pagina 155.
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8 Informazioni e istruzioni per
smaltimento e riparazioni

L'imballaggio non piu utilizzato deve essere portato al centro locale diriciclo
e di smaltimento dei rifiuti. L'imballaggio consiste completamente di mate-
rie non inquinanti, riciclabili come materie prime secondarie.

L'apparecchio, comprensivo di accessori, pile e batterie ricaricabili, non
appartiene alla categoria dei rifiuti domestici. La legislazione dell'lUE
prescrive nei propri Stati membiri la raccolta separata delle apparecchiature
elettriche ed elettroniche rispetto ai rifiuti municipali misti ai fini di un loro
successivo recupero, reimpiego e riciclaggio.

In Germania e in alcuni altri paesi, la Sartorius stessa s’incarica del ritiro e
dello smaltimento delle proprie apparecchiature elettriche ed elettroniche
secondo le leggi vigenti. Queste apparecchiature non devono essere
smaltite insieme ai rifiuti domestici o non devono essere portate ai centri di
raccolta rifiuti locali - cio vale anche per i piccoli esercenti.

Per maggiori informazioni sulle possibilita di smaltimento, potete rivolgervi
in Germania e negli Stati membri dello Spazio economico europeo ai nostri
addetti del Service locale oppure al nostro Service Center di Goettingen, in
Germania:

Sartorius Stedim Biotech GmbH
August-Spindler-Strasse 11
37079 Goettingen, Germania

Nei Paesi che non fanno parte dello Spazio economico europeo o in cui non
e presente una filiale, una succursale, un rivenditore o distributore Sartorius,
rivolgersi alle autorita locali o alle aziende incaricate dello smaltimento.

Prima dello smaltimento e|o della rottamazione delle apparecchiature,
togliere le pile e le batterie ricaricabili e trasferirle negli appositi contenitori
diraccolta.

Le apparecchiature contaminate con sostanze nocive (contaminazione
NBC) non saranno ritirate dalla Sartorius, dalle sue filiali, succursali e dai
suoi rivenditori e distributori, né per lavori di riparazione né per lo
smaltimento. Per maggiori informazioni sulle modalita di riparazione e
smaltimento del proprio apparecchio ed i relativi indirizzi dei centri di
Service consultare il manuale allegato oppure visitare il nostro sito Internet
(www.sartorius.com).

Contatto

Servizio Clienti 24 ore su 24

+1866 424 5600

(numero verde solo peril Nord America))
+1707 747 5614

(nel resto del mondo)
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sartorius

biotech

€ EC Declaration of Conformity

Company

Sartorius Stedim Systems GmbH

Address

Schwarzenberger Weg 73-79

34212 Melsungen; Germany

Phone +49.551.308.0, Fax +49.551.308.3289
www sartorius-stedim.com

We hereby declare that based on the design, construction
and version placed on the market, the device designated be-
low fulfills the relevant fundamental safety requirements
and health regulations specified by the pertinent EC Direc-
tive.

This declaration shall become legally invalid if any modifica-
tions are made to the device, which have not been certified
by Sartorius Stedim Systems.

Authorised person for documentation

Sartorius Stedim Biotech GmbH

attn. Marc Hogreve

August-Spindler-Strasse 11

37079 Goettingen, Deutschland

Phone +49.551.308.3752, Fax +49.551.308.2062

Designation of the device

Benchtop Freeze-Thaw System

Model, version

S3 System, CryoWedge System

Cat.-No.

FTH-CS00000-0002, FTH-CS00000-0004, FTH-CS00000-0006,
FTH-CS00000-0008, FTH-CS00000-0010, FTH-CS00000-0012,
FTH-CS00000-0014, FTH-CS00000-0016

Relevant directives of the EC

2004/42/EC Machinery
2004/108/EC  Electromagnetic Compatibility
2006/95/EC  Electrical equipment designed for use within

certain voltage limits

Applied harmonized standards

EN 1SO 12100-1:2003, EN ISO 12100-2:2003
EN 61326-1:2006
EN 61010-1:2001

Applied national standards and
Technical specifications

not applied

Date and Signature 24.01.2011

Function of Signatory

Automation, Sensors
and Instruments

- © N\
‘-l( Z 4\ { !,/ \< (

Dr. Susaniie Gerighausen
Director of Quality
Engineered Systems and
Instruments

Lars Bottcher
Director of R&D for
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